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Περίληψη 

Ο διαδραστικός σχεδιασμός και η δημιουργία εφαρμογών και ιστοσελίδων είναι κάτι που 

αλλάζει και εξελίσσεται καθημερινά με νέες δυνατότητες και νέα προγράμματα και έχει 

μπει για τα καλά στην ζωή των σχεδιαστών και το αποτέλεσμα αυτών  θεωρείται 

απαραίτητο στην καθημερινότητα των χρηστών. Τα προγράμματα σχεδίασης UI/UX είναι 

εργαλεία που χρησιμοποιούνται  για αυτόν τον σκοπό από σχεδιαστές  για τη δημιουργία 

και ανάπτυξη διεπαφών χρήστη και εμπειριών χρήστη. Ο κύριος σκοπός τους είναι να 

διευκολύνουν τη δημιουργία διαδραστικών prototypes, την οπτική σχεδίαση και την 

ανάλυση της εμπειρίας του χρήστη (UX).  Κάποια από τα δημοφιλή  προγράμματα που 

γνωρίσαμε μέσα στα χρόνια είναι το Figma που θεωρείται ένα αρκετά υποσχόμενο 

διαδικτυακό εργαλείο συνεργασίας καθώς επιτρέπει την ταυτόχρονη ομαδική συνεργασία, 

ένα ακόμη είναι  το Sketch που θεωρείται ιδανικό για σχεδίαση UI και κυρίως σε macOS. 

Tο InVision είναι ακόμη ένα αξιόλογο πρόγραμμα που προσφέρει prototypes και 

σχεδιασμό UX δίνοντας έμφαση στη συνεργασία.  

Το Adobe XD ανήκει στην κατηγορία των παραπάνω προγραμμάτων με ιδιαίτερη έμφαση 

στη δημιουργία ιστοσελίδων και εφαρμογών για κινητές συσκευές. Είναι ένα πρόγραμμα 

ίσως με τις καλύτερες δυνατότητες στην δημιουργία prototypes και animated design. 

Υποστηρίζει την ομαδική εργασία καθώς προσφέρει και ανταλλαγή σχολίων μεταξύ της 

ομάδας έργου σε πραγματικό χρόνο. Το πρόγραμμα είναι πολύ φιλικό και εύκολα 

κατανοητό, ιδιαίτερα για τους χρήστες της σουίτας της Adobe, καθώς ενσωματώνεται 

άψογα με Photoshop, Illustrator κ.τ.λ. 

Σήμερα ο σχεδιασμός και η δημιουργία εφαρμογών και ιστοσελίδων είναι πολύ σημαντικό 

κομμάτι για τους σχεδιαστές και τις ομάδες έργου, ωστόσο πρέπει να αντιληφθούμε πως η 

επιλογή του καταλληλότερου προγράμματος σχεδίασης  UI/UX γίνεται ύστερα από μελέτη 

του σκοπού του τελικού μας έργου, καθώς και τις ανάγκες που έχουμε καθώς δουλεύουμε 

πάνω σε αυτό. 

 

Λέξεις κλειδιά 

Τεχνολογία, Διαδραστικά πολυμέσα, Σχεδιασμός, Αλληλεπίδραση, Ιστοσελίδες, 

Εφαρμογές, Ταυτόχρονη συνεργασία, Εμπειρία χρήστη, Ενσωμάτωση, Λογισμικό, 

Προγράμματα, Κινητές συσκευές, Prototype  
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Αbstract 

Interactive design and the creation of applications and websites is something that changes 

and evolves every day with new features and new programs and has entered the lives of 

designers for good and the result of these is considered necessary in the daily life of 

users. UI/UX design programs are tools used for this purpose by designers to create and 

develop user interfaces and user experiences. Their main purpose is to facilitate 

interactive prototyping, visual design and user experience (UX) analysis. Some of the 

popular programs we have met over the years are Figma which is considered a quite 

promising online collaboration tool as it allows simultaneous group collaboration, 

another one is Sketch which is considered ideal for UI design and especially on macOS. 

InVision is another great program that offers prototypes and UX design with an emphasis 

on collaboration.  

Adobe XD belongs to the category of the above programs and excels in creating websites 

and mobile applications. It is a program with perhaps the best capabilities in creating 

prototypes and animated design. It supports teamwork by offering real-time feedback 

between the project team. We find the program very accessible and easy to understand, 

especially for users of the Adobe suite, as it integrates perfectly with Photoshop, 

Illustrator, etc. 

Today the design and creation of applications and websites is a very important part for 

designers and project teams, however, one must understand that the selection of the most 

suitable UI/UX design program is made after studying the needs both of the project's and 

the team's that is working on it. 

 

Keywords 

Technology, Interactive multimedia, Design, Interaction, Websites, Apps, Concurrent 

collaboration, User experience, Integration, Software, Programs, Mobile devices, 

Prototype 
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1. ΕΙΣΑΓΩΓΗ 

Από τη δημιουργία ενός συνεκτικού συστήματος σχεδιασμού έως το σχεδιασμό 

ροών για την κατασκευή πρωτοτύπων πολύπλοκων διεπαφών για δοκιμές χρηστών, οι 

σχεδιαστές μπορούν να επιλέξουν από μια πληθώρα εργαλείων σχεδιασμού UX. Είτε 

πρόκειται για ένα από τα πιο δημοφιλή προγράμματα όπως το Sketch, το Figma που 

βασίζεται στο διαδίκτυο, το επιθετικά αναπτυσσόμενο Adobe XD ή το πρόσφατα εισαχθέν 

InVision Studio - η εξοικείωση με τα κατάλληλα εργαλεία σχεδιασμού UX, 

συμπεριλαμβανομένης αυτής της επισκόπησης του Adobe XD, θα επιταχύνει τη 

διαδικασία σχεδιασμού προϊόντων.1 

Κατά την εξέταση των εργαλείων που χρησιμοποιούν οι σχεδιαστές, είναι 

σημαντικό να σημειωθεί ότι οι αρμοδιότητες των σχεδιαστών μεταβάλλονται και 

επεκτείνονται συνεχώς. Μόλις 6-7 χρόνια πριν, λίγοι άνθρωποι καταλάβαιναν καν τι κάνει 

ένας σχεδιαστής εμπειρίας χρήστη. Στις μέρες μας αναμένεται από κάθε σχεδιαστή να 

κάνει τουλάχιστον κάποιου είδους έρευνα χρηστών, δημιουργία πρωτοτύπων και ανάλυση 

ανταγωνισμού.2 

Αυτές οι αλλαγές επηρεάζουν τον τρόπο με τον οποίο οι σχεδιαστές πρέπει να 

βλέπουν τη ροή εργασίας τους, τις γνώσεις του τομέα, τις τεχνικές και τα εργαλεία τους. 

Οι πελάτες σήμερα περιμένουν να δουν όχι μόνο ένα ολοκληρωμένο και τέλεια 

διαμορφωμένο τα τελικό προϊόν, αλλά τα πάντα, από το wireframing μέχρι την κατασκευή 

πρωτοτύπων και ένα ομαλά κινούμενο UI.3 

Οι μέρες που οι σχεδιαστές βασίζονταν στο Photoshop ως κύριο εργαλείο 

σχεδιασμού έχουν περάσει ανεπιστρεπτί. Τώρα είναι ένας αγώνας δρόμου για τις 

πλατφόρμες λογισμικού σχεδιασμού που προσελκύουν τόσο τους αρχάριους όσο και τους 

επαγγελματίες. Το Sketch είναι ένας σημαντικός παίκτης εδώ και αρκετά χρόνια, και η 

 
1 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
2 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
3 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Figma, έχοντας λάβει οικονομική υποστήριξη άνω των 46 εκατομμυρίων δολαρίων, 

μοιάζει με το διαδικτυακό διαδραστικό εργαλείο πρωτοτυποποίησης.4 

Πρόσφατα, η πλατφόρμα πρωτοτυποποίησης InVision αποφάσισε να εισέλθει στον 

χώρο με το δικό της εργαλείο σχεδίασης, το InVision Studio. Δεν κινήθηκε τόσο γρήγορα 

όσο όλοι ήλπιζαν, οπότε ενώ το Studio φαίνεται αρκετά σταθερό, εξακολουθεί να είναι 

κάπως υποτονικό και προβληματικό, παρά την αρκετή διαφήμιση. Αφού κυριάρχησε στον 

κόσμο του ψηφιακού σχεδιασμού για πολύ καιρό, η Adobe βρίσκεται πίσω σε αυτόν τον 

αγώνα για το απόλυτο εργαλείο σχεδιασμού UX/UI. Χωρίς να έχει την πολυτέλεια να 

παραμείνει σε αυτή τη θέση για πολύ καιρό... μπαίνει το Adobe XD. Αν και λίγο αργά, το 

Adobe XD έχει αυξήσει τη δημοτικότητά του και έχει γίνει ένας πολλά υποσχόμενος 

διεκδικητής από την κυκλοφορία του το 2016.5 

1.1 Συχνές ερωτήσεις 

Τι είναι το Adobe XD και σε ποιον απευθύνεται; 

Το Adobe XD είναι ένα εργαλείο σχεδίασης UI/UX για τη δημιουργία και την 

κοινή χρήση design για ιστότοπους, εφαρμογές για κινητά και άλλες εμπειρίες χρηστών. 

Απευθύνεται τόσο σε επαγγελματίες σχεδιαστές UI/UX που δημιουργούν σχέδια και 

πρωτότυπα, όσο και σε οποιονδήποτε βρίσκεται στα πρώτα στάδια  εκμάθησης τους. Είναι 

ένα ισχυρό αλλά εύκολο στη χρήση πρόγραμμα, γεγονός που το καθιστά το κατάλληλο για 

σχεδιαστές όλων των υποβάθρων και επιπέδων εμπειρίας. 6 

Πού μπορώ να λάβω βοήθεια και υποστήριξη για το Adobe XD; 

Χρησιμοποιώντας το forum του Adobe XD προσφέρεται η δυνατότητα 

αλληλεπίδρασης με χρήστες, οι οποίοι μοιράζονται την προσωπική τους εμπειρία χρήσης 

και ενδεχομένως παρέχουν απαντήσεις σε αναρτημένα ερωτήματα. Περαιτέρω βοήθεια 

παρέχεται στη σελίδα υποστήριξης της εταιρείας.7 

 
4 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
5 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
6 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
7 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 

https://helpx.adobe.com/gr_en/support/xd.html
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Σε ποια λειτουργικά συστήματα υποστηρίζεται το Adobe XD; 

Το Adobe XD υποστηρίζεται στα ακόλουθα λειτουργικά συστήματα:8 

● MAC 10.13 και μεταγενέστερη έκδοση 

● Windows 10 Creators Update (64-bit) και νεότερηέκδοση 

Πώς μπορώ να ελέγξω αν έχω το αρχικό πλάνο (starter plan) για το Adobe XD; 

● Σε Mac, κάνουμε click στο XD > About XD. 

● Στα Windows, κάνουμε click στην επιλογή Help>About XD. 

Μπορούμε να δούμε τη λέξη Starter δίπλα στην έκδοση. 

Είναι το αρχικό πλάνο (starter plan) διαθέσιμο σε τελικούς χρήστες τόσο στο Creative 

Cloud για ομάδες όσο και στο Creative Cloud για επιχειρήσεις; 

Ναι. 

Εάν είστε τελικός χρήστης του Creative Cloud για ομάδες ή για επιχειρήσεις και 

δεν έχετε πρόσβαση στην εφαρμογή για υπολογιστές, επικοινωνήστε με τον διαχειριστή 

του συστήματος για να σας δοθεί πρόσβαση μέσω του Creative Cloud Packager.9 

Σε περίπτωση που δεν διαθέτετε πρόγραμμα επί πληρωμή που να περιλαμβάνει το 

Adobe XD, υπάρχει δυνατότητα δωρεάν λήψης του ως μέρος του αρχικού πλάνου, μέσω 

του Creative Cloud Packager.10 

Γιατί δεν υποστηρίζονται παλαιότερες εκδόσεις των Windows; 

Το Windows 10 Creators Update (64-bit) αντιπροσωπεύει το μέλλον της 

πλατφόρμας των Windows, ανοίγοντας ευκαιρίες στην Adobe XD να προσφέρει την 

 
8 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 

9 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 

10 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
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υψηλότερη δυνατή απόδοση χρησιμοποιώντας τον πιο πρόσφατο εξοπλισμό με 

δυνατότητα αφής, που είναι διαθέσιμη στην επόμενη γενιά συσκευών που βασίζονται σε 

Windows .11  

Γιατί δεν μου ζητάει το Adobe XD να αποθηκεύσω τα έργα μου στα Windows; Έχω 

χάσει όλη μου τη δουλειά; 

Τα αρχεία σας αποθηκεύονται αυτόματα στο παρασκήνιο. Σε περίπτωση που 

κλείσατε ένα έγγραφο χωρίς να το αποθηκεύσετε, μπορείτε πάντα να συνεχίσετε την 

εργασία σας μεταβαίνοντας στο File>Open Recent και επιλέγοντας το επιθυμητό αρχείο 

από τη λίστα.12 

1.2 Ροή Εργασιών 

Η ροή εργασιών μπορεί να περιγραφεί στα ακόλουθα βασικά βήματα:13 

● Το Design, που παρέχει τις παρακάτω δυνατότητες: 

○ Δημιουργία στοιχείων διάταξης σχεδίασης. 

○ Προσθήκη artboards και εισαγωγή πόρων από άλλες εφαρμογές όπως το 

Adobe Illustrator, το Adobe Photoshop και το Adobe After Effects. 

○ Χρήση πρόσθετων για αυτοματοποίηση επαναλαμβανόμενων λειτουργιών 

ή τμημάτων ροών εργασιών σχεδίων, που είναι περίπλοκα ή 

επαναλαμβανόμενα.  

● Το Prototype που επιτρέπει την επιλογή αντικειμένων ή artboards και τη 

δημιουργία  αλληλεπιδράσεων μεταξύ τους. 

 
11 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
12 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 

13 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
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● Το Share που παρέχει τη δυνατότητα εξαγωγής και κοινής χρήσης με τα 

ενδιαφερόμενα μέρη, πρωτοτύπων ή προδιαγραφών σχεδίασης ή έργου ή των 

στοιχείων, μόλις αυτά είναι έτοιμα για έλεγχο. 

1.3 Βασικά στοιχεία του Χώρου Εργασίας 

Αρχική οθόνη:14 

Tab Περιγραφή. 

Learn Πρόσβαση σε όλα τα σεμινάρια που σχετίζονται με δυνατότητες, εργαλεία και 

ροές εργασίας στο XD. 

Your 

files 

Εμφάνιση της λίστας των εγγράφων cloud που βρίσκεται αποθηκευμένη στο XD. 

Δυνατότητα οργάνωσης των προσωπικών εγγράφων σε φακέλους στο cloud XD. 

Shared 

with you 

Εμφάνιση της λίστας εγγράφων cloud που κοινοποιούνται από διαφορετικούς 

ενδιαφερόμενους για έλεγχο. 

Manage 

links... 

Πρόσβαση στα έγγραφα cloud και προβολή αυτών από την ενότητα Cloud 

Documents στο μενού Files. Εναλλακτική δυνατότητα παρουσίασης των 

εγγράφων είτε σε προβολή grid είτε σε προβολή λίστας, και ταξινόμηση με βάση 

το όνομα ή την ημερομηνία τροποποίησης. 

Deleted Εύρεση της πλήρης λίστας των εγγράφων cloud που έχουν διαγραφεί και επιλογή 

επαναφοράς ή οριστικής διαγραφής αυτών. 

Recent 

files 

Προβολή της λίστας με τα πρόσφατα επεξεργασμένα αρχεία XD. 

 
14 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Artboard 

presets 

Έναρξη του σχεδιαστικού έργου επιλέγοντας ένα από τα προκαθορισμένα μεγέθη 

του artboard στην αρχική οθόνη. Εύρος επιλογών όπως ενδεικτικά αποτελούν το 

iPhone, το Web, τις προεπιλογές μέσων κοινωνικής δικτύωσης ή ακόμα και ορισμό 

προσαρμοσμένου μεγέθους πίνακα γραφικών. 

 

Χώρος Εργασίας:15 

Option Περιγραφή. 

Main menu 
Πρόσβαση στα μενού File, Edit, Object, View, Window και Help καθώς και 

στα υπομενού τους. 

Design Mode 

Δημιουργία και σχεδίαση artboards που συνθέτουν το έργο σας. Δυνατότητα 

εισαγωγής στοιχείων που δημιουργήθηκαν, χρησιμοποιώντας άλλα εργαλεία 

ή μέσα από τον ιστό ή δημιουργία γραφικών σε XD. 

Prototype Mode 

Σύνδεση artboards μεταξύ τους, δημιουργία demo του design (προς το παρόν 

μόνο σε macOS), δημιουργία πρωτότυπου design σε ένα πρόγραμμα 

περιήγησης ή μια συσκευή και κοινή χρήση με τους ενδιαφερόμενους για 

έλεγχο. 

Invite to 

document 

Ενεργοποίηση της συνεπεξεργασίας και πρόσκληση άλλων σχεδιαστών 

προκειμένου να έχουν πρόσβαση στο έγγραφο και δυνατότητα ταυτόχρονης 

επεξεργασίας του. 

Share Mode 
Δημιουργία και κοινή χρήση συνδέσμων για κριτικές σχεδιασμού, ανάπτυξη, 

παρουσιάσεις και δοκιμές χρηστών.  

 

15 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
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Preview on device 
Σύνδεση πολλαπλών συσκευών μέσω USB στο επιτραπέζιο μηχάνημα και 

ρύθμιση τους για μεταφορά δεδομένων και ζωντανή προβολή. 

Preview 

Δοκιμή του πρωτότυπου σας στο Adobe XD χρησιμοποιώντας την 

προεπισκόπηση επιφάνειας εργασίας ή την εφαρμογή Adobe XD στη συσκευή 

σας iOS ή Android. 

Property 

Inspector 

Ορισμός πλήθους ιδιοτήτων αντικειμένων και διαχείριση τους 

χρησιμοποιώντας διαφορετικές επιλογές στο Property Inspector. 

Για παράδειγμα, μπορείτε να καθορίσετε φόντο, γεμίσματα, περιγράμματα, 

σκιές, στοίχιση και διαστάσεις αντικειμένων. Μπορείτε επίσης να συνδυάσετε 

αντικείμενα μαζί για να δημιουργήσετε εντελώς νέα αντικείμενα. Για να 

τοποθετήσετε επαναλαμβανόμενα στοιχεία, χρησιμοποιήστε την επιλογή 

Repeat Grid στο Property Inspector. Χρησιμοποιήστε την επιλογή Σταθερή 

θέση για να καθορίσετε τη θέση πολλών στοιχείων στην κύλιση. Μπορείτε 

επίσης να χρησιμοποιήσετε τον μαθηματικό υπολογισμό για να 

δημιουργήσετε design με μεγαλύτερη ακρίβεια ή να μετακινήσετε αντικείμενα 

σε μια νέα θέση ή να τροποποιήσετε το πλάτος και το ύψος της. 

Γραμμήεργαλείω

ν (Plugins, 

Layers, Assets 

and tools) 

Πρόσβαση στο selection tool, στα drawing tools, στο text tool, στο artboard 

tool, στον πίνακα Assets και Layers. 

Application 

toolbar 

Πρόσβαση στη λειτουργία σχεδίασης, στη λειτουργία πρωτοτύπου, στα 

επίπεδα ζουμ του καμβά, στις επιλογές προεπισκόπησης και κοινής χρήσης. 

Χώρος εργασίας Περιέχει τον καμβά ή τους πίνακες τέχνης με τα δημιουργημένα στοιχεία. 

 

1.4 Πρόσβαση σε UI design kits και χρήση 

Το Adobe XD παρέχει συνδέσμους σε UI kits χρήστη για Apple iOS, Google 

Material, Microsoft Windows και Wireframes. Τα UI kits των χρηστών περιέχουν στοιχεία 
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γραφικών που είναι εγγενή στο λειτουργικό σύστημα. Για παράδειγμα, αν σχεδιάζετε μια 

εφαρμογή iOS, μπορείτε να ξεκινήσετε απευθείας με τις άμεσα διαθέσιμες οθόνες στο kit 

Apple iOS. Το XD παρέχει επίσης πρόσβαση σε kit έμπνευσης, όπως  UI kit Designer 

Marketplace ή Dashboard. Για την απόκτηση ενός UI kit, υπάρχουν οι κάτωθι επιλογές: 16 

● Στην αρχική οθόνη, επιλέξτε Add-ons > Plugins. 

● Σε Mac, επιλέξτε File > Get UI Kits 

● Σε Windows,  επιλέξτε Hamburger menu, καιστηνσυνέχεια Get UI Kits. 

 

 

 

 

 

 

  

 

 

 

  

 
16 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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2. DESIGN 

2.1 Artboards, Guides, Layers 

2.1. 1 Εισαγωγή στα Artboards 

Ξεκινώντας με το πιο απλό ερώτημα, δηλαδή τι είναι τα artboards; 

Τα artboards είναι ουσιαστικά οι οθόνες στην εφαρμογή ή στην ιστοσελίδα του 

ιστότοπού μας. Βοηθούν στην βελτίωση του σχεδιασμού και της δημιουργίας 

διαδραστικών σχεδίων για διάφορα μεγέθη οθόνης στο ίδιο έγγραφο. Η εφαρμογή 

παραπέμπει το χρήστη σε οποιαδήποτε εργασία XD στα artboards.17 

 Στη συνέχεια, παρατίθενται οι τρόποι δημιουργίας και διαχείρισης των artboards 

καθώς και οι διάφορες επιλογές που υπάρχουν όσον αφορά τις ρυθμίσεις. 18  

Δημιουργία ενός νέου artboard 

Μπαίνοντας στην Adobe XD βλέπουμε ότι η εφαρμογή παρέχει κάποια artboards 

για οθόνες που είναι συνήθης σε iPhone, iPad, Android και Web. Στην περίπτωση που 

καμία επιλογή δεν μας καλύπτει, υπάρχει δυνατότητα δημιουργίας ενός νέου artboard, 

επιλέγοντας το Custom Size. Στα δεξιά της οθόνης παρατίθενται οι επιλογές που 

υπάρχουν.19 

 
17 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
18 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
19 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 



18 
 

Εικόνα 1 

Εικόνα 2 

Χρήση ενός artboard από το Photoshop ή το Illustrator 

Εναλλακτική επιλογή αποτελεί η χρήση ενός ήδη υπάρχοντος artboard από το 

Photoshop ή το Illustrator, εφαρμογές ευρέως γνωστές που ανήκουν στην σουίτα της 

Adobe. Για το άνοιγμα ενός artboard απο το Photoshop ή το Illustrator, επιλέξτε File > 

Import from XD.20 

Διαχείριση των artboards 

Καθώς προχωρούμε στον σχεδιασμό, μπορεί να αλλάξουμε γνώμη για το τελικό μας 

design, να θέλουμε να μετονομάσουμε το εκάστοτε artboard ή να τροποποιήσουμε το 

 
20 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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μέγεθος, να προσθέσουμε κάποια artboards ή τα ανατοποθετήσουμε. Όλα τα παραπάνω 

πραγματοποιούνται με μεγάλη ευκολία ως εξής : 21 

➔ Μετονομασία 

Πραγματοποιείται εύκολα και γρήγορα με διπλό click στον τίτλο του εκάστοτε 

artboard.22 

 

➔ Τροποποίηση Μεγέθους 

Επιλέγοντας και σέρνοντας το μπλέ εικονίδιο (βλέπουμε μέσα στην έλλειψη) που 

εμφανίζεται στις άκρες ενός artboard επιτρέπεται η αλλαγή του μεγέθους του.23 

 

  

 
21 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
22 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
23 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
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➔ Αντιγραφή 

Αφού επιλεχθεί το επιθυμητό artboard, με Ctrl/Cmd + D αντιγράφεται. 24 

➔ Ευθυγράμμιση και Διανομή 

Επιλέξτε πολλά artboard πατώντας το Shift και στην συνέχεια κάντε click στην 

επιλογή Align and Distribute στο Property Inspector πάνωδεξιά.  Αυτές τις επιλογές 

μπορείτε  να τις βρείτε επίσης από Object>Align/Distribute. Σέρνετε το artboard για 

αναδιάταξη.25  

 

Εφαρμογή πλεγμάτων διάταξης (layout grids) ή τετράγωνα πλέγματα (square grids) 

Τα layout grids ή αλλιώς πλέγματα διάταξης αποτελούν βοηθό στον ορισμό μιας 

υποκείμενης δομής του σχεδιαστικού περιεχομένου. Επιλέξτε ένα ή περισσότερα artboards 

και στην ενότητα Grid του Property Inspector, επιλέξτε Layout.26 

 
24 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
25 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
26 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
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Τα square grids ή αλλιώς τετράγωνα πλέγματα, εξυπηρετούν στο γρήγορο 

μέτρημα και στην ευθυγράμμιση του περιεχομένου του σχεδιασμού μας ενώ τοποθετείτε 

κείμενο ή οτιδήποτε άλλο στα artboard.27 

Για τα square grids επιλέξτε ένα ή περισσότερα artboard και στην ενότητα Grid 

του Property Inspector, επιλέξτε Square.28 

Design artboards 

Αφού αναλύθηκαν τα βασικά βήματα για έναν σχεδιασμό artboard, στην συνέχεια θα 

παρουσιαστούν τρόποι προσθήκης οπτικών στοιχείων, στοιχείων κειμένου, αλλαγής 

φόντου και δημιουργίας εφέ κύλισης.29 

➔ Προσθήκη οπτικών στοιχείων και στοιχείων κειμένου 

Χρησιμοποιήστε τα εργαλεία σχεδίασης για να δημιουργήσετε προσαρμοσμένα 

στοιχεία ή επιλέξτε File>Import  για να εισάγετε υπάρχοντα στοιχεία, όπως εικόνες και 

εικονίδια από το φάκελο της εκάστοτε συσκευής. Χρησιμοποιήστε τα εργαλεία κειμένου 

για την δημιουργία, την μορφοποίηση και  την αποτύπωση στυλ κειμένου σε 

επαναχρησιμοποιήσιμα στοιχεία. 30 

 
27 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
28 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
29 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
30 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 

 

https://helpx.adobe.com/gr_en/xd/help/drawing-text-tools.html
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Για αλλαγή τους χρώματος φόντου στα artboard, από το Property Inspector, επιλέξτε 

Fill και εφαρμόστε το επιθυμητό  χρώμα από τον επιλογέα χρώματος.31 

➔ Δημιουργία επαναλαμβανόμενων στοιχείων 

Τα repeat grids χρησιμοποιούνται για δημιουργία αντικειμένων με επαναλαμβανόμενα 

στοιχεία, όπως λίστες και διατάξεις.32 

➔ Δημιουργία artboard με δυνατότητα κύλισης 

Κάθετη κύλιση (Vertical Scroll) 

Για επέκταση του γραφικού πέρα από το ύψος της οθόνης προβολής, χρησιμοποιείστε 

το δείκτη. Ο δείκτης υποδεικνύει τη θέση μέχρι την οποία πρέπει να πραγματοποιηθεί 

κύλιση για να αποκτηθεί πρόσβαση στο περιεχόμενο.33 

➔ Αλλαγή θέσης κατα την κύλιση (Fix position when scrolling) 

Για καρφίτσωμα των στοιχείων σχεδίασης σε μια σταθερή θέση, επιλέξτε Fix Position 

When Scrolling στο Property Inspector.34 

2.1.2 Χρήση των οδηγών (guides) και των πλεγμάτων (grids) 

Η χρήση των οδηγών (guides) εξυπηρετεί στην ευθυγράμμιση αντικειμένων στο 

design του χρήστη καθώς και στην διαχείριση της απόστασης μεταξύ των στοιχείων σε 

ένα artboard.35 

Δημιουργία και διαχείριση των οδηγών 

Οι οδηγοί χωρίζονται σε κατακόρυφους (vertical)  και οριζόντιους (horizontal).  

Εάν επιθυμείτε την ευθυγράμμιση και την τοποθέτηση αντικειμένων στα artboard από 

 
31 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools with 

different levels of fidelity from a product design student’s perspective. In International Conference on Innovative 
Technologies and Learning (pp. 557-566). Cham: Springer International Publishing. 
32 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
33 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
34 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
35 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
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πάνω προς τα κάτω, θα χρησιμοποιήσετε τον κατακόρυφο οδηγό (vertical guide). Εάν 

επιθυμείτε την ευθυγράμμιση και την τοποθέτηση αντικειμένων στα artboardαπό αριστερά 

προς τα δεξιά, θα χρησιμοποιήσετε τον οριζόντιο οδηγό (Horizontal guide).36 

Κατακόρυφος οδηγός (Vertical guide) 

Για την δημιουργία ενός κατακόρυφου οδηγού, τοποθετήστε το δείκτη του 

ποντικιού πάνω από το αριστερό περίγραμμα του artboard μέχρι να εμφανιστεί το εικονίδιο 

. Στην συνέχεια, κάντε click και κρατήστε πατημένο το εικονίδιο σέρνοντας το στην 

επιθυμητή θέση.37 

Οριζόντιος οδηγός (Horizontal guide) 

Για την δημιουργία ενός οριζόντιου οδηγού, τοποθετήστε το δείκτη του ποντικιού 

στο πάνω περίγραμμα του artboard μέχρι να εμφανιστεί το εικονίδιο . Στην συνέχεια, 

κάντε click και κρατήστε πατημένο το εικονίδιο σέρνοντας το στην επιθυμητή θέση.38 

Αντιγραφή και επικόλληση των οδηγών (guides) 

Για αντιγραφή οδηγών από ένα artboard, κάντε click στην επιλογή View > Guides 

> Copy Guides. Για επικόλληση οδηγών, κάντε click στην επιλογή View ή δεξί click στο 

artboard >Guides > Paste Guides.39 

 

Αφαίρεση των οδηγών (guides) 

Για αφαίρεση ενός οδηγού κάντε click και σύρετε τον επιθυμητό οδηγό έξω από το 

artboard. Για αφαίρεση πολλαπλών οδηγών από ένα artboard, επιλέξτε το artboard και 

κάντε click στην επιλογή View> Guides> Clear Guides.40 

 
36 Low, N. E. (2022). Barber App UI/UX Design. 
37 Low, N. E. (2022). Barber App UI/UX Design. 
38 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
39 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
40 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
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Απόκρυψη και κλείδωμα των οδηγών (guides) 

Προσφέρεται προσωρινή απόκρυψη των οδηγών, σε περίπτωση που κάτι τέτοιο 

χρειαστεί. Υπάρχει, επίσης, δυνατότητα για κλείδωμα όλων των οδηγών που 

συμπεριλαμβάνονται στο artboard, έτσι ώστε να διασφαλιστούν απο πιθανότητα 

μετακίνησης ή απώλειας.  Για απόκρυψη και κλείδωμα των οδηγών (guides) σε MAC, 

ακολουθείστε τα κάτωθι βήματα: 41 

1. Απόκρυψη: Κάντε click στηνεπιλογήView > Hide All Guides. Εναλλακτικά, 

χρησιμοποιείστε τον συνδυασμό Cmd + ; 

2. Κλείδωμα: Κάντε click στην επιλογή View > Lock All Guides. Εναλλακτικά, 

χρησιμοποιείστε τον συνδυασμό Cmd + Shift + ; 

 

Για απόκρυψη και κλείδωμα των οδηγών (guides) σε Windows, ακολουθείστε τα 

κάτωθι βήματα:42 

1. Απόκρυψη: Κάντε δεξί click στον πίνακα γραφικών και επιλέξτε View > Hide All 

Guides . Εναλλακτικά, χρησιμοποιείστε τον συνδυασμό Ctrl + ; 

2. Κλείδωμα: Κάντε δεξί click στο artboard και επιλέξτε Guides >Lock All Guides. 

Εναλλακτικά, χρησιμοποιείστε τον συνδυασμό  Ctrl + Shift + ; 

Ευθυγράμμιση αντικειμένων με την χρήση Smart guides  

Η συγκεκριμένη λειτουργία είναι ενεργοποιημένη από προεπιλογή. Μέσα από τα 

smart guides παρέχεται η δυνατότητα ταιριάσματος των επιλεγμένων αντικειμένων ή ενός 

artboard με άλλα αντικείμενα ή artboard που δημιουργούμε ή διαχειριζόμαστε. Έτσι, κατα 

την μετακίνηση ενός αντικειμένου ή ενός artboard, τα smart guides επιτρέπουν την 

ευθυγράμμιση, την επεξεργασία και τον μετασχηματισμό σε σχέση με άλλα αντικείμενα, 

artboards ή ακόμα και με τα δύο μέσω snap-aligning.43 

 
41 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
42 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
43 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Χρήση των πλεγμάτων (grids) 

Τα πλέγματα (grids) χρησιμεύουν ως πλαίσιο πάνω στο οποίο υπάρχει δυνατότητα 

οργάνωσης των σχεδιαστικών στοιχείων του χρήστη (για παράδειγμα εικόνες και 

παράγραφοι), με αποτέλεσμα την διασφάλιση συμμετρίας στην διάταξη.44 

Τοποθέτηση αντικειμένων με την χρήση πλεγμάτων 

Ο καθορισμός της δομής της σχεδίασης και η ευθυγράμμιση των αντικειμένων 

μέσα στο artboard, πραγματοποιούνται με την χρήση δύο πλεγμάτων: Layout και Square. 

45 

Τα Layout αποτελούν πλέγματα (grids) στηλών που είναι χρήσιμα κατά την 

ευθυγράμμιση αντικειμένων σχεδίασης ή κατα την σχεδίαση διαφορετικών μεγεθών 

οθόνης. Προσαρμόζονται εύκολα και γρήγορα από τον χρήστη με βάση τις ανάγκες του.46 

Τα Square αποτελούν πλέγματα (grids), τα οποία διαθέτουν οριζόντιες και 

κατακόρυφες γραμμές, για παροχή ακρίβειας στο μέγεθος και δυνατότητας ευθυγράμμισης 

αντικειμένων κατά το σχεδιασμό εφαρμογών ή εικονιδίων για κινητά.47 

Ορισμός προτιμήσεων του πλέγματος 

Προτιμήσεις Square grid 

Με βάση τις σχεδιαστικές ανάγκες, παρέχεται η δυνατότητα αλλαγής του μεγέθους 

του πλέγματος για square grid. Το μέγεθος grid είναι η απόσταση μεταξύ των γραμμών 

του  grid. Για επεξεργασία της τιμής του μεγέθους του πλέγματος, εισάγετε τον 

απαιτούμενο αριθμό στο πεδίο Square size του Property Inspector.48 

  

 
44 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
45 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
46 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
47 Low, N. E. (2022). Barber App UI/UX Design. 
48 Low, N. E. (2022). Barber App UI/UX Design. 

https://www.adobe.com/gr_en/products/xd/solutions/app-design-software.html
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Προτιμήσεις Layout grid 

Με την εφαρμογή ενός layout grid σε ένα artboard, παρέχεται η δυνατότητα 

ορισμού του αριθμό των στηλών (Column), του πλάτους της στήλης (Column Width), 

του πλάτους ανάμεσα στις στήλες (Gutter Width) και του μεγέθους των περιθωρίων 

(Margin sizes) από την ενότητα Grid του Property Inspector. Μπορείτε να αλλάξετε τις 

τιμές και κάτω δεξιά στο πλαίσιο του Grid θα συναντήσετε δύο εικονίδια:49 

Για προσαρμογή των περιθωρίων αριστερά και δεξιά επιλέξτε το πρώτο εικονίδιο 

ενώ για προσαρμογή του  κάθε περιθωρίου μεμονωμένα (δηλαδή αριστερό, δεξί, πάνω, 

κάτω), επιλέξτε το δεύτερο εικονίδιο.50 

Προσθήκη χρώματος 

Η προσθήκη χρώματος γίνεται εύκολα με αριστερό click πάνω στο εικονίδιο του 

Column. Στην επιλογή Grid του Property Inspector εμφανίζεται ο ευρύτερα γνωστός 

πίνακας χρωμάτων.51 

Απόκρυψη πλέγματος και επανεμφάνιση 

Για απόκρυψη και εμφάνιση των πλεγμάτων (grids) σε MAC, ακολουθείστε τα κάτωθι 

βήματα: 52 

1. Απόκρυψη: Κάντε click στην επιλογή View > Hide Layout Grid. Εναλλακτικά, 

χρησιμοποιείστε τον συνδυασμό Command + ' 

2. Εμφάνιση: Κάντε click στην επιλογή View >  Show Square Grid. Εναλλακτικά, 

χρησιμοποιείστε τον συνδυασμό Ctrl + "  

 

Για απόκρυψη και εμφάνιση των πλεγμάτων (grids) σε Windows, ακολουθείστε τα 

κάτωθι βήματα:53 

 
49 Low, N. E. (2022). Barber App UI/UX Design. 
50 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
51 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
52 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
53 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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1. Απόκρυψη: Κάντε δεξί click στον πίνακα γραφικών και επιλέξτε View > Hide 

Layout Grid. Εναλλακτικά, χρησιμοποιείστε τον συνδυασμό Ctrl + Shift + " 

2. Εμφάνιση: Κάντε δεξί click στο artboard και επιλέξτε  View > Show Square Grid. 

Εναλλακτικά, χρησιμοποιείστε τον συνδυασμό Ctrl + "  

2.1.3 Δημιουργία κύλισης (scrollable artboards) 

Η Adobe XD δίνει τη δυνατότητα δημιουργίας artboards με εφέ κύλισης, καθώς 

πολλές φορές κάποιο artboard δεν είναι αρκετά μεγάλο για να χωρέσει όλο το περιεχόμενο 

ενός design. Με το εφέ κύλισης, υπάρχει δυνατότητα εύκολης προσθήκης υλικού και 

επίτευξης ενός περισσότερο επαγγελματικού, προχωρημένου επιπέδου αποτελέσματος. 54 

Η κατακόρυφη κύλιση βοηθά στην προσομοίωση ενός εφέ κύλισης κατα τον 

σχεδιασμό αναπτυσσόμενων λιστών ή ιστοτόπων με δυνατότητα κύλισης. Υπάρχει 

επιπρόσθετα δυνατότητα χρήσης ομάδων κύλισης (scroll groups), για επίτευξη ενός νέου 

επιπέδου αλληλεπίδρασης κατα τον σχεδιασμό διεπαφών πολλαπλών πλαισίων, χαρτών 

και οριζόντιων γκαλερί εικόνων.55 

Η δημιουργία μιας κατακόρυφης κύλισης, πραγματοποιείται ώς εξής: 56 

Στο εκάστοτε artboard σύρετε την άκρη του προς τα κάτω για να αυξήσετε το 

μήκος του περισσότερο από την οθόνη της συσκευής. Μια διακεκομμένη γραμμή 

υποδεικνύει την έναρξη του περιεχομένου με δυνατότητα κύλισης.57 

 
54 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
55 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
56 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
57 Low, N. E. (2022). Barber App UI/UX Design. 
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Σε λειτουργία Design η επεξεργασία των πληροφοριών γίνεται στο Property 

Inspector:  

Scrolling: Επιλέξτε Vertical ή none 

 
 

Fix Position When Scrolling: Επιλέξτε, προκειμένου τα στοιχείανα καρφιτσωθούν σε μια 

σταθερή θέση και να αποφευχθεί η κύλιση με το περιεχόμενο.  

 
Viewport Height: Επιλέξτε το ύψος που επιθυμείτε να ξεκινάει η κύλιση στο artboard.  

1. Συνδέουμε τα artboards σε prototype mode.  

2. Preserve scroll position: Διατηρεί τη θέση κύλισης  
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2.1.4 Χρήση των layers 

Τα layers δεν διαφέρουν και πολύ από τα αντίστοιχα άλλων εφαρμογών, όπως είναι 

το Photoshop. Ουσιαστικά, αποτελούν το σύνολο των πληροφοριών, όπως είναι οι 

φωτογραφίες, τα κείμενα, οι τίτλοι και οποιαδήποτε άλλη λεπτομέρεια έχουμε προσθέσει 

στο artboard που έχουμε δημιουργήσει.58 

Για την εμφάνιση των layers στα αριστερά της οθόνης,επιλέξτε το μεσαίο σύμβολο 

που βρίσκεται κάτω αριστερά. Εναλλακτικά, σε MAC μπορείτε να επιλέξετε τον 

συνδυασμό Cmd + Y και σε Windows Ctrl + Y.59 

 

 
 

Για αναζήτηση κάποιου από τα layers, πληκτρολογήστε στην αναζήτηση είτε την 

ονομασία του είτε λέξεις κλειδιά που θα βοηθήσουν στην εύρεση του (π.χ. μια λέξη από 

το κείμενο που μπορεί να υπάρχει μέσα στο όνομα του layer).60 

 
58 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
59 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
60 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
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Η διαχείριση των layers, όπως η ομαδοποίηση τους, μετονομασία τους, αντιγραφή 

ή εξαγωγή τους, πραγματοποιείται μέσα από τον πίνακα Layers. 

Αναλυτικότερα,υπάρχουν οι κάτωθι δυνατότητες: 61 

● Για ομαδοποίηση layers: Επιλέξτε  πολλαπλά layers και στην συνέχεια κάντε δεξί 

click και επιλέξτε Group. 

● Για μετονομασία layer: Χρησιμοποιήστε τους συνδυασμούς Cmd+Opt+R (για 

MAC) ή Ctrl+Alt+R (για Windows) και πληκτρολογήστε ένα νέο όνομα.  

● Για αντιγραφή layer: κάντε δεξί click στο layer και επιλέξτε Duplicate. 

● Για απόκρυψη layer: τοποθετήστε το δείκτη του ποντικιού πάνω στο layer και 

κάντε click στο σφραγισμένο μάτι. Για να επανεμφάνιση κάντε click στο ίδιο 

σύμβολο. 

● Για κλείδωμα layer: επιλέξτε το εικονίδιο της κλειδαριάς που βρίσκεται δίπλα στο 

σφραγισμένο μάτι. Τα κλειδωμένα layers εξαιρούνται από όλες τις λειτουργίες 

επεξεργασίας που θα εκτελεστούν στο artboard. Ξανα επιλέξτε το για ξεκλείδωμα. 

● Για εξαγωγή layer: κάντε δεξί click και στην συνέχεια επιλέξτε Export. 

● Για δημιουργία ενός στοιχείου με την χρήση ενός layer ή μίας ομάδας layers: κάντε 

δεξί click και στην συνέχεια επιλέξτε Make Component. 

● Για διαγραφή ενός layer: κάντε δεξί click και στην συνέχεια επιλέξτε Delete. 

 
61 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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2.1.5 Δημιουργία scroll group 

Οι ομάδες κύλισης (scroll groups), προσφέρουν τη δυνατότητα δημιουργίας εφέ 

τόσο κάθετης όσο και οριζόντιας κύλισης. Μπορούν να φανούν αρκετά χρήσιμες κατα την 

επεξεργασία carousel εικόνων, sliders ή interactive χαρτών. 62 

Δημιουργία ενός εφέ οριζόντιας κύλισης 

1. Σε λειτουργία Design, επιλέξτε τα αντικείμενα που θέλετε να μετατρέψετε σε 

scrollable group. 

 

2. Στην συνέχεια, κάντεclick στο εικονίδιο στο 

Property Inspector. Οι διαστάσεις προσαρμόζονται 

αυτόματα. Μπορείτε επίσης να χρησιμοποιήσετε τον 

συνδυασμό⇧⌘H  (για MAC) και τον συνδυασμό  Shift 

+ Ctrl +H (για Windows) για δημιουργίαενός οριζόντιου εφέ κύλισης. 

Δημιουργία ενός εφέ κατακόρυφης κύλισης63 

1. Σε λειτουργία Design, επιλέξτε τα αντικείμενα που θέλετε να μετατρέψετε σε 

scrollable group. 

2. Στην συνέχεια, για κύλιση προς τα πάνω και προς τα κάτω, κάντε click στο 

εικονίδιο που βρίσκεται ακριβώς δίπλα από το εικονίδιο που αντιστοιχεί στην 

οριζόντια κύλιση που παρουσιάστηκε παραπάνω, στο Property Inspector. 

Μπορείτε επίσης να χρησιμοποιήσετε τον συνδυασμό⇧⌘V  (για MAC) και τον 

συνδυασμό  Shift + Ctrl +V  (για Windows) για δημιουργίαενός εφέ κατακόρυφης 

κύλισης. 

Δημιουργία ενός οριζόντιου και κατακόρυφου εφέ κύλισης 

Ακολουθείται η ίδια ακριβώς διαδικασία, με την διαφορά ότι επιλέγετε το τρίτο 

εικονίδιο στη σειρά, στο Property Inspector.  Μπορείτε επίσης να χρησιμοποιήσετε τον 

 
62 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
63 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
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συνδυασμό ⇧⌘D  (για MAC) και τον συνδυασμό  Shift + Ctrl +D (για Windows) για 

δημιουργία ενός συνδυασμού οριζόντιων και κάθετων εφέ κύλισης.64 

2.2 Shapes, Οbjects, Path 

2.2.1 Επεξεργασία των Objects 

Επιλογή αντικειμένων (Select)65 

● Πριν την τροποποίηση ενός αντικειμένου, επιλέγοντας το απλά, το ξεχωρίζετε από 

τα υπόλοιπα γύρω του. Αφού το επιλέξετε, ολόκληρο ή ένα μέρος αυτού, μπορεί 

να πραγματοποιηθεί η απαραίτητη επεξεργασία. 

● Κάντε click στο Selection και όταν ο κέρσορας αλλάξει σε δείκτη, επιλέξτε το 

αντικείμενο ή μια ομάδα αντικειμένων. Για πολλαπλή επιλογή αντικειμένων, 

σχεδιάστε ένα πλαίσιο γύρω από τα αντικείμενα χρησιμοποιώντας το εργαλείο 

Selection. Εναλλακτικά, χρησιμοποιείστε τον συνδυασμό Shift + click στα 

αντικείμενα.  

● Για επιλογή layers σε μια ομάδα κάντε διπλό click στα αντικείμενα. Εναλλακτικα, 

χρησιμοποιείστε τον συνδυασμό Cmd+click (για MAC) ή τον συνδυασμό 

Alt+click (για Windows). 

● Για επιλογήενός αντικειμένου χωρίς γέμισμα, κάντε click στο περίγραμμά του. 

Αλλαγή μεγέθους αντικειμένων (Resize) 

Επιλέξτε το αντικείμενο ή την ομάδα αντικειμένων και σύρετε τις κυκλικές λαβές 

που βρίσκονται πάνω στα όρια του εκάστοτε αντικειμένου. Για κλείδωμα της αναλογίας 

των διαστάσεων, κατά την αλλαγή μεγέθους, κάντε απλά click στο εικονίδιο κλειδώματος 

στο Property Inspector. Με αυτόν τον τρόπο, η αναλογία μεταξύ ύψους και πλάτους 

παραμένει η ίδια σε οποιαδήποτε αλλαγή.66 

 

 
64 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
65 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
66 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
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Περιστροφή αντικειμένων (Rotate)67 

● Επιλέξτε το αντικείμενο ή την ομάδα αντικειμένων. 

● Τοποθετήστε το δείκτη του ποντικιού πάνω από τις κυκλικές λαβές και 

μετακινήστε τον κέρσορα ελαφρώς προς το εξωτερικό της λαβής για να εμφανιστεί 

ο δρομέας περιστροφής. 

● Όταν εμφανιστεί ο κέρσορας περιστροφής, σύρετε τη λαβή προς την επιθυμητή 

κατεύθυνση για περιστροφή. 

● Για περιστροφή αντικειμένων πολλαπλάσια των 45°, χρησιμοποιείτε το πλήκτρο 

Shift. 

Μετακίνηση αντικειμένων (Move objects) 

Η μετακίνηση αντικειμένων επιτυγχάνεται με τους εξής τρόπους:68 

● Σύρετε αντικείμενα με το ποντίκι. 

● Χρησιμοποιήστε τα πλήκτρα βέλους στο πληκτρολόγιο. 

● Εισάγετε με ακρίβεια, μαθηματικές τιμές λειτουργίας (+, -./, *), στο Property 

Inspector. 

● Επιλέξτε ένα ή περισσότερα αντικείμενα. Στο Property Inspector, εισάγετε νέες 

τιμές για τις συντεταγμένες X και/ή Y. Υπάρχει επίσης δυνατότητα, κάνοντας κλίκ 

 
67 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
68 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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στις τιμές X και Y, να πραγματοποιηθεί αυξομείωση της τιμής με χρήση των 

πλήκτρων βέλους. 

Ευθυγράμμιση και Διανομή (Align and Distribute) 

Η ευθυγράμμιση και διανομή είτε ενός αντικειμένου, είτε μιας ομάδας 

αντικειμένων, είτε αντικειμένων μεταξύ τους, αποτελούν διαδικασίες όμοιες αυτές που 

πραγματοποιούνται σε ένα artboard.  Επιλέξτε τα επιθυμητά αντικείμενα και από το 

Property Inspector έχετε δυνατότητα για: 69 

● Ευθυγράμμιση/Μετακίνηση πάνω 

● Ευθυγράμμιση/Μετακίνηση της μέσης 

● Ευθυγράμμιση/Μετακίνηση του κάτω μέρους 

● Ευθυγράμμιση/Μετακίνηση αριστερά 

● Ευθυγράμμιση/Μετακίνηση κέντρου 

● Στοίχιση δεξιά 

● Κατανομή αντικειμένων οριζόντια ή κάθετα 

Ευθυγράμμιση αντικειμένων σε pixel grid 

Η άκρη ενός αντικειμένου μπορεί να ευθυγραμμιστεί με την χρήση του pixel grid. 

Για να γίνει αυτό, το XD στρογγυλοποιεί τις ακέραιες τιμές για τις ιδιότητες X, Y, W, H 

ενός στοιχείου για να διασφαλίσει ότι οι τιμές είναι ευκρινείς.70 

Για ευθυγράμμιση ενός αντικειμένου σε pixel grid, κάντε δεξί click στο 

αντικείμενο και επιλέξτε Align to Pixel Grid.71 

 
69 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
70 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
71 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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*Σημείωση: Η ευθυγράμμιση στο pixel grid δεν σημαίνει πάντα ότι οι ιδιότητες X, Y, W, 

H δεν θα έχουν κλάσματα. Για γραμμές και μονοπάτια (σχήματα με κεντρικές πινελιές), 

μερικές φορές το X, Y πρέπει να τελειώνει σε 0,5 για να διατηρείται η διαδρομή 

ευθυγραμμισμένη με ακρίβεια στο pixel. 

Τακτοποίηση αντικειμένων (Arrange objects) 

Σε MAC: Για μετακίνηση ενός αντικειμένου στην επάνω ή στην κάτω θέση της ομάδας 

του, επιλέξτε το αντικείμενο που θέλετε να μετακινήσετε και στην συνέχεια: 72 

● Για μετακίνηση αντικειμένου στην κορυφή, επιλέξτε Object > Arrange > Bring 

To Front 

●  Για μετακίνηση αντικειμένου πάνω από το άμεσο αντικείμενο, επιλέξτε Object > 

Arrange > Bring Forward 

● Για μετακίνηση αντικειμένου πίσω από το άμεσο αντικείμενο, επιλέξτε Object > 

Arrange > Send Backward 

● Για μετακίνηση αντικειμένου κάτω από όλα τα αντικείμενα, επιλέξτε Object > 

Arrange > Send To Back 

Σε Windows: Κάντε δεξί click σε ένα αντικείμενο και διαλέχτε οποιαδήποτε από τις 

επιλογές Arrange πουεμφανίζονται στο μενού περιβάλλοντος ή επιλέξτε από την γραμμή 

εργαλείων στο πάνω μέρος Object>Arrange και την επιθυμητή κίνηση.  

Ομαδοποίηση αντικειμένων (Group) 

Υπάρχει δυνατότητα συνδυασμού πολλών αντικειμένων σε μια ομάδα, έτσι ώστε 

τα αντικείμενα να αντιμετωπίζονται ως μια μονάδα. Η ομάδα αντικειμένων, μετακινείται 

και μορφοποιείται, χωρίς να επηρεάζονται τα χαρακτηριστικά ή οι σχετικές θέσεις τους.73 
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Για παράδειγμα, μπορείτε  να ομαδοποιήσετε τα αντικείμενα σε ένα σχέδιο 

λογότυπου, έτσι ώστε να μπορείτε να μετακινήσετε ή να επεξεργαστείτε  το λογότυπο ως 

μία μονάδα. Στην συνέχεια,με την κατάργηση της ομαδοποίησης της ομάδας, ανακτάται ο 

έλεγχος σε μεμονωμένα στοιχεία. Για ομαδοποίηση ή κατάργηση της ομαδοποίησης από 

αντικείμενα, επιλέξτε τα και στην συνέχεια: 74 

● Σε MAC: επιλέξτε Object > Group ή Object > Ungroup αντίστοιχα από το κύριο 

μενού.  

● Σε Windows: επιλέξτε τα αντικείμενα για ομαδοποίηση ή επεξεργασία 

ομαδοποίησης, κάντε δεξί click και επιλέξτεGroup ή Ungroupαντίστοιχα. 

➔ Πως επιλέγουμε ένα αντικείμενο από μία ομάδα ή από πολλές ομάδες; 

Για να επιλέξουμε ένα αντικείμενο από μια ομάδα κάνουμε διπλό click ή Cmd + 

click (Mac) ή Ctrl + click (Windows) στο αντικείμενο της ομάδας. Για να επιλέξουμε 

αντικείμενα από πολλές ομάδες χρησιμοποιούμε Cmd/Ctrl+Shift+click για να 

προσθέσουμε αντικείμενα στην επιλογή, ανεξάρτητα από τις ομάδες στις οποίες ανήκουν. 

Αφού τα επιλέξουμε, μπορούμε εύκολα να αλλάξουμε κοινά χαρακτηριστικά στο 

Property Inspector και στην ομάδα, να κλειδώσουμε, να αλλάξουμε την ορατότητα και 

ούτω καθεξής.75 

Κλείδωμα και ξεκλείδωμα αντικειμένων (Lock and Unlock) 

Το κλείδωμα αντικειμένων εμποδίζει την δυνατότητα επιλογής και επεξεργασίας 

τους.76 

● Σε Mac: Επιλέξτε το αντικείμενο και κάντε click στο Object>Lock. Εναλλακτικά, 

κάντε δεξί click στο αντικείμενο και επιλέξτε Lock από το μενού περιβάλλοντος 

(Context menu). 

● ΣεWindows: Κάντε δεξί click στο αντικείμενο και επιλέξτε Lock από το μενού 

περιβάλλοντος (Context menu). 

 
74 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
75 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 
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76 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
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Κατα την επιλογή ενός κλειδωμένου αντικειμένου, εμφανίζεται ένα σχετικό εικονίδιο 

κλειδωματος. Για ξεκλείδωμα αντικειμένων, επιλέξτε τα  και στην συνέχεια κάντε click 

στο εικονίδιο ξεκλειδώματος ή εναλλακτικα στο Object>Unlock.77 

Αντιγραφή αντικειμένων (Duplicate objects) 

Επιλέξτε ένα ή περισσότερα αντικείμενα και στη συνέχεια: 78 

●  Σε Mac, κρατήστε πατημένο Option και σύρετε 

● Σε Windows, κρατήστε πατημένο Alt και σύρετε 

Εναλλακτικά, κάντε click στο Edit> Duplicate 

Αντιγραφή και επικόλληση αντικειμένων (Copy and Paste)  

Επιλέξτε ένα αντικείμενο ή μια ομάδα αντικειμένων. Για αντιγραφή επιλέξτε Ctrl 

+ C(Windows) ή Cmd + C(MAC) και για επικόλληση Ctrl + V(Windows) ή Cmd + V 

(MAC). Όταν το αντικείμενα επικολληθεί,  το XD το τοποθετεί έξυπνα στην ίδια θέση X 

και Y όπου βρισκόταν το αρχικό αντικείμενο. Αυτή η δυνατότητα είναι ιδιαίτερα χρήσιμη 

κατά την αντιγραφή κεφαλίδων ή υποσέλιδων σε πολλά artboards.79 

Υπάρχει επίσης δυνατότητα αντιγραφής του στυλ ενός αντικειμένου και 

επικόλλησης σε άλλα αντικείμενα ή στοιχεία κειμένου. Αντιγράψτε το αντικείμενο, κάντε 

δεξί click (σε Windows) ή click με Control (σε MAC) σε άλλο αντικείμενο και επιλέξτε 

Paste Appearance. Μόνο η μορφοποίηση αντικειμένου αντιγράφεται και επικολλάται.80 

Αναστροφή αντικειμένων (Flip objects) 

Αφού επιλέξετε το στοιχείο που επιθυμείτε να αναστραφεί στο artboard, διαλέξτε 

Κατακόρυφη (Vertical) ή Οριζόντια (Horizontal) από το Property Inspector. 

Κάνοντας click στο εικονίδιο αναστροφής για δεύτερη φορά, τα στοιχεία επαναφέρονται 

στην αρχική τους κατάσταση. Τα εικονίδια μειώνονται εάν το αντικείμενο που έχει 
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επιλεχθεί δεν μπορεί να αναστραφεί. Συχνά αυτό έχει να κάνει με το στοιχείο στον καμβά 

που επιλέχθηκε.81 

 

 

*Εξαιρέσεις κατά την εργασία με flip:82 

● Το Flip δεν υποστηρίζεται σε artboard, επαναλαμβανόμενο πλέγμα (repeat grids) 

και components. Ωστόσο, μπορεί να επιλεχθεί ολόκληρο το περιεχόμενο σε ένα 

artboard και να αναστραφεί.  

● Όταν πρόκειται για εικόνες, υπάρχει δυνατότητα αναστροφής είτε της μάσκας που 

περιβάλλει την εικόνα, είτε της ίδιας της εικόνας γεμίσματος ή και των δύο, 

ανάλογα με την κατάσταση επιλογής.  

● Η θέση του αναποδογυρισμένου αντικειμένου δεν αλλάζει. 

● Το Flip παίρνει το κεντρικό σημείο του αντικειμένου ή της ομάδας και 

αναποδογυρίζει κατά μήκος του άξονα. 

● Το Flip δεν επηρεάζει τις σκιές.  

● Εάν ένα αντικείμενο περιστρέφεται, το αντικείμενο αναστρέφεται κατά μήκος του 

οπτικού άξονα και όχι του άξονα του αρχικού αντικειμένου. 

● Εάν επιλεχθούν πολλά αντικείμενα, τα αντικείμενα αναστρέφονται ως ομάδα. 

 
81 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 
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Εφαρμογή χρώματος (Fill) 

Στο Property Inspector του XD, στην επιλογή Fill εμφανίζεται το ευρέως γνωστό, πίνακα 

χρωμάτων. 

 

Πέρα από τα υπάρχοντα χρώματα παρέχεται η δυνατότητα δημιουργίας επιπλέον 

χρωμάτων, καθορισμού των τιμών των RGB, HSB και χρήσης του eyedropper, με το 

οποίο διαλέγεις το χρώμα που επιθυμείς  από οπουδήποτε αλλού. 

Σκιάσεις (Shadows) 

Το πρόγραμμα διαθέτει δύο διαφορετικές σκιάσεις: την εσωτερική (inner) και την 

εξωτερική (drop). 83 

 

 

 
83 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 
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Η λειτουργία είναι αρκετά απλή. Προσθέστε ένα αντικείμενο στο artboard, 

επιλέξτε το και απο το Property Inspector>Effects, επιλέξτε την επιθυμητή σκίαση και 

χρώμα.84 

Οι τιμές Χ, Υ που παρουσιάζονται στην παραπάνω εικόνα εντός του πράσινου 

πλαισίου φανερώνουν την μετατόπιση κατευθύνσεων Χ και Υ. Το Β αντίστοιχα, 

αναφέρεται στο επιθυμητό για την σκίαση θάμπωμα. 85 

Η αφαίρεση οποιασδήποτε πραγματοποιηθείσας προσθήκης, γίνεται εύκολα 

ξεκλικάρωντας τα πεδία Fill, Border, Inner, Drop Shadow στο Property Inspector.86 

2.2.2 Δημιουργία επαναλαμβανόμενων στοιχείων (Create repeating elements) 

Κατά την σχεδίαση εφαρμογών δημιουργείται συχνά η ανάγκη πολλαπλής 

επανάληψης στοιχείων. Το Repeat Grid μπορεί να αλλάξει μια ομάδα στοιχείων σε 

επαναλαμβανόμενα στοιχεία. Σύρετε το στοιχείο προς οποιαδήποτε κατεύθυνση και το 

grid θα επαναληφθεί. Έτσι οποιαδήποτε αλλαγή, θα εφαρμοστεί αυτόματα σε όλο το 

grid.87 

Για παράδειγμα, σε ένα κείμενο στο grid, μπορείτε να αντιγράψετε μόνο το στυλ 

του κειμένου και όχι το περιεχόμενο. Έτσι, επιτυγχάνεται ταχεία διαμόρφωση των 

στοιχείων του κειμένου, διατηρώντας παράλληλα το περιεχόμενο.88 

Δημιουργία Repeat Grid 

Σχεδιάστε το βασικό στοιχείο που θέλετε να επαναλάβετε. Για παράδειγμα, έναν 

συνδυασμό μικρογραφιών εικόνας και κειμένου. Επιλέξτε επαναλαμβανόμενα τα στοιχεία 

και στην συνέχεια από το Property Inspector το Repeat Grid. Εναλλακτικά, επιλέξτε τον 
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συνδυασμό Cmd+R (για MAC) και τον συνδυασμό Ctrl+R (για Windows). Μεγάλες 

λαβές θα εμφανιστούν στα όρια του στοιχείου.89 

Για επανάληψη του στοιχείου σε ένα κατακόρυφο grid, σύρετε τη λαβή στο κάτω 

μέρος του στοιχείου. Για επανάληψη του στοιχείου σε ένα οριζόντιο grid, σύρετε τη λαβή 

στα δεξιά του στοιχείου. Για την κατάργηση ενός grid, επιλέξτε Property 

Inspector>Ungroup grid. Με την ολοκλήρωση των επιθυμητών αλλαγών, μπορείτε να 

εξέλθετε από το περιβάλλον επεξεργασίας, πατώντας το πλήκτρο Esc.90 

Padding (Επένδυση) 

Για προσαρμογή της επένδυσης μεταξύ δύο στοιχείων στο grid, τοποθετήστε το δείκτη 

του ποντικιού πάνω από το κενό μεταξύ των στοιχείων. Όταν ο κέρσορας αλλάξει σε διπλά 

βέλη, σύρετε για αυξομείωση του padding.91 

➔ Θέλουμε να προσθέσουμε στο grid κάποια μεμονωμένα στοιχεία από ένα κείμενο;  

Για να επιλέξουμε το κομμάτι του κειμένου: Cmd + click (για MAC) ή Ctrl + click 

(για Windows) στο Repeat Grid. Για να επεξεργαστούμε το κείμενο πατάμε διπλό click σε 

αυτό και το αλλάζουμε.92 

➔ Θέλουμε να προσθέσουμε ένα ολόκληρο αρχείο κειμένου; 

Δεν υπάρχει πιο απλός τρόπος από το να σύρουμε το αρχείο του κειμένου μας από τον 

υπολογιστή στο artboard αρκεί να είναι αρχείο .txt.93 
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92 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Εικόνες σε Repeat Grid 

Με τις εικόνες μπορούν να δημιουργηθούν επαναλαμβανόμενα μοτίβα 

αντικειμένων, όπου το γέμισμα εικόνας ενός αντικειμένου επαναλαμβάνεται σε ένα μοτίβο 

που ορίζει ο χρήστης.94 

Ένα μοτίβο γεμίσματος εικόνας δημιουργείται σύροντας εικόνες μία προς μία σε 

ένα αντικείμενο. Για αντικατάσταση των εικόνων αυτών επιλέξτε τις εικόνες από τον 

υπολογιστή και τοποθετήστε στην επιθυμητή θέση. Η προηγούμενη φωτογραφία απλά θα 

αντικατασταθεί.95 

Σύνδεση ενός repeat grid για μία αλληλεπίδραση96 

1. Στη λειτουργία Design δημιουργήστε ένα δεύτερο artboard στο αρχείο 

χρησιμοποιώντας το εργαλείο Artboard (A). 

2. Μεταβείτε στη λειτουργία Prototype. 

3. Επιλέξτε το Repeat Grid στο πρώτο artboard. Ένας σύνδεσμος με ένα βέλος 

εμφανίζεται στη δεξιά πλευρά του αντικειμένου στο μέσο του. 

4. Σύρετε την υποδοχή στο δεύτερο artboard. Επιλέξτε τις επιλογές μετάβασης στο 

αναδυόμενο παράθυρο και πατήστε Esc. 

5. Κάντε προεπισκόπηση είτε πατώντας το κουμπί Αναπαραγωγή στην πάνω δεξιά 

γωνία του πλαισίου της εφαρμογής είτε χρησιμοποιώντας τη συντόμευση 

πληκτρολογίου Cmd + Enter (για MAC) ή Ctrl + Enter (για Windows). Κάντε 

click οπουδήποτε στο Repeat Grid για αναπαραγωγή της αλληλεπίδρασης. 

 
94 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 
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Για σύνδεση ενός μεμονωμένου στοιχείου από ένα repeat grid για μία αλληλεπίδραση 

ακολουθείται η ίδια διαδικασία, μόνο που θα επιλεχθεί μεμονωμένα το επιθυμητό 

αντικείμενο.97 

Δημιουργία μιας ομάδας στοιχείων μέσα στο Repeat Grid και μιας αλληλεπίδρασης από 

την ομάδα 

Δίνεται επίσης η δυνατότητα δημιουργίας μιας ομάδας αντικειμένων στο Repeat Grid 

και, στη συνέχεια, δημιουργίας αλληλεπιδράσεων από αυτήν την ομάδα:98 

1. Επιλέξτε ένα αντικείμενο στο Repeat Grid και κάντε click με Shift σε άλλα 

αντικείμενα για προσθήκη στα επιλεγμένα. 

2. Αφού επιλέξετε  τα αντικείμενα κάντε δεξί click και στην συνέχεια Group.  

3. Σε Prototype mode σύρετε την εφαρμογή σύνδεσης, από την ομάδα στο artboard 

που θέλετε να συνδέσετε. 

4. Επιλέξτε την Προεπισκόπηση.  

2.2.3 Δημιουργία σχεδίων προοπτικής με 3D μετασχηματισμούς 

Η λειτουργία 3D Transforms επιτρέπει την προσομοίωση του βάθους και της 

προοπτικής των αντικειμένων στα design του χρήστη, με ελάχιστη προσπάθεια. 

Συνδυάζοντας τη δυνατότητα περιστροφής οποιουδήποτε αντικειμένου κατά τον οριζόντιο 

και τον κατακόρυφο άξονά του καθώς και την εφαρμογή βάθους κατά μήκος του άξονα Z, 

δίνεται η δυνατότητα μίμησης οπτικών εφέ, όπως είναι τα τρισδιάστατα κινούμενα 

σχέδια,οι μακέτες σε προοπτική, οι αλληλεπιδράσεις και πολλά άλλα. 99 

  

 
97 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
98 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool Prototype 

Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
99 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 

https://www.adobe.com/gr_en/products/xd/features/3d-transforms.html
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#add-depth
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Προσομοίωση βάθους και προοπτικής αντικειμένου 

Η εφαρμογή 3D Transforms σε σύνθετες συνθέσεις, όπως scroll groups, repeat grids, 

stacks, padding, γίνεται με τον εξής τρόπο: 100 

• Με ενεργοποιημένο το 3D Transforms, παρέχεται η δυνατότητα ελέγχου του 

προσανατολισμού των αντικειμένων κατά μήκος των αξόνων X και Y και 

εφαρμογής βάθους κατά μήκος του άξονα Z. 

• Για προσομοίωση ενός εφέ 3D, ενεργοποιήστε πρώτα το 3D Transforms στο 

Property Inspector, και στη συνέχεια κάντε χρήση του εικονιδίου gizmo  για 

τροποποίηση του προσανατολισμού.  

• Τέλος, εφαρμόστε βάθος στα αντικείμενα σχεδίασης. 

Ενεργοποίηση 3D μετασχηματισμών 

Για ενεργοποίηση του 3D Transforms, επιλέξτε το απαιτούμενο αντικείμενο και 

κάντε click στο εικονίδιο 3D Transforms στο Property Inspector. Νέα στοιχεία ελέγχου 

αντικειμένων εμφανίζονται στην ενότητα Transforms και το εικονίδιο gizmo  είναι 

διαθέσιμο στο κέντρο του τρέχοντος επιλεγμένου αντικειμένου. Μετακινήστε το  

εικονίδιο προς τα αριστερά, δεξιά, πάνω και κάτω. Μπορείτε να τροποποιήσετε τις τιμές 

των αξόνων στο Property Inspector ή να περιστρέψετε το εικονίδιο gizmo για 

αντίστοιχη περιστροφή αντικειμένων κατά μήκος του άξονα.101 

Περιστροφή αντικειμένων κατά μήκος του άξονα X ή Y 

Αφού ενεργοποιήσετε το εικονίδιο 3D Transforms στο Property Inspector, για 

τροποποίηση του προσανατολισμού των αντικειμένων κατά μήκος των αξόνων X και Y, 

ακολουθήστε τα εξής βήματα:102 

 
100 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
101 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
102 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 

https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#add-depth
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#enable
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#enable
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#enable
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#rotate-objects
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#add-depth
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#add-depth
https://helpx.adobe.com/gr_en/xd/help/design-in-perspective-using-3D-transforms.html#add-depth
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1. Επιλέξτε το αντικείμενο που θέλετε να περιστρέψετε.  

2. Εισάγετε τις τιμές προσανατολισμού στο Property Inspector. Εναλλακτικά, κάντε 

click και σύρετε το  εικονίδιο gizmo, που εμφανίζεται στο κέντρο του 

αντικειμένου. 

3. Κατα την προσαρμογή των τιμών, θα παρατηρήσετε ότι τα αντικείμενα αρχίζουν 

να περιστρέφονται κατά μήκος του απαιτούμενου άξονα.  

Εφαρμογή βάθους κατά μήκος του άξονα Z 

Για εφαρμογή βάθους κατά μήκος του άξονα Z, ακολουθήστε τα εξής βήματα:103 

1. Επιλέξτε το επιθυμητό αντικείμενο. 

2. Τοποθετήστε το δείκτη του ποντικιού στο κεντρικό σημείο του  εικονιδίου 

gizmo. 

3. Εμφανίζεται το εικονίδιο αγκύρωσης  και μπορείτε να μετακινήσετε το 

επιλεγμένο αντικείμενο πάνω και κάτω. 

Πράγματα που πρέπει να προσέξετε:104 

● Το εικονίδιο 3D Transforms  εμφανίζει ή αποκρύπτει μόνο τα χειριστήρια και 

το gizmo. Δεν βοηθά στη δημιουργία ενός τρισδιάστατου περιβάλλοντος ή στην 

απενεργοποίηση ήδη εφαρμοσμένων μετασχηματισμών. 

● Κατα την αλλαγή του μεγέθους των αντικειμένων που έχουν περιστροφή X ή Y,  η 

τιμή βάθους Z αλλάζει ταυτόχρονα, αυτόματα, με αποτέλεσμα την αναδιάταξη του 

περιεχομένου. Για παράδειγμα, κατα τον σχεδιασμό μιας ομάδας οθονών, κάθε 

οθόνη περιστρέφεται με την ίδια γωνία, αλλά με διαφορετικό βάθος. Εάν επιλέξετε 

αυτές τις οθόνες και αλλάξετε το μέγεθός τους, θα αλλάξετε το μέγεθός τους, όπως 

 
103 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
104 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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απαιτείται. Ωστόσο, η τιμή Z αλλάζει για κάθε κάρτα και οδηγεί σε αναδιάταξη 

περιεχομένου. 

● Κατα την αλλαγή της τιμής βάθους Z για οποιοδήποτε αντικείμενο, το XD δεν 

υποστηρίζει μεθόδους ταξινόμησης επιπέδων, όπως Bring to Front, Send to Back 

και αναδιάταξη από το παράθυρο Layers. 

Συμβουλές105 

● Μπορείτε να επαναφέρετε το αντικείμενο στην κατάσταση 3D ανά πάσα στιγμή. 

Κάντε δεξί click στο επιλεγμένο αντικείμενο και στην συνέχεια Reset  3D 

Transforms. Εναλλακτικά, μπορείτε να χρησιμοποιήσετε το ⌥⌘T (για MAC) 

και το Alt + Ctrl + T (για Windows) για να επαναφορά του 3D Transforms. 

● Μπορείτε να επιλέξετε την εμφάνιση ή την απόκρυψη των στοιχείων ελέγχου 3D 

Transforms. Χρησιμοποιήστε τα ⌘T (για MAC) και Ctrl + T (για Windows) για 

εμφάνιση ή για απόκρυψη των μετασχηματισμών 3D. 

2.2.4 Επεξεργασία αντικειμένων με χρήση Boolean λειτουργιών 

Σε αυτό το κεφάλαιο αναλύονται οι τρόποι δημιουργίας πολύπλοκων σχημάτων, 

συνδυάζοντας ομάδες αντικειμένων, με την χρήση Boolean λειτουργιών.  

 

Συνδυασμός αντικειμένων με χρήση Boolean λειτουργιών 

Μπορείτε να συνδυάσετε απλά σχήματα για τη δημιουργία σύνθετων σχημάτων 

και αντικειμένων. 106 

Επιλέξτε τα σχήματα που θέλετε να συνδυάσετε και στην συνέχεια, διαλέξτε μία 

από τις παρακάτω επιλογές στο Property Inspector:107 

 
105 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
106 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 

107 Abdallah, R. (2022). Take advantage of Adobe XD software to support the customer's experience in selecting product 

specifications. Journal of Design Sciences and Applied Arts, 3(1), 295-306. 
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Add to Shape Area /Προσθήκη στην περιοχή σχήματος 

 

Subtract from Shape Area /Αφαίρεση από την περιοχή σχήματος 

 

Intersect Shape Areas /Περιοχές σχήματος τομής 
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Exclude Overlapping Shape Areas /Εξαίρεση των επικαλυπτόμενων περιοχών 

σχήματος 

 

Μάσκα αντικειμένων 

Η χρήση μασκών, βοηθά τον χρήστη να εστιάσει στα απαιτούμενα μέρη μιας 

εικόνας, να θολώσει ή να οξύνει μια εικόνα καθώς και να ορίσει την αδιαφάνεια των 

επιπέδων.108 

 

2.3 Εργαλεία κειμένου (Text Tools) και Γραμματοσειρές  

2.3.1 Χρήση design και text tools 

Δεν υπάρχει πιο εύκολο πράγμα από την σχεδίαση απλών γεωμετρικών σχημάτων 

στο Adobe XD. Στο αριστερό μέρος της εφαρμογής θα συναντήσετε τα σχήματα: τρίγωνο, 

τετράγωνο, κύκλο και τη γραμμή. Βασικά σχήματα που μέσα από αυτά παρέχεται η 

δυνατότητα δημιουργίας και άλλων σχημάτων. Για παράδειγμα με τον κύκλο ο χρήστης 

μπορεί να δημιουργήσει την έλλειψη. Στη συνέχεια, αναλύεται ο τρόπος δημιουργίας 

απλών και σύνθετων σχημάτων και αντικειμένων καθώς και ο τρόπος επικάλυψης 

τμήματος ενός σχήματος.109 

  

 
108 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
109 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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Ορθογώνιο και Τετράγωνο 

Για τη δημιουργία του ορθογωνίου, επιλέξτε το σχήμα του τετραγώνου και σύρετε 

διαγώνια μέχρι να φτιάξετε το ορθογώνιο που θέλετε. Για τη δημιουργία του τετραγώνου, 

σύρετε πάλι διαγώνια έχοντας πατημένο το Shift. Για τη δημιουργία ενός ορθογωνίου με 

καμπύλες γωνίες, αρχικά σχεδιάστε το ορθογώνιο. Μέσα σε αυτό, θα δείτε τις λαβές 

επεξεργασίας ακτίνας. Σύρετε προς το κέντρο μία από αυτές. Μπορείτε να 

χρησιμοποιήσετε το Property Inspector για εισαγωγή μιας συγκεκριμένης τιμής για την 

ακτίνα μιας ή περισσότερων γωνιών.110 

Ρύθμιση της ακτίνας μόνο μιας γωνίας: 

Επεξεργαστείτε κάθε τιμή ακτίνας γωνίας ξεχωριστά, αφού πρώτα επιλέξετε  

στο Property Inspector.111 

Ρύθμιση ακτίνας όλων των γωνιών ταυτόχρονα: 

Επεξεργαστείτε την τιμή της ακτίνας αφού επιλέξετε  στο Property 

Inspector.112 

 

  

 
110 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
111 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
112 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Κύκλος και Έλλειψη 

Για τη δημιουργία της έλλειψης, επιλέξτε το σχήμα του κύκλου και σύρετε 

διαγώνια για να δημιουργήσετε μια έλλειψη. Για τη δημιουργία του κύκλου, σύρετε 

διαγώνια έχοντας πατημένο το Shift.113 

Τρίγωνο και Πολύγωνο 

Για τη δημιουργία του τρίγωνου, επιλέξτε το σχήμα του τριγώνου από τη γραμμή 

εργαλείων. Για σχεδίαση ενός ισόπλευρου τρίγωνου, σύρετε κρατώντας πατημένο το 

Shift. Μπορείτε να χρησιμοποιήσετε το αριστερό και το δεξί πλήκτρο βέλους ενώ 

σχεδιάζετε, για να αλλάξετε το σχήμα του τριγώνου σε σχήμα αστεριού, όπως και τα πάνω 

και κάτω βέλη κατα τη διάρκεια  σχεδίασης του τριγώνου.  

Αλλαγή τιμών από το Property Inspector 

 

● Το πρώτο στα αριστερά είναι το πλευρικό πλήθος(κίτρινο πλαίσιο) 

● Το μεσαίο είναι η ακτίνα γωνίας (πράσινο πλαίσιο) 

● Και το τελευταίο στη σειρά είναι ο λόγος αστεριών (κόκκινο πλαίσιο) 

Γραμμές 

Επιλέξτε το σχήμα της γραμμής και σύρετε προς το σημείο που επιθυμείτε να τελειώνει η 

γραμμή.114 

 
113 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
114 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Το pen tool 

Η απλούστερη διαδρομή που μπορείτε να σχεδιάσετε με το pen tool είναι μια 

ευθεία γραμμή. Κάντε click στο pen tool για να δημιουργήσετε δύο σημεία αγκύρωσης. 

Συνεχίζοντας να κάνετε click, δημιουργήστε μια διαδρομή που αποτελείται από 

ευθύγραμμα τμήματα που συνδέονται με γωνιακά σημεία.115 

Επιλέξτε το pen tool  και τοποθετήστε το στο σημείο που επιθυμείτε να αρχίζει 

το ευθύγραμμο τμήμα. Κάνοντας click, ορίζετε το πρώτο σημείο αγκύρωσης. Ξανα κάνετε  

click στο σημείο που επιθυμείτε να τελειώσει το τμήμα (Shift - click για περιορισμό της 

γωνίας του τμήματος σε πολλαπλάσιο των 45°). Συνεχίστε να κάνετε click για καθορισμό 

σημείων αγκύρωσης για περισσότερα ευθύγραμμα τμήματα. Για μετατροπή ενός σημείου 

αγκύρωσης από ευθεία σε κυρτή και αντίστροφα, κάντε διπλό click στο σημείο 

αγκύρωσης.116 

Το τελευταίο σημείο αγκύρωσης που θα προστεθεί, εμφανίζεται πάντα ως 

συμπαγής κύκλος, υποδεικνύοντας ότι είναι επιλεγμένο. Τα προηγουμένως καθορισμένα 

σημεία αγκύρωσης γίνονται κούφια και αναιρείται η επιλογή τους, καθώς προστίθενται 

περισσότερα σημεία αγκύρωσης. Για την ολοκλήρωση της διαδρομής, υπάρχουν οι 

παρακάτω επιλογές:117 

● Αν θέλετε να παραμείνει ανοιχτή η διαδρομή, κάντε click στο Esc.  

● Για κλείσιμο της διαδρομής, τοποθετήστε το pen tool πάνω από το πρώτο (κοίλο) 

σημείο αγκύρωσης, κάντε click ή σύρετε, προκειμένου να κλείσει η διαδρομή. 

● Για να επιλέξετε και να σύρετε το σημείο έναρξης, χωρίς κλείσιμο της διαδρομής, 

κρατήστε πατημένο το πλήκτρο Cmd (για MAC) / Ctrl (για Windows). 

 
115 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
116 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
117 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Καμπύλες 

Για δημιουργία καμπυλών, επιλέξτε το pen tool . Στη συνέχεια,  τοποθετήστε το 

pen tool στο σημείο που επιθυμείτε να ξεκινάει η καμπύλη και κρατήστε πατημένο το 

κουμπί του ποντικιού. Σύρετε για ορισμό της κλίσης του τμήματος καμπύλης που 

δημιουργείται και αφήστε το κουμπί του ποντικιού. Κρατήστε πατημένο το πλήκτρο Shift 

ενώ το σύρετε για να περιορίσετε το εργαλείο σε πολλαπλάσια των 15°.118 

Τοποθετήστε το pen tool στο σημείο που επιθυμείτε να τελειώνει το τμήμα καμπύλης. 

Υπάρχουν οι παρακάτω επιλογές: 119 

● Για δημιουργία μιας καμπύλης σε σχήμα C, σύρετε προς μια κατεύθυνση αντίθετη 

από την προηγούμενη γραμμή κατεύθυνσης και αφήστε το κουμπί του ποντικιού. 

● Για δημιουργία μιας καμπύλης σε σχήμα S, σύρετε προς την ίδια κατεύθυνση με 

την προηγούμενη γραμμή κατεύθυνσης και αφήστε το κουμπί του ποντικιού. 

● Για δημιουργία μιας σειράς από ομαλές καμπύλες, συνεχίστε να σύρετε το pen tool 

από διαφορετικές τοποθεσίες. 

Υπάρχει επίσης δυνατότητα να σύρετε γραμμές κατεύθυνσης, με σκοπό τον 

διαχωρισμό των γραμμών κατεύθυνσης ενός σημείου αγκύρωσης. Η διαδρομή θα 

ολοκληρωθεί κάνοντας ένα από τα παρακάτω:120 

● Για κλείσιμο της διαδρομής, τοποθετήστε το pen tool πάνω από το πρώτο (κοίλο) 

σημείο αγκύρωσης, κάντε click ή σύρετε για κλείσιμο της διαδρομής. 

● Για να παραμείνει ανοιχτή η διαδρομή, πατήστε Esc. 

  

 
118 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
119 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
120 Rajendran, R. K. (2023). Exploring Best Practices in Mobile App Design Patterns and Tools: A User-Centered 

Approach. In Designing and Developing Innovative Mobile Applications (pp. 371-380). IGI Global. 
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Σχεδίαση ευθειών γραμμών, ακολουθούμενες από καμπύλες 121 

1. Χρησιμοποιώντας το στυλό ( ), κάντε click σε γωνιακά σημεία σε δύο θέσεις για 

δημιουργία ενός ευθύγραμμου τμήματος. 

2. Τοποθετήστε το pen tool πάνω από το επιλεγμένο τελικό σημείο για καθορισμό της 

κλίσης του καμπυλωμένου τμήματος που δημιουργείται. Κάντε click στο σημείο 

αγκύρωσης και σύρετε τη γραμμή κατεύθυνσης που εμφανίζεται. 

3. Τοποθετήστε το pen tool στο επόμενο σημείο αγκύρωσης και κάντε click ή σύρετε 

το νέο σημείο αγκύρωσης για ολοκλήρωση της καμπύλης. 

Σχεδίαση καμπυλών ακολουθούμενες από ευθείες γραμμές 122 

1. Χρησιμοποιώντας το pen tool ( ), σύρετε για δημιουργία του πρώτου ομαλού 

σημείου του καμπυλωμένου τμήματος και στην συνέχεια, αφήστε το κουμπί του 

ποντικιού. 

2. Επανατοποθετήστε το pen tool στο σημείο που επιθυμείτενα τελειώνει η καμπύλη, 

σύρετε για ολοκλήρωση και αφήστε. 

3. Τοποθετήστε το pen tool πάνω από το επιλεγμένο τελικό σημείο. 

4. Τέλος, επανατοποθετήστε το pen tool στο σημείο που επιθυμείτε να τελειώσει το 

ευθύγραμμο τμήμα και κάντε click για ολοκλήρωση. 

Σχεδίαση δύο (2) καμπύλων τμημάτων, που συνδέονται με μια γωνία123 

1. Χρησιμοποιώντας το pen tool ( ), σύρετε για δημιουργία του πρώτου ομαλού 

σημείου ενός καμπυλωμένου τμήματος. 

2. Για δημιουργία μιας καμπύλης με ένα δεύτερο ομαλό σημείο, επανατοποθετήστε 

το pen tool και σύρετε. 

 
121 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
122 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
123 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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3. Επανατοποθετήστε το pen tool στο σημείο που επιθυμείτε να τελειώσει το δεύτερο 

καμπύλο τμήμα και σύρετε ένα νέο ομαλό σημείο για ολοκλήρωση του δεύτερου 

καμπύλου τμήματος. 

Λειτουργία σχεδίασης έναντι επεξεργασίας 

Για αλλαγή, από λειτουργία σχεδίασης σε λειτουργία επεξεργασίας, πατήστε Esc. 

Υπάρχει επιπρόσθετα δυνατότητα εισαγωγής του χρήστη στη «Λειτουργία επεξεργασίας 

διαδρομής (Path edit mode), με διπλό click στο σχήμα ή στη τρέχουσα διαδρομή. Τα 

σημεία αγκύρωσης είναι ορατά, αλλά η κίνηση του ποντικιού δεν επηρεάζει τίποτα. 

Μπορείτε να χειριστείτε υπάρχοντα σημεία  ή να εισάγετε νέα σε υπάρχοντα τμήματα της 

διαδρομής.124 

*Όταν σχεδιάζετε με το pen tool μπορείτε να εκτελέσετε όλες τις αλλαγές που 

περιγράφονται παραπάνω εκτός από τη σχεδίαση νέων τμημάτων. 

Επέκταση υπαρχουσών διαδρομών  

Με την επιλογή του pen tool, όλες οι διαδρομές στον πίνακα γραφικών κάτω από 

την οθόνη του ποντικιού χειρίζονται το σημείο έναρξης και λήξης τους. Για να συνεχίσετε 

να σχεδιάζετε τη διαδρομή από αυτό το σημείο, κάντε click σε μία από τις λαβές.125 

Επιλογή και Απενεργοποίηση των σημείων αγκύρωσης  

Τα σημεία αγκύρωσης, εμφανίζονται με διπλό click στο design. Στη συνέχεια, 

κάνοντας click σε ένα από τα σημεία, το επιλέγετε. Για πολλαπλή επιλογή σημείων, 

κρατήστε πατημένο το Shift και επιλέξτε τα σημεία.Μπορείτε να επεξεργαστείτε τις 

ιδιότητες των σημείων (Συντεταγμένες Χ και Υ) στο Property Inspector.126 

 
124 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
125 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
126 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Κατά την τοποθέτηση ενός νέου σημείου ή τη μεταφορά ενός υπάρχοντος, 

εμφανίζονται κλειδωμένες γραμμές, όταν μια άγκυρα βρίσκεται κάθετα ή οριζόντια κοντά 

σε κάποιο άλλο σημείο. Κρατήστε πατημένο το πλήκτρο Cmd (για MAC) /Ctrl (για 

Windows) για να απενεργοποιήσετε το κλείδωμα του σημείου.127 

Επεξεργασία, Προσθήκη, Διαγραφή σημείων αγκύρωσης  

Κάντε διπλό click στο σχέδιο για να το επιλέξετε και να προβάλετε τα υπάρχοντα 

σημεία. Κάντε click στη διαδρομή για προσθήκη νέων σημείων στη θέση του δρομέα. Για 

διαγραφή σημείων, επιλέξτε τα και στην συνέχεια πατήστε Delete. 128 

Μέτρηση Αποστάσεων  

Για μέτρηση αποστάσεων μεταξύ ενός αντικειμένου και του artboard ή μεταξύ 

διαφόρων αντικειμένων, κάντε click στο αντικείμενο και πατήστε Option (για MAC) ή 

Alt (για Windows).129 

*Εάν το επιλεγμένο αντικείμενο δεν είναι τετράγωνο ή ορθογώνιο, τότε το XD σχεδιάζει 

ένα πλαίσιο οριοθέτησης γύρω από το αντικείμενο και εμφανίζει τις μετρήσεις από τα όρια 

του πλαισίου οριοθέτησης. 

Μέτρηση απόστασης ενός αντικειμένου από τις άκρες του artboard: 

Κάντε click στο αντικείμενο και πατήστε Option (για MAC) / Alt (για Windows). 

Η Adobe XD μετράει τις αποστάσεις και εμφανίζει τις μετρήσεις, για όσο διάστημα πατάτε 

το πλήκτρο Option/ Alt.130 

  

 
127 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
128 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
129 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
130 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Μέτρηση απόστασης ενός αντικειμένου από άλλα αντικείμενα στο artboard: 

Κάντε click στο αντικείμενο και πατήστε Option (για MAC) / Alt (για Windows) 

και τοποθετήστε το ποντίκι πάνω από άλλα αντικείμενα. Η Adobe XD μετρά τις 

αποστάσεις μεταξύ των πλησιέστερων ορίων και των δύο αντικειμένων και εμφανίζει τις 

μετρήσεις αρκεί να πατήσουμε Option /Alt.131 

Εισαγωγή κειμένου σε ένα σημείο του artboard 

Επιλέξτε το εργαλείο κειμένου και κάντε click στη θέση από όπου θέλετε να 

ξεκινήσει το κείμενο. Πληκτρολογήστε το κείμενο και αν θέλετε να αλλάξετε το κείμενο, 

πατήστε  Esc. Αν θέλετε να προχωρήσετε στην επόμενη σειρά πατήστε το Return.132 

Κατα την πληκτρολόγηση κειμένου, επιλέγοντας ένα σημείο στο artboard, θα δείτε 

μια οριζόντια γραμμή κειμένου που ξεκινά από το σημείο που κάνατε click. Η γραμμή 

κειμένου επεκτείνεται καθώς πραγματοποιείται εισαγωγή χαρακτήρων. Κάθε γραμμή 

κειμένου είναι ανεξάρτητη. Η γραμμή επεκτείνεται ή συρρικνώνεται καθώς την 

επεξεργάζεστε, αλλά δεν αναδιπλώνεται στην επόμενη γραμμή.133 

Μπορείτε να πληκτρολογήσετε κείμενο πάνω από άλλα αντικείμενα, ώστε να 

εμφανίζεται μπροστά από το εκάστοτε αντικείμενο με την επιλογή Object>Arrange 

options.134 

Πραγματοποίηση ορθογραφικού ελέγχου; 

Με την επιλογή Edit>Turn Spell Check On. Οι ανορθόγραφες λέξεις 

υπογραμμίζονται με κόκκινο χρώμα και οι λέξεις που διορθώνονται αυτόματα 

υπογραμμίζονται με μπλε. Τα γραμματικά λάθη επισημαίνονται με πράσινη υπογράμμιση.  

Κάντε δεξί click στην ανορθόγραφη λέξη και επιλέξτε την ορθογραφία με βάση τα 

 
131 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
132 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
133 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
134 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
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συμφραζόμενα από την προτεινόμενη λίστα, ακριβώς όπως στο Word των Windows. Για 

επαναφορά των ορθογραφικών που διορθώθηκαν αυτόματα, στη λέξη που γράψατε 

αρχικά, πατήστε τον συνδυασμό Cmd + Z (για Mac) και τον συνδυασμό Ctrl + Z (για 

Windows).135 

Εισαγωγή κειμένου από αρχεία κειμένου; 

Υπάρχουν τρεις τρόποι εισαγωγής ενός ήδη υπάρχοντος αρχείου κειμένου:136 

1. Να σύρετε ένα αρχείο κειμένου στο artboard. 

2. Να σύρετε ένα αρχείο κειμένου σε ένα repeat grid. Ουσιαστικά εδώ θα εισάγετε 

ένα κείμενο πάνω από το ήδη υπάρχον κείμενο που υπάρχει στο artboard. Το παλιό 

αρχείο θα αντικατασταθεί με το νέο. 

3. Να αντιγράψετε και να επικολλήσετε κείμενο στο artboard. 

Αλλαγή μεγέθους στο κείμενο 

Με βάση τις ανάγκες σχεδίασης, επιλέξτε ένα αντικείμενο κειμένου. Υπάρχουν οι 

εξής επιλογές:137 

 

  

 
135 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
136 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
137 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
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Auto Width 

Ουσιαστικά, το πρώτο εικονίδιο μέσα στη κίτρινη έλλειψη, είναι το αυτόματο 

πλάτος. Πατώντας πάνω σε αυτό μεγαλώνει το πλάτος και έτσι, υπάρχει δυνατότητα 

προσθήκης κειμένου στην ίδια γραμμή.138 

Auto Height 

Το μεσαίο εικονίδιο αναφέρεται στο αυτόματο ύψος. Για την προσθήκη παραπάνω 

κειμένου από μία γραμμή θα χρησιμοποιήσετε την συγκεκριμένη λειτουργία.  139 

Το Auto Height επιτρέπει στο κείμενο της περιοχής να προσαρμόζει αυτόματα το 

ύψος του για να ταιριάζει στο περιεχόμενο. Κατα τον σχεδιασμό ενός κειμένου περιοχής, 

αυτή η επιλογή είναι προεπιλεγμένη. 140 

Fixed Size 

Κατα την προσθήκη κειμένου στα design, όπως φυλλάδια ή ιστοσελίδες, μπορεί να 

θέλετε την προσθήκη μίας ή παραπάνω παραγράφων και στην συνέχεια, τον έλεγχο του 

πλάτους και του ύψους της περιοχής του κειμένου. Το αυτόματο μέγεθος, προσαρμόζει το 

κείμενο ώστε να χωράει μέσα στο ήδη υπάρχον πλαίσιο κειμένου. 141 

Όταν το κείμενο μέσα σε μια περιοχή κειμένου δεν ταιριάζει, το XD το υποδεικνύει 

με μια κόκκινη λαβή αλλαγής μεγέθους στο κάτω μέρος. Κάνοντας διπλό click στην κάτω 

λαβή αλλαγής μεγέθους, αλλάζει το μέγεθος της περιοχής κειμένου, έτσι ώστε να ταιριάζει 

στο περιεχόμενο. 

  

 
138 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
139 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
140 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
141 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
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Μορφοποίηση κειμένου 

Επιλέξτε το κείμενο και καθορίστε τη γραμματοσειρά, το μέγεθος της και τη 

στοίχιση κειμένου, χρησιμοποιώντας το Property Inspector. Υπάρχει επίσης δυνατότητα 

επιλογής μεμονωμένων λέξεων ή χαρακτήρων και η επιλεκτική μορφοποίηση τους. 142 

 

 

 

Αλλαγή διαστήματος  χαρακτήρων, γραμμών και παραγράφων 

Για αλλαγή του διαστήματος χαρακτήρων επιλέξτε 🡪 Character 

Spacing>Property Inspector Αν θέλετε αλλαγή του διαστήματος χαρακτήρων σε ένα 

ολόκληρο κείμενο, επιλέξτε το κείμενο τροποποιήστε την απόσταση σε χιλιοστά, από το 

Property Inspector. Για την επαναφορά του ύψους γραμμής στο προεπιλεγμένο, 

πληκτρολογήστε 0 στο Line Spacing στο Property Inspector. Για αλλαγή του 

διαστήματος παραγράφων, επιλέξτε μια παράγραφο και κάντε click στο εικονίδιο της 

παραγράφου στον πίνακα Formatting. Τροποποιήστε την τιμή διαστήματος, ανάλογα με 

τις απαιτήσεις.143 

 
142 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
143 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
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Text transformations 144 

● Uppercase/Κεφαλαία(TT) 

● Lowercase/Πεζά (tt)  

● Title case/Πεζά Κεφαλαία τίτλου (Tt)  

● Text superscript/Εκθέτης κειμένου (Ττ) 

● Text subscript/Δείκτης κειμένου (Ττ) 

Τα δύο τελευταία εικονίδια, αναφέρονται στην υπογράμμιση, με την διαφορά ότι το 

προτελευταίο αναφέρεται στην απλή υπογράμμιση ενώ το τελευταίο στη υπογράμμιση στη 

μέση του κειμένου.145 

 

 

 

2.3.2 Οι γραμματοσειρές στην Adobe XD 

Στην περίπτωση που λείπουν γραμματοσειρές στο έγγραφό μας, εμφανίζεται ένα 

θαυμαστικό δίπλα στη γραμματοσειρά που λείπει στον πίνακα Assets. Οι γραμματοσειρές 

που ενεργοποιούνται από το Adobe Fonts είναι αυτόματα διαθέσιμες στο έγγραφό μας, 

χωρίς καμία παρέμβαση.146 

 
144 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
145 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
146 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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Κατά την φόρτωση πολλών εγγράφων με διαφορετικές γραμματοσειρές, είναι 

αναγκαία η επιβεβαίωση οτι οι γραμματοσειρές που δεν χρησιμοποιούνται, είναι 

απενεργοποιημένες. Η απενεργοποίηση πραγματοποιείται από τη βιβλιοθήκη Creative 

Cloud Fonts.147 

Προσδιορισμός της γραμματοσειράς που λείπει 

Κάντε δεξί click στη γραμματοσειρά που λείπει και επιλέξτε Highlight on Canvas 

για επισήμανση της γραμματοσειράς που λείπει στα design, προτού γίνει 

αντικατάσταση.148 

Αντικατάσταση της γραμματοσειράς που λείπει 

Κάντε δεξί click στη γραμματοσειρά που λείπει και επιλέξτε Replace Font. Το XD 

κάνει αυτόματη προεπισκόπηση της προτεινόμενης γραμματοσειράς αντικατάστασης σε 

καμβά. Επιλέξτε OK  για αντικατάσταση της γραμματοσειράς στον καμβά, καθώς και στα 

καθορισμένα στυλ χαρακτήρων.149 

2.4 Components and states 

Τα components αποτελούν ευέλικτα σχεδιαστικά στοιχεία που βοηθούν στη 

δημιουργία και στη διατηρηση επαναλαμβανόμενων στοιχείων. Η παρουσίαση τους 

διαφοροποιείται σε άλλο περιβάλλον και διάταξη, όπως η χρήση κουμπιών.150 

2.4.1 Χρήση των components  

Δημιουργία ενός component  

Επιλέξτε Object>Make component. Εναλλακτικά: 151 

● ΣτοProperty Inspector, κάντε clickστοεικονίδιο + Component. 

 
147 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
148 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
149 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
150 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
151 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
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● Στον πίνακα Assets, κάντεclick στο κουμπί + στην ενότητα Components. 

● Στο μενού περιβάλλοντος, κάντε δεξί click σε ένα αντικείμενο και επιλέξτε Make 

Component (CMD / CTRL+K). 

Κατα την αρχική δημιουργία ενός στοιχείου στο XD, γίνεται Κύριο στοιχείο, γεγονός 

που υποδεικνύεται από ένα πράσινο ρόμβο στην επάνω αριστερή γωνία. Η επεξεργασία 

του πραγματοποιείται όπως ακριβώς και οποιουδήποτε άλλου στοιχείου. 152 

Πράγματα που πρέπει να προσέξουμε153 

1. Το XD δεν διαθέτει αποκλειστική προβολή για την επεξεργασία των Main 

Components. Κατα την επεξεργασία ενός κύριου στοιχείου, αυτή 

πραγματοποιείται σε καμβά. 

2. Με τη διαγραφή ενός main component από τον καμβά, δίνεται η δυνατότητα 

επιπλέον επιλογής  μιας παρουσίας και η απόκτηση πρόσβασης στην επιλογή Edit 

Main Component. Το XD θα δημιουργήσει ένα κύριο στοιχείο σε καμβά. 

3. Για αποσύνδεση ενός συγκεκριμένου κομματιού ενός στοιχείου, επιλέξτε το 

Ungroup Component. Ωστόσο, για αποσύνδεση του συνόλου των παρουσιών σε 

καμβά, χρησιμοποιήστε την επιλογή διαγραφής στον πίνακα Assets. 

Η επιβεβαίωση ότι πραγματοποιείται επεξεργασία του κύριου στοιχείου, παρέχεται με 

το πράσινο ρόμβο στην επάνω αριστερή γωνία του πλαισίου οριοθέτησης. 

Βέλτιστες πρακτικές154 

● Κατα τη δημιουργία ενός μεγάλου συστήματος σχεδιασμού Components, πρέπει να 

βεβαιωθείτε ότι έχετε οργανώσει τα σχετικά κύρια στοιχεία σε ξεχωριστά artboards. 

● Κατά την δημιουργία του συστήματος σχεδιασμού, πρέπει να βεβαιωθείτε ότι η κατασκευή  

των Components πραγματοποιείται σε ατομικό επίπεδο, για μέγιστη ευελιξία και 

επαναχρησιμοποίηση. Για παράδειγμα, αν δημιουργήσετε ένα στοιχείο διαλόγου, τα 

 
152 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
153 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
154 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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κουμπιά για το παράθυρο διαλόγου θα πρέπει να είναι Instances (Παρουσίες) ένθετες 

μέσα στο στοιχείο διαλόγου. 

Εργασία με παρουσίες στοιχείων (Work with Components Instances) 

Κάθε αντίγραφο του Main Component, είναι γνωστό ως στιγμιότυπο. Κάθε 

στοιχείο υποδεικνύεται με ένα πράσινο ρόμβο στην επάνω αριστερή γωνία. Όταν 

πραγματοποιούνται αλλαγές στο Main Component, οι ίδιες αλλαγές εφαρμόζονται σε όλα 

τα αντίγραφα.155 

Η παράκαμψη παρουσίας (Instance override), είναι η μοναδική αλλαγή που ισχύει 

μόνο για το κάθε στοιχείο ξεχωριστά. Κατα την τροποποίηση μιας ιδιότητας σε ένα 

στοιχείο, το XD επισημαίνει αυτήν την ιδιότητα ως παράκαμψη. Υπάρχει δυνατότητα 

παράκαμψης σε ιδιότητες ενός στοιχείου χωρίς να διακοπεί η σύνδεσή τους με το κύριο 

στοιχείο. 156 

Επεξεργασία ενός κύριου στοιχείου (Edit a Main Component) 

Κατα την επεξεργασία ενός κύριου στοιχείου, όλες οι παρουσίες του στοιχείου αυτού 

ενημερώνονται, εκτός εάν περιέχουν παρακάμψεις για τη συγκεκριμένη ιδιότητα. Για την 

επεξεργασία ενός κύριου στοιχείου, υπάρχουν οι εξής τρεις τρόποι:157 

1. Με Δεξί click και στην συνέχεια Edit Main Component. 

2. Με Δεξί click σε ένα στοιχείο στο Assets και στην συνέχεια επιλογή Edit Main 

Component. 

3. Με επιλογή του εικονιδίου επεξεργασίας μολυβιού δίπλα στο Default State, στην 

ενότητα Component στο Property Inspector. 

  

 
155 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
156 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
157 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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Παράκαμψη μιας παρουσίας στοιχείου (Override a Component Instance) 

Οι παρακάμψεις αποτελούν μοναδικές αλλαγές που ισχύουν μόνο για αυτήν την 

παρουσία και όχι για το Main Component. Εάν πραγματοποιηθεί αλλαγή μιας ιδιότητας 

σε μια παρουσία, η XD επισημαίνει αυτήν την ιδιότητα ως παράκαμψη. Οι ιδιότητες που 

έχουν παρακαμφθεί διατηρούνται πάντα, ακόμα κι αν γίνει επεξεργασία της ίδιας ιδιότητας 

από το Main Component. Για διαγραφή των παρακάμψεων και για επαναφορά του κύριου 

στοιχείου, κάντε δεξί click σε μια παρουσία και επιλέξτε Reset to Main State.158 

Τύποι παρακάμψεων (Types of Overrides)159 

● Κείμενο (Text): Δυνατότητα επεξεργασίας του περιεχομένου κειμένου σε μια 

παρουσία του στοιχείου. Για παράδειγμα, όταν γίνεται αλλαγή της ετικέτας για ένα 

κουμπί Component.  

● Bitmap: Δυνατότητα αντικατάστασης του περιεχομένου bitmap σε μια παρουσία 

Component. Για παράδειγμα, όταν γίνεται αντικατάσταση μιας εικόνας, σε μια 

εικόνα προφίλ Component. 

● Μέγεθος (Size): Δυνατότητα αλλαγής του μεγέθους μιας παρουσίας κατά την 

εφαρμογή padding και responsive αλλαγή μεγέθους. Για παράδειγμα, όταν γίνεται 

τροποποίηση του μεγέθους των πεδίων κειμένου σε μια φόρμα. 

● Εμφάνιση (Appearance): Δυνατότητα τροποποίησης στις ιδιότητες εμφάνισης, 

όπως το χρώμα γεμίσματος, το περίγραμμα και το θάμπωμα. Για παράδειγμα, όταν 

γίνεται τροποποίηση του χρώματος φόντου για ειδοποιήσεις. 

● Διάταξη και δομή (Layout and structure): Δυνατότητα προσθήκης, διαγραφής 

και μετακίνησης αντικειμένων σε μια παρουσία του στοιχείου. Για παράδειγμα, 

όταν γίνεται τροποποίηση του αναπτυσσόμενου μενού με πρόσθετες καταχωρήσεις 

μενού. 

 
158 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
159 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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Παρακάμψεις μεγέθους (Size overrides) 

Οι παρουσίες στοιχείων έχουν επίσης δυνατότητα αλλαγής μεγέθους και διαθέτουν 

ισχυρές δυνατότητες για άμεση απόκριση σε αλλαγή μεγέθους. Αν το μέγεθος του Main 

Component αλλάξει, οι περιπτώσεις που δεν έχουν αλλάξει μέγεθος χειροκίνητα ως 

παράκαμψη, αλλάζουν αυτόματα. Επομένως, οι περιπτώσεις που έχουν αλλάξει μέγεθος 

διατηρούν τη θέση τους ως παράκαμψη.160 

➔ Πώς λειτουργεί η αλλαγή μεγέθους σε ένα κύριο στοιχείο ή στις παρουσίες 

του; 

● Μπορούμε να αλλάξουμε το μέγεθος μιας παρουσίας χωρίς να επηρεάσουμε το 

κύριο στοιχείο. 

● Μπορούμε να αλλάξουμε το μέγεθος ενός ολόκληρου Component και να 

αλλάξουμε τη διάταξη των στοιχείων μέσα σε αυτό. 

● Μπορούμε να αλλάξουμε τις παρουσίες Component ανεξάρτητα από τα μεγέθη στα 

οποία τις έχουμε προσαρμόσει. 

Ακριβώς όπως η απόκριση αλλαγής μεγέθους, το XD δημιουργεί εκ νέου την 

τοποθέτηση των στοιχείων  σε μεγαλύτερο ή μικρότερο καμβά, καθώς αλλάζουμε το 

μέγεθός τους. Στο Property Inspector, μπορούμε να αλλάξουμε το Responsive Resize 

από Auto σε Manual, που μας επιτρέπει να επεξεργαστούμε τους περιορισμούς για 

περισσότερο έλεγχο.161 

Επικάλυψη των στοιχείων εμφάνισης (Appearance overrides) 

Η αλλαγή των αρχικών στοιχείων ανάλογα με το περιβάλλον, είναι σημαντική κατά 

τη δημιουργία επαναχρησιμοποιήσιμων στοιχείων, έτσι ώστε να υπάρχει δυνατότητα 

παράκαμψης κάθε ιδιότητας στυλ και εμφάνισης μιας παρουσίας. Οι παρακάμψεις 

 
160 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World Journal 

of Research and Review (WJRR), 12(6), 41-45. 
161 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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επιτρέπουν μια σειρά παραλλαγών, διατηρώντας παράλληλα τους δεσμούς τους με το 

κύριο στοιχείο.162 

Επικάλυψη διάταξης και δομής (Layout and structure overrides) 

Κατα την προσθήκη ενός αντικειμένου στο κύριο στοιχείο, προστίθεται επίσης στις 

αντίστοιχες παρουσίες του. Κατά την προσθήκη ενός αντικειμένου, το XD εφαρμόζει τον 

αλγόριθμο αλλαγής μεγέθους απόκρισης και τοποθετεί αυτόματα τους περιορισμούς στο 

αντικείμενο. Όταν ένα αντικείμενο διαγράφεται από το κύριο στοιχείο, αφαιρείται επίσης 

σε όλες τις περιπτώσεις. Τα στοιχεία μπορούν να προστεθούν ή να αφαιρεθούν από μια 

παρουσία και οι περιορισμοί τοποθετούνται αυτόματα σε ένα αντικείμενο, κατα την 

προσθήκη του. Κατα τη διαγραφή ενός στοιχείου σε μία παρουσία, αφαιρείται μόνο το 

συγκεκριμένο στοιχείο σε αυτή τη παρουσία, το οποίο όμως συνεχίζει να υπάρχει στο 

Κύριο στοιχείο. 163 

Πράγματα που πρέπει να προσέξουμε:164 

● Μπορούμε να επαναφέρουμε όλες τις παρακάμψεις, και όχι μεμονωμένες 

παρακάμψεις, πίσω στο Main Component.  

● Εάν έχουμε επισημάνει μια ιδιότητα ως παράκαμψη σε μια παρουσία, επιλέγουμε 

Reset to Main State για να την επαναφέρουμε σε συγχρονισμό με την κύρια.  

Προσθήκη καταστάσεωνστα Components (Add states to Components) 

Οι καταστάσεις στοιχείων επιτρέπουν την αποθήκευση διαφορετικών παραλλαγών 

του στοιχείου για κάθε επαναχρησιμοποίηση. Μόλις πραγματοποιηθούν παρακάμψεις στο 

κύριο στοιχείο, παρέχεται η δυνατότητα δημιουργίας μιας κατάστασης από αυτές τις 

παρακάμψεις, ώστε να μπορεί εύκολα να επαναχρησιμοποιηθεί.165 

 
162 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
163 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
164 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
165 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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Πράγματα που πρέπει να θυμόμαστε:166 

● Οι καταστάσεις που δημιουργούνται στο Main Component είναι διαθέσιμες σε 

όλες τις περιπτώσεις αυτού του στοιχείου. Αυτό επιτρέπει τη δημιουργία 

Components με πολλαπλές παρουσίες και την εύκολη εναλλαγή καταστάσεων. 

● Υπάρχει δυνατότητα μετονομασίας και διαγραφής από το state switcher στο 

Property Inspector. 

● Υπάρχει δυνατότητα προσθήκης ενός κανόνα για εναλλαγή από μια κατάσταση 

ενός στοιχείου σε μια άλλη κατάσταση. 

Προσθήκη κατάστασης (State) 

Κατόπιν δημιουργίας ενός component, το Property Inspector παραθέτει το στοιχείο 

με Default State. Υπάρχουν τρεις τύποι κατάστασης για τα Components: New State, 

Hover State, Toggle State:167 

● New State:Το New State χρησιμοποιείται για σενάρια όπου είναι επιθυμητή η 

εμφάνιση παραλλαγών ενός Component. 

Σε λειτουργία Design, κάντε click στο κουμπί + δίπλα στο Default state του κύριου 

στοιχείου στο Property Inspector και επιλέξτε New state. 

● Hover State:Το Hover state χρησιμοποιείται για σενάρια όπου είναι επιθυμητό το 

στοιχείο c να αλλάξει και να εμφανίσει διαφορετική κατάσταση, κατα την 

τοποθέτηση του δείκτη του ποντικιού πάνω από το στοιχείο. 

Σε λειτουργία Design κάντε click στο κουμπί + δίπλα στο Default state του κύριου 

στοιχείου στο Property Inspector και επιλέξτε Hover state. 

● Toggle state: Το Hover state χρησιμοποιείται για σενάρια όπου είναι επιθυμητή η 

δημιουργία  στοιχείων με διαδραστική συμπεριφορά εναλλαγής, όπως είναι το 

κουμπί επιλογής, το πλαίσιο ελέγχου και ούτω καθεξής.  

 
166 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
167 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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Σε λειτουργία Design, κάντε click στο κουμπί + δίπλα στο Default state του κύριου 

στοιχείου στο Property Inspector και επιλέξτε το Toggle state. Μόλις 

δημιουργηθεί αυτό το state, θα έχουν αυτόματα δημιουργηθεί δύο αλληλεπιδράσεις 

μεταξύ του Default state και του Toggle state. 

Αφού δημιουργήσετε τα επιθυμητά states, μπορείτε εύκολα να τα διαχειριστείτε 

από το Property Inspector. Οι επιλογές είναι switch states, rename states and delete 

states. 

Παρακάμψεις σε ιδιότητες κατάστασης (Overrides in states) 

Με τα states παρέχεται η  δυνατότητα παράκαμψης ιδιοτήτων όπως κείμενο, 

bitmap, μέγεθος, διάταξη και εμφάνιση. Μόλις παρακαμφθεί μια ιδιότητα κατάστασης σε 

μια παρουσία, δεν θα λαμβάνει πλέον ενημερώσεις για αυτές τις ιδιότητες από το main 

component.168 

Εάν τα αποτελέσματα των παρακάμψεων, δεν είναι τα επιθυμητά, υπάρχει 

δυνατότητα επαναφοράς στο αρχικό κύριο στοιχείο, κάνοντας  δεξί click σε μια παρουσία 

και επιλέγοντας Reset to Main state. Η συγκεκριμένη ενέργεια, διαγράφει όλες τις 

παρακάμψεις μιας παρουσίας και την επαναφέρει στο Main Component.169 

Προσθήκη διαδραστικότητας (Interactivity)  

Η προσθήκη διαδραστικότητας, επιτυγχάνεται με τα ακόλουθα βήματα: 170 

1. Βρίσκεστε σε Prototype λειτουργία . 

2. Επιλέξτε την κατάσταση στοιχείου από την οποία θέλετε να δημιουργήσετε την 

αλληλεπίδραση.  

 
168 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
169 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
170 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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3. Κάντε click στο εικονίδιο > στην κατάσταση του στοιχείου ή στο + στην ενότητα 

interaction στο Property Inspector  για προσθήκη μιας αλληλεπίδρασης. 

4. Επιλέξτε το Tap (για συμβάντα click), Hover (για ενέργειες με το ποντίκι), Keys 

& Gamepad (για περιπτώσεις χρήσης πλοήγησης και προσβασιμότητας) ή Voice 

(για περιπτώσεις χρήσης πλοήγησης και προσβασιμότητας), ως έναυσμα. 

5. Επιλέξτε έναν τύπο ενέργειας (όπως Auto-Anite ή Transition). 

6. Επιλέξτε ένα state ως προορισμό (default/interactive). 

7.  Πραγματοποιήστε Προεπισκόπηση. 

Πράγματα που πρέπει να προσέξουμε: 171 

● Όταν κάνουμε διπλό click σε ένα στοιχείο, ο επιλογέας κατάστασης στο Property 

Inspector εξαφανίζεται. 

● Το XD υποστηρίζει μόνο τα Tap, Hover, Keys & Gamepad και Voice ως triggers 

μεταξύ των καταστάσεων. 

● Το XD δεν διαδίδει overrides από ένα state σε ένα άλλο state. 

Διαχείριση στοιχείων (Manage Components) 

Οι επιλογές όσον αφορά τη διαχείριση στοιχείων, είναι οι εξής: View, Edit, Rename 

or Delete, Reset to a Main state:172 

● View: Δυνατότητα προβολής ή μετακίνησης νέων παρουσιών στον καμβά από τον 

πίνακα Assets. 

Για τον εντοπισμό του συνόλου των εμφανίσεων, κάντε δεξί click σε ένα στοιχείο 

στον πίνακα Assets και επιλέξτε Highlight on canvas. 

 
171 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. In 10th 

International Symposium on Graphic Engineering and Design (pp. 537-541). 
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Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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 Για τον εντοπισμό στοιχείων στον πίνακα Assets, κάντε δεξί click σε μια παρουσία 

του στοιχείου σε καμβά και επιλέξτε Reveal Component στο πλαίσιο Assets. 

● Edit, Rename or Delete: Κάντε δεξί click σε ένα στοιχείο στον πίνακα Assets ή 

επιλέξτε μια παρουσία στον καμβά. Χρησιμοποιήστε τις επιλογές του μενού 

περιβάλλοντος για να προχωρήσετε επεξεργασία (edit) ή διαγραφή (delete). Για 

μετονομασία Components, κάντε δεξί click και χρησιμοποιήστε την αντίστοιχη 

επιλογή μετονομασίας (rename). 

● Reset to a Main state: Κάντεδεξί click σεμιαπαρουσίακαιεπιλέξτε Reset to Main 

state. Με αυτόν τον τρόπο, πραγματοποιείται διαγραφή του συνόλου των 

παρακάμψεων και επανασύνδεση με το Main Component. Για αποσύνδεση μιας 

παρουσίας από το Main Component, κάντε δεξί click καιεπιλέξτε Ungroup a 

Component. 

2.4.2 Χρήση ένθετων components 

Ορολογία των components173 

● Main component:Ένα main component είναι το στοιχείο που ορίζει και ελέγχει 

όλες τις ιδιότητες του. 

● Component instance: Ένα component instance είναι ένα αντίγραφο του κύριου 

component και κληρονομεί τις αλλαγές που έγιναν στο main component. 

● Nested component: Ένα nested component είναι ένα στοιχείο μέσα σε ένα άλλο 

στοιχείο. 

● Outer component: Ένα outer component είναι ένα στοιχείο που έχει ένα άλλο 

στοιχείο μέσα του. 

 

173 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
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Δημιουργία ενός ένθετου στοιχείου (nested component)174 

Για τη δημιουργίας ενός ένθετου στοιχείου (nested component) , υπάρχουν οι εξής τρεις 

τρόποι: 

● Copy - paste ενός component instance σε μια ομάδα και μετατροπή σε component. 

Βήματα:  

1. Δημιουργίαενός main button component. 

2. Copy - paste μιας παρουσίας του button component μέσα σε ένα 

group. 

3. Επιλογή του group και μετατροπή του group σε component. 

 

● Copy - paste ενός component instance μέσα σε ένα ήδη υπάρχον component. 

Βήματα:  

1. Δημιουργία ενός main button component. 

2. Copy - paste μιας παρουσίας του button component σε άλλο 

component. 

 

● Άνοιγμα τμήματος ενός component και μετατροπή του σε component. 

                      Βήματα:  

1. Δημιουργία ενός κύριου στοιχείου διαλόγου 

2. Άνοιγμα ενός button μέσα στο component 

3. Μετατροπή του button σε component 

  

 

174 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
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Πράγματα που πρέπει να προσέξουμε: 175 

● Τα nested component  δεν μπορούν να είναι main component. Επομένως, εάν 

θέλουμε η αλλαγή να είναι στο κύριο στοιχείο, κάνουμε δεξί click στο ένθετο 

στοιχείο και επιλέγουμε Edit Main Component.  

● Εάν ένα nested component σε μια παρουσία του outer component αντικατασταθεί, 

το Reset to Main State στο nested component  του main δεν θα αλλάξει την 

παρουσία με το αντικατασταθέν στοιχείο.  

 

2.4.3 Προσθήκη πολλαπλών καταστάσεων στα components 

Σε αυτό το υποκεφάλαιο αναλύεται ο τρόπος προσθήκης πολλαπλών καταστάσεων 

σε ένα component, έτσι ώστε να υπάρχει δυνατότητα ανάπτυξης διαδραστικού 

περιεχομένου με ευκολία. Υπάρχουν οι δυνατότητες δημιουργίας ενός component, 

προσθήκης διαφόρων παραλλαγών (καταστάσεων/states) σε αυτό αλλά και σύνδεσης του 

component, για μίμηση της συμπεριφοράς των χρηστών στον πραγματικό κόσμο (χωρίς 

να χρειάζεται επανειλημμένη αντιγραφή των στοιχείων). Η ύπαρξη component με 

καταστάσεις/states διευκολύνει επίσης τη διαχείριση των assets και τη δημιουργία 

διαδραστικών συστημάτων σχεδίασης. Συνήθη παραδείγματα components με states είναι 

τα buttons, τα πλαίσια ελέγχου (checkboxes) και τα κινούμενα κουμπιά εναλλαγής 

(animated toggle buttons). Αυτά τα στοιχεία πρέπει να αλλάζουν όταν οι χρήστες 

αλληλεπιδρούν μαζί τους πατώντας ή τοποθετώντας το δείκτη του ποντικιού πάνω τους.176 

New State 

Το new state χρησιμοποιείται για σενάρια στα οποία σκοπός είναι η εμφάνιση 

παραλλαγών ενός στοιχείου. Για παράδειγμα, μια απενεργοποιημένη έκδοση του. Κάντε 

click στο + δίπλα στο Default state του main component στο Property Inspector και 

 
175 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
176 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 

https://helpx.adobe.com/gr_en/xd/help/create-component-states.html#checkbox
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επιλέξτε New state. Η σύνδεση της αλληλεπίδρασης, πραγματοποιείται σε Prototype 

mode.177 

Hover State 

Το hover state χρησιμοποιείται για σενάρια στα οποία σκοπός είναι το στοιχείο να 

αλλάζει και να εμφανίζει διαφορετική κατάσταση, όταν ένας χρήστης είναι πάνω από αυτό. 

Σε Design modeκάντε click + δίπλα στην Default state του main component στο 

Property Inspector και επιλέξτε Hover state. Κατα την χρήση του Hover State, δεν 

απαιτείται μετάβαση σε λειτουργία Prototype για σύνδεση της αλληλεπίδρασης,καθώς 

πραγματοποιείται αυτόματα. 

Toggle State 

Το toggle state χρησιμοποιείται για σενάρια στα οποία σκοπός είναι η δημιουργία 

στοιχείων με διαδραστική συμπεριφορά εναλλαγής, όπως ενδεικτικά είναι η εναλλαγή, το 

κουμπί επιλογής, το πλαίσιο ελέγχου. Σε Design mode κάντε click + δίπλα στο Default 

state του main component στο Property Inspector καιεπιλέξτε Toggle state.178 

Οπτικοποίηση στοιχείων σε διαφορετικές καταστάσεις 

Αφού δημιουργήσετε τα states για το επιθυμητό στοιχείο, μπορείτε να επεξεργαστείτε 

τις ιδιότητες του στοιχείου και να ελέγξετε το πώς εμφανίζεται στον χρήστη που 

αλληλεπιδρά με αυτό, με τα εξής βήματα: 179 

1. Επιλέξτε το στοιχείο. 

2. Μεταβείτε στο Property Inspector και κάντε εναλλαγή μεταξύ διαφόρων 

καταστάσεων (π.χ. από Default state σε Hover state). 

 

177 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
178 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
179 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
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Προσθήκη διαδραστικότητας στα components  

Μπορείτε να χρησιμοποιήσετε τα triggers Tap, Hover, Keys & Gamepad , Voice για 

αλληλεπιδράσεις μεταξύ των component state σε Prototype mode. Τα interactions μεταξύ 

των component state και αυτά των artboard είναι παρόμοια. Η κύρια διαφορά τους είναι 

ότι κατά τις αλληλεπιδράσεις μεταξύ component state, επιλέγεται μια κατάσταση ως 

προορισμός αντί για ένα artboard.  Αναλυτικότερα, μεταβείτε στην καρτέλα Prototype και 

στην συνέχεια:180 

1. Επιλέξτε το component state από το οποίο θέλετε να δημιουργήσετε την 

αλληλεπίδραση (interaction). 

2. Κάντε click στο + στην ενότητα Interaction στο Property Inspector για προσθήκη 

μιας αλληλεπίδρασης. 

3. Επιλέξτε Tap (για συμβάντα click), Hover (για τις ενέργειες με το ποντίκι), Keys 

& Gamepad (για περιπτώσεις χρήσης πλοήγησης και προσβασιμότητας) ή Voice 

(για περιπτώσεις χρήσης πλοήγησης και προσβασιμότητας) ως έναυσμα. 

4. Επιλέξτε έναν τύπο ενέργειας (όπως Auto ή Transition). 

5. Επιλέξτε ένα state ως προορισμό. 

6. Πραγματοποιήστε προεπισκόπηση. 

Επεξεργασία καταστάσεων  (Edit component state) 

Όταν ορίζεται ένα interaction σε ένα Main Component state, όλες οι εμφανίσεις 

αυτού του στοιχείου κληρονομούν αυτόματα αυτές τις αλληλεπιδράσεις. Αυτό σημαίνει 

ότι εάν συνδέσουμε ένα στοιχείο σε ένα συγκεκριμένο artboard ή state, όλες οι εμφανίσεις 

 

180 Li, J., W. Tigwell, G., & Shinohara, K. (2021, May). Accessibility of high-fidelity prototyping tools. In Proceedings of the 

2021 CHI Conference on Human Factors in Computing Systems (pp. 1-17). 
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αυτού του στοιχείου περιέχουν επίσης αυτές τις αλληλεπιδράσεις. Για την επεξεργασία  

υπαρχουσών καταστάσεων ή για την προσθήκη νέων, υπάρχουν δύο επιλογές:181 

Επιλογή 1: Κάντε δεξί click στην παρουσία του στοιχείου και επιλέξτε Edit Main 

Component. 

Επιλογή 2: Κάντε click στο Edit για αλλαγή της επιλογής στο Main Component και την 

προσθήκη ή την επεξεργασία καταστάσεων. 

Για επαναφορά στην αρχική κατάσταση της παρουσίας, επιλέξτε >Reset to Main State. 

*Πράγματα που πρέπει να ξέρουμε: 

▪ Μπορούμε να παρακάμψουμε ιδιότητες (text, bitmap, size, appearance, or structure 

changes) για καταστάσεις, όπως ακριβώς μπορούμε να παρακάμψουμε μια 

παρουσία στοιχείου. 

▪ Όταν επεξεργαζόμαστε ένα state σε ένα main component, αυτό το state 

ενημερώνεται σε όλες τις παρουσίες. 

▪ Όταν επεξεργαζόμαστε ένα state σε μια παρουσία, αντιμετωπίζεται ως μοναδικό 

override και δεν συγχρονίζεται με αλλαγές από την κύρια κατάσταση. 

▪  

2.5 Masking and effects 

2.5. 1 Δημιουργία μάσκας με τη χρήση σχημάτων 

Η χρήση μασκών εξυπηρετεί στην αποκοπή τμημάτων εικόνων ή αντικειμένων και 

στην δημιουργία ενός αποτελέσματος που εστιάζει σε συγκεκριμένα στοιχεία του design. 

Μερικά από τα σενάρια που μπορεί να γίνει χρήση κάλυψης με μάσκα (masking), είναι η 

δημιουργία ενός avatar προφίλ ή η προσομοίωση μιας εμπειρίας σκοτεινής λειτουργίας 

όπως φαίνεται παρακάτω.182 

 
181 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
182 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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Οι διαδικασίες δημιουργίας, επεξεργασίας και αφαίρεσης ενός εφέ μάσκας (mask 

effect), παρουσιάζονται στην συνέχεια.  183 

1. Σχεδιάστε ένα σχήμα που θέλετε να χρησιμοποιήσετε ως μάσκα και τοποθετήστε 

το στο τμήμα της εικόνας που θέλετε να διατηρήσετε. Επιλέξτε την εικόνα και το 

σχήμα. 

2. Επιλέξτε Object>Mask with shape (για MAC) ή κάντε δεξί click στο επιλεγμένο 

περιεχόμενο και επιλέξτε Mask with shape (για Windows). Το τμήμα της εικόνας 

ή του σχεδίου που βρίσκεται έξω από το σχήμα είναι καλυμμένο. 

3. Για επεξεργασία του περιεχομένου, εντός του σχήματος μάσκας, κάντε διπλό click 

στο καλυμμένο περιεχόμενο. Η καλυμμένη περιοχή δεν διαγράφεται από το έργο. 

Υπάρχει δυνατότητα αναπροσαρμογής της μάσκας για να επισυνάψετε ένα άλλο 

τμήμα της εικόνας. 

4. Για απενεργοποίηση ή αφαίρεση μιας μάσκας, επιλέξτε το αντικείμενο και κάντε 

Ctrl + click (για MAC) ή δεξί click (για Windows) και επιλέξτε Ungroup Mask 

από το μενού. 

2.5.2Χρήση των blur effects 

Προσθήκη θαμπώματος (blur) 

Υπάρχει δυνατότητα προσθήκης θαμπού φόντου (background blur) σε αντικείμενα ή 

εικόνες σε ένα artboard, για να τονιστούν ή να θαμπώσουν τα μέρη ενός αντικειμένου, με 

τους ακόλουθους τρόπους:184 

 
183 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
184 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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● Δημιουργία blur mask, για να θολώσετε οτιδήποτε είναι ορατό από κάτω. 

● Προσθήκη background blur effect σε επιλεγμένα αντικείμενα, για να θολώσετε 

ολόκληρο το αντικείμενο. 

Κατα την προσθήκη blur effect σε αντικείμενα, οι αλλαγές δεν είναι μη αναστρέψιμες 

και υπάρχει δυνατότητα ανάκτησης του αρχικού αντικειμένου.185 

Εφαρμογή θαμπώματος σε συγκεκριμένες περιοχές ενός artboard186 

1. Σχεδιάστε ένα σχήμα πάνω από το τμήμα της εικόνας, του αντικειμένου ή της 

περιοχής που θέλετε να θαμπώσετε. 

2. Επιλέξτε Background Blur στο Property Inspector. 

3. Προσαρμόστε τις ρυθμίσεις, για να ελέγξετε το θάμπωμα φόντου.Συγκεκριμένα: 

● Amount: Ελέγχει την έκταση του θαμπώματος 

● Brightness: Ελέγχει τη φωτεινότητα της μάσκας θαμπώματος 

● Opacity: Ελέγχει την αδιαφάνεια της μάσκας θαμπώματος 

● Για εμφάνιση ή απόκρυψη του θαμπώματος, επιλέξτε ή αποεπιλέξτε το πλαίσιο 

ελέγχου δίπλα στο Background Blur. 

● Για αφαίρεση του θαμπώματος, επιλέξτε το αντικείμενο (blur mask) και 

προχωρήστε σε διαγραφή. 

 

 
185 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
186 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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Προσθήκη θαμπώματος σε ένα επιλεγμένο αντικείμενο187 

1. Επιλέξτε το αντικείμενο ή την εικόνα στην οποία θέλετε να προσθέσετε την 

λειτουργία background blur. 

2. Επιλέξτε Object Blur στο Property Inspector. 

3. Προσαρμόστε τις ρυθμίσεις, για έλεγχο της έκτασης του θολώματος. 

4. Για εμφάνιση ή απόκρυψη του θαμπώματος, επιλέξτε ή αποεπιλέξτε το πλαίσιο 

ελέγχου δίπλα στο Object Blur. 

 

 
187 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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2.6 Layout  

2.6. 1 Responsive resize and constraints 

Κατα την σχεδίαση μιας εφαρμογής, ο χρήστης πρέπει να λάβει υπόψη το γεγονός 

πως η συγκεκριμένη εφαρμογή αναφέρεται σε πολλές διαφορετικές συσκευές. Συνεπώς, η 

ποιότητα της ανάλυσης του σχεδίου στο κινητό, στο tablet, στον Η/Υ, έχει ιδιαίτερη 

σημασία. 188 

H Adobe, προσφέρει τη δυνατότητα του responsive size. Μέσω της συγκεκριμένης 

δυνατότητας, επιτρέπει την αλλαγή στο μέγεθος των αντικειμένων, διατηρώντας όμως σε 

όλα τα μεγέθη τον χώρο που αρχικά κατείχαν.189 

Work with responsive size 

Με το Responsive Resize, το XD προβλέπει αυτόματα τους περιορισμούς που 

είναι πιθανό να εφαρμοστούν από το χρήστη και εφαρμόζει αυτόματα αυτούς τους 

περιορισμούς καθώς αλλάζει το μέγεθος των αντικειμένων. Το XD εφαρμόζει αυτόματα 

περιορισμούς, αναλύοντας τα επιλεγμένα αντικείμενα, τη δομή ομαδοποίησης (grouping 

structure) και τις πληροφορίες διάταξης.190 

Responsive resize crosshairs 

Κατά την αλλαγή μεγέθους, εμφανίζονται ροζ σταυροί στο αντικείμενο του οποίου 

το μέγεθος τροποποιείται. Τα σταυρόνημα (crosshairs) υποδεικνύουν ποιοι κανόνες 

περιορισμού εφαρμόζονται σε μια ομάδα. Το XD παρέχει μια οπτική μέθοδο εντός του 

πλαισίου, για την εκμάθηση του τρόπου με τον οποίο το responsive resize και οι manual 

constraints λειτουργούν παράλληλα.191 

  

 
188 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
189 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
190 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
191 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Responsive resize and groups 

Πριν την αλλαγή μεγέθους, υπάρχει δυνατότητα ομαδοποίησης παρόμοιων 

αντικειμένων, για τη συσχέτιση τους. Το XD διατηρεί τα ομαδοποιημένα αντικείμενα μαζί 

από προεπιλογή και επιτρέπει τη δημιουργία μιας ιεραρχίας στα έργα, μέσω ενός 

μηχανισμού οργάνωσης. Όταν το μέγεθος αλλάζει, τα ομαδοποιημένα αντικείμενα 

παραμένουν μαζί.192 

Manually edit constraints 

Εάν τα αποτελέσματα της λειτουργίας Responsive Resize δεν είναι ικανοποιητικά, 

υπάρχει δυνατότητα επεξεργασίας στους κανόνες περιορισμών χειροκίνητα. Η 

τοποθέτηση μη αυτόματων περιορισμών, επιτρέπει τον προσδιορισμό της συμπεριφοράς 

των αντικειμένων, κατα την αλλαγή του μεγέθους ενός component, ενός artboard ή ενός 

group with layers.193 

Επιλέξτε Manual για επεξεργασία των περιορισμών που έχουν τεθεί σε αντικείμενα 

από την λειτουργία Responsive Resize. Οι χειροκίνητοι περιορισμοί υπερισχύουν των 

αυτόματων περιορισμών που θέτει το XD. Διατίθενται οι παρακάτω περιορισμοί, για τον 

καθορισμό των κανόνων και τον έλεγχο της συμπεριφοράς των διαφόρων στοιχείων: 194 

● Fixed/Variable width 

● Fixed/Variable height 

● Fixed/Variable left margin 

● Fixed/Variable right margin 

● Fixed/Variable top margin 

● Fixed/Variable bottom margin 

 
192 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
193 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
194 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Responsively resizing artboards 

Από προεπιλογή, το Responsive Resize είναι απενεργοποιημένο για τα artboards, αλλά 

παρέχεται δυνατότητα ενεργοποίησης: 195 

1. Επιλέξτε το artboard σε Design mode. 

2. Στο Property Inspector, επιλέξτε το κουμπί εναλλαγής για ενεργοποίηση του 

Responsive Resize. 

3. Διαθέτετε τις εξής επιλογές:  

● Auto: χρησιμοποιεί αυτόματα περιορισμούς για την αλλαγή του μεγέθους του 

artboard. 

● Manual: επιτρέπει να ορίσετε μη αυτόματους περιορισμούς που είναι διαθέσιμοι 

στο Property Inspector. 

 

Καθορισμός σταθερών τιμών συμπλήρωσης σε στοιχεία ή ομάδες (Set fixed padding for 

components and groups)  

 
195 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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Το Adobe XD προσφέρει τη δυνατότητα καθορισμού σταθερών τιμών συμπλήρωσης 

(set fixed padding values) σε στοιχεία ή ομάδες με καταστάσεις και αυτόματης 

κλιμάκωσης φόντου (scale the background) όταν πραγματοποιούνται αλλαγές 

περιεχομένου. Η δυνατότητα αυτή,  μειώνει την τριβή του σχεδιασμού και τη γνωστική 

υπερφόρτωση κατά τη δημιουργία buttons, αναπτυσσόμενων μενού, συμβουλών 

εργαλείων ή διαλόγων. Σε αντίθεση με το responsive resize, που ενεργεί όταν αλλάζει το 

μέγεθος μιας ολόκληρης ομάδας, το padding ενεργεί όταν αλλάζει το περιεχόμενο σε μια 

ομάδα. Το padding πρόκειται για την απόσταση από το οπτικό φόντο μέχρι την άκρη του 

περιεχομένου σε κάθε πλευρά, που προσδιορίζεται από ολόκληρο το φόντο. Το XD 

προσδιορίζει αυτόματα ένα φόντο όταν:196 

● Οποιοδήποτε σχήμα, ομάδα ή ομάδα Boolean είναι τοποθετημένη στο χαμηλότερο 

επίπεδο στο επίπεδο ομάδας ή συστατικού. 

● Άλλα στοιχεία επικαλύπτουν το χαμηλότερο στρώμα.  

Για ακριβή έλεγχο του μεγέθους φόντου ενός αντικειμένου μέσω padding, 

ακολουθήστε τα εξής βήματα:197 

 

1. Από το Property Inspector, κάντε εναλλαγή για ενεργοποίηση του κουμπιού 

padding. 

2. Με βάση τις σχεδιαστικές ανάγκες, ορίστε τιμές για Same padding for all 

directions ή Different padding for each direction. 

Μπορείτε να επιλέξετε την λειτουργία Padding μόνο εάν το στοιχείο φόντου της δομής 

στρώματος είναι τοποθετημένο τελευταίο στην ομάδα και επικαλύπτει άλλα αντικείμενα. 

Κατα την μετακίνηση ή την αλλαγή του μεγέθους του περιεχομένου σε μια ομάδα ή ένα 

στοιχείο, το XD προσδιορίζει το φόντο, υπολογίζει τις τιμές συμπλήρωσης και τις 

ενημερώνει στο Property Inspector. Οι ενημερωμένες τιμές διατηρούνται στην ομάδα ή 

 
196 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
197 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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στο στοιχείο και το μέγεθος του φόντου αλλάζει αυτόματα. Όταν μια ομάδα ή στοιχείο δεν 

έχει οπτικό φόντο, η τιμή του padding είναι 0.198 

Τροποποίηση στις τιμές του padding; 

Για τροποποίηση στις τιμές του padding, χρησιμοποιήστε οποιαδήποτε από τις 

παρακάτω επιλογές:199 

● Στο Property Inspector, ενημερώστε τις υπάρχουσες τιμές padding. 

● Για αλλαγή του μεγέθους του padding σε έναν καμβά, πατήστε το πλήκτρο `, 

τοποθετήστε το δείκτη του ποντικιού πάνω από την περιοχή padding και σύρετε. 

● Για ενημέρωση των τιμών padding σε μια ομάδα ή στοιχείο, αλλάξτε χειροκίνητα 

(manual) το μέγεθος ή μετακινήστε το φόντο στον καμβά. 

● Για επεξεργασία όλων των τιμών padding, επιλέξτε Shift + `. 

● Για επεξεργασία των αντίθετων τιμών padding, επιλέξτε  ` + Alt. 

Πράγματα που πρέπει να προσέξουμε:200 

● Όταν ενεργοποιούμε το padding, όλες οι παρουσίες στοιχείων και καταστάσεων 

κληρονομούν αυτόματα την ιδιότητα που έχει οριστεί στο κύριο στοιχείο ή στην 

προεπιλεγμένη κατάσταση, χωρίς την επιλογή τοπικής παράκαμψής τους. 

● Η επιλογή Send to Back στον καμβά, τοποθετεί οποιοδήποτε στοιχείο σε μια 

ομάδα ή ένα στοιχείο ακριβώς πάνω από το φόντο της ομάδας. 

● Εάν το φόντο είναι μια ομάδα Boolean, μια μάσκα ή ένα στοιχείο, εφαρμόζονται 

κανόνες απόκρισης αλλαγής μεγέθους για την αλλαγή μεγέθους του αντικειμένου. 

 
198 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
199 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
200 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 



84 
 

● Εάν διαγράψουμε ένα φόντο, το XD αξιολογεί την ομάδα και προωθεί αυτόματα 

το επόμενο layer ως φόντο και ενημερώνει τις τιμές padding. Εάν δεν υπάρχει 

background layer, η τιμή padding επαναφέρεται στο 0. 

Περιορισμοί201 

● Τα στοιχεία και το κείμενο σημείου δεν μπορούν να λειτουργήσουν ως φόντο για 

μια ομάδα ή  για ένα στοιχείο. 

● Το padding δεν κινείται σε Prototype mode όταν χρησιμοποιούμε καταστάσεις 

Hover ή Tap εντός του περιεχομένου σχεδίασης. 

2.6.2 Δημιουργία δυναμικών σχεδίων με στοίβες (stacks) 

Πριν την παρουσίαση του τρόπου λειτουργίας της συγκεκριμένης δυνατότητας του 

Adobe XD, χρήσιμο είναι να αναφερθούν ορισμένοι περιορισμοί: 202 

● Εάν ο δείκτης του ποντικιού τοποθετηθεί σε ένα στοιχείο με hover state που 

μεγαλώνει σε μέγεθος, το μέγεθος του φόντου δεν αλλάζει ώστε να ταιριάζει στη 

νέα κατάσταση και τα στοιχεία στη στοίβα δεν απομακρύνονται. 

● Τα στοιχεία δεν μπορούν να λειτουργήσουν ως φόντο padding και stacks. 

Αντίθετα, θα δημιουργηθεί ένα στοιχείο που να περιέχει τόσο το περιεχόμενο όσο 

και το φόντο. 

● Δεν υπάρχει δυνατότητα μετατροπής ειδικών ομάδων σε masks ή Boolean ομάδες 

σε στοίβες. 

● Δεν υπάρχει δυνατότητα αλλαγής του stack size  προς την κατεύθυνση της στοίβας. 

● Δεν υπάρχει δυνατότητα επιλογής ενός στοιχείου στοίβας και στοιχείων εκτός 

στοίβας. 

 

 
201 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
202 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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Οι στοίβες στο Adobe XD επιτρέπουν σε αντικείμενα μέσα σε μια ομάδα να ορίζουν 

σταθερά κενά μεταξύ τους. Κατά την αλλαγή μεγέθους, την αναδιάταξη ή την 

τροποποίηση αντικειμένων μέσα σε μια στοίβα, το XD διατηρεί αυτόματα τον 

καθορισμένο χώρο μεταξύ των αντικειμένων. Σε συνδυασμό με το padding και το 

responsive resize, οι στοίβες δημιουργούν έναν ισχυρό συνδυασμό χαρακτηριστικών που 

παρέχει περισσότερο έλεγχο και ταχύτητα στο σχεδιασμό.203 

Ενεργοποίηση στοιβών (Enable stacks) 

Μπορείτε να ενεργοποιήσετε στοίβες σε μια ομάδα ή στοιχείο που έχει ενεργοποιημένο 

το Responsive Resize. Επιλέξτετο πλαίσιο Stacks του Responsive Resize του Property 

Inspector. Το XD καθορίζει αυτόματα τον προσανατολισμό της στοίβας, με βάση τη δομή 

της ομάδας ή του στοιχείου. Ωστόσο, εάν θέλετε την αλλαγή προσανατολισμού της 

στοίβας, επιλέξτε Vertical ή Horizontal στην επιλογή Stacks στο Property Inspector. 

Με την ενεργοποίηση του stack, το XD προχωράει στις εξής ενέργειες:204 

● Προσδιορίζει αυτόματα το φόντο. 

● Ενεργοποιεί και υπολογίζει τις τιμές συμπλήρωσης. 

● Καθορίζει τον προσανατολισμό της στοίβας: Vertical ή Horizontal. 

● Ομαδοποιεί επικαλυπτόμενα στοιχεία για τη διατήρηση της διάταξης. 

● Καθορίζει και διορθώνει τις τιμές διαστήματος μεταξύ των στοιχείων. 

Επεξεργασία στοιχείων στοίβας (Edit stack elements) 

Παρέχονται οι εξής δυνατότητες επεξεργασίας στοιχείων στοίβας: 205 

● Move elements or use the Align option. 

 
203 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
204 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
205 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system for 

soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune Section 
International Conference (PuneCon) (pp. 1-5). IEEE. 
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● Resize objects and text in the stack: Επιλέξτε ένα αντικείμενο για αλλαγή 

μεγέθους. Τα υπόλοιπα αντικείμενα στη στοίβα μετακινούνται αυτόματα για να 

διατηρήσουν τη σχετική τους απόσταση. Κάντε χρήση του Auto Height για 

προσαρμογή του ύψους του κειμένου στη στοίβα χωρίς αλλαγή του πλάτους του. 

● Edit spaces between objects: Επιλέξτε ένα αντικείμενο μέσα σε ένα group ή 

στοιχείο και τοποθετήστε το δείκτη του ποντικιού στα κενά. Μια ροζ επισήμανση 

αντιπροσωπεύει το χώρο μεταξύ των αντικειμένων στη στοίβα. Κάντε click και 

σύρετε την επισήμανση, για επεξεργασία του διαστήματος μεταξύ των 

αντικειμένων. 

●  Adjust spaces within a stack: Επιλέξτε ολόκληρη τη στοίβα και κρατήστε 

πατημένο το πλήκτρο S, για προσαρμογή των κενών μέσα σε μια στοίβα. Το 

πλήκτρο S, μπορεί επίσης να χρησιμοποιηθεί για επεξεργασία του padding.  

● Equalize spaces in a stack: Σύρετε με ταυτόχρονη χρήση του Shift ή Shift + S 

(όταν η επιλογή σας είναι εκτός της στοίβας). 

● Duplicate elements in a stack: Χρησιμοποιήστε τον συνδυασμό Cmd + D (για 

MAC) ή τον συνδυασμό Ctl + D (για Windows), για αντιγραφή ενός στοιχείου 

μέσα σε μια στοίβα και την τοποθέτηση του κάτω από το επιλεγμένο αρχείο.  

Αναδιάταξη στοιχείων στοίβας (Reorder element stacks) 

Η αναδιάταξη στοιχείων στοίβας, πραγματοποιείται με τα εξής βήματα: 206 

1. Επιλέξτε τα στοιχεία στοίβας και σύρετε τα κατά μήκος της κατεύθυνσης της 

στοίβας στον καμβά. 

2. Χρησιμοποιήστε τον συνδυασμό Cmd + ] (για MAC) ή Ctrl + ] (για Windows) 

και τον συνδυασμό Cmd + [ (για MAC) ή Ctrl + [ (για Windows), για μετακίνηση 

προς τα πάνω και προς τα κάτω στη στοίβα. Η εντολή είναι διαθέσιμη και στο 

μενού, με δεξί click.  

 
206 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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3. Χρησιμοποιήστε τον συνδυασμό Cmd + Shift + ] (για MAC) ή Ctrl + Shift + ] 

(για Windows) και τον συνδυασμό Cmd + Shift + [ (για MAC) ή Ctrl + Shift + [ 

(για Windows), για μετακίνηση στην πρώτη ή στην τελευταία επιλογή σε μια 

στοίβα. Η εντολή είναι διαθέσιμη και στο μενού, με δεξί click.  

4. Η νέα θέση του στοιχείου στοίβας επισημαίνεται με ροζ πλαίσια. Για διατήρηση 

της ευθυγράμμισης (alignment) κατά την αναδιάταξη (reordering), πατήστε Shift 

για κλείδωμα των στοιχείων στοίβας προς την επιθυμητή κατεύθυνση και 

διατήρηση της αρχικής τους ευθυγράμμισης. 

Δημιουργία ή τροποποίηση ενός stack background 

Κατά τη δημιουργία μιας στοίβας, η XD καθορίζει αυτόματα το φόντο. Κατά την 

ενεργοποίηση στοιβών σε μια ομάδα ή σε ένα στοιχείο, το layer ή το group που βρίσκεται 

στη χαμηλότερη θέση στη στοίβα που επικαλύπτει το περιεχόμενό της, γίνεται το φόντο 

της. Για τη δημιουργία ή την τροποποίηση ενός stack background, ακολουθήστε τα εξής 

βήματα:207 

1. Δημιουργήστε ένα σχήμα ή μια ομάδα μέσα στη στοίβα που λειτουργεί ως φόντο 

στοίβας. Μπορείτε επίσης να δημιουργήσετε ένα φόντο έξω από τη στοίβα και να 

το αντιγράψετε στο stacked group. 

2. Από τη στοίβα, επιλέξτε το στοιχείο που θέλετε να χρησιμοποιήσετε ως φόντο. 

3. Κάντε δεξί click και επιλέξτε Make Background ή Replace Background. Το 

επιλεγμένο στοιχείο μετακινείται στο τέλος της στοίβας και αλλάζει μέγεθος, ώστε 

να ταιριάζει στο μέγεθος της στοίβας και των προεπιλεγμένων τιμών. 
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2.7 Videos 

2.7.1 Επεξεργασία video 

Εισαγωγή βίντεο 

Για εισαγωγή ενός βίντεο σε XD, σύρετε το βίντεο στο artboard. Εναλλακτικά, 

επιλέξτε File> Import. Τα βίντεο πρέπει να έχουν τα παρακάτω χαρακτηριστικά για να 

μπορέσουν να εισαχθούν διαφορετικά θα εμφανίζεται σφάλμα: 208 

Μορφήαρχείου (Video file format) MP4 

Συμπίεση βίντεο - κωδικοποιητής (Video compression - codec) H.264 

Κωδικοποιητής ήχου (Audio codec) AAC 

Μέγιστο μέγεθος (Maximum size) 25 MB 

Μέγιστη ανάλυση (Maximum resolution) 4K 

 

Μετατροπή ή περικοπή βίντεο με χρήση του Media Encoder 

Το Adobe Media Encoder εξυπηρετεί στην εισαγωγή βίντεο. Τα βήματα είναι τα 

εξής:209 

1. Ανοίξτε το Media Encoder και επιλέξτε στο File>Add Source. Εντοπίστε το βίντεο 

που θέλετε να ανέβει και επιλέξτε Open. 

2. Το βίντεο εντοπίζεται στην ουρά/Queue. Κάντε click στον σύνδεσμο Preset. 

 
208 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
209 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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3. Στο παράθυρο Export settings, κάντε τις εξής ενέργειες:  

✔ Βεβαιωθείτε ότι η Μορφή (Format) είναι H.264. 

✔ Για επίτευξη μείωσης μεγέθους του βίντεο κάτω από 15 MB, είτε περικόψτε 

το βίντεο είτε επιλέξτε μια προεπιλογή (preset  με χαμηλότερη ανάλυση. 

Καθώς πραγματοποιείται η περικοπή ή δοκιμάζονται διαφορετικές 

προεπιλογές, το εκτιμώμενο μέγεθος αρχείου παρουσιάζεται στην κάτω 

δεξιά γωνία του παραθύρου. Μια προτεινόμενη προεπιλογή είναι η high 

quality 720p HD. Επιλέξτε αυτό που σας ταιριάζει και πατήστε ΟΚ. 

4. Στο Queue, κάντε click στο πράσινο κουμπί αναπαραγωγής στην πάνω δεξιά γωνία 

για export. 

5. Ανοίξτε το XD και εισάγετε το βίντεο. 

Προσαρμογή των ρυθμίσεων βίντεο 

Μετά την εισαγωγή, το πρώτο καρέ του βίντεο εμφανίζεται σε καμβά. Όταν το 

βίντεο επιλεχθεί σε Design mode, ένα εικονίδιο αναπαραγωγής εμφανίζεται στην πάνω 

αριστερή γωνία του. Για προεπισκόπηση του βίντεο ή προσαρμογή των ρυθμίσεων, κάντε 

click στο κουμπί της αναπαραγωγής, στην ενότητα Video του Property Inspector. 

Ανοίγει το Heads Up Display (HUD). Στο HUD, υπάρχουν διάφορες δυνατότητες: 

προεπισκόπησης του βίντεο κάνοντας click στην Αναπαραγωγή, περικοπής βίντεο, 

αλλαγής thumbnail, ρύθμισης της αναπαραγωγής σε loop, απενεργοποίησης του ήχου. 210 

Περικοπή βίντεο211 

1. Κάντε click στην επιλογή Trim. 

2. Επιλέξτε ένα κλιπ σύροντας τα σημεία έναρξης και διακοπής στο ρυθμιστικό. 

3. Κάντε click στο σημάδι επιλογής, για αποθήκευση του κλιπ.  

 
210 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Τα πλαίσια δεν διαγράφονται όταν γίνεται περικοπή τους. Τα καρέ ανακτώνται με διπλό 

click sto Trim.   

Αλλαγή Thumbnail212 

1. Κάντε click στο εικονίδιο για εισαγωγή μιας εικόνας.  

2. Επιλέξτε μια εικόνα. 

3. Κάντε click στο Import. 

Για διαγραφή ενός thumbnail, επιλέξτε Διαγραφή. 

Ρυθμιση αναπαραγωγής σε Loop 

Για την ενεργοποίηση ή την απενεργοποίηση της αναπαραγωγής του βίντεο σε 

loop, γίνεται χρήση της λειτουργίας εναλλαγής αναπαραγωγής Loop. Κάντε click στο 

εικονίδιο του ηχείου, για την σίγαση ή την κατάργηση της σίγασης του soundtrack στο 

βίντεο.213 

Ορισμός επιλογής αναπαραγωγής 

Αφού πραγματοποιηθούν οι απαραίτητες προσαρμογές στις ρυθμίσεις βίντεο, το 

επόμενο βήμα είναι ο έλεγχος του τρόπου αναπαραγωγής του βίντεο, με μία από τις 

δαθέσιμες επιλογές. Σε Design mode, στην ενότητα Video του Property Inspector, 

υπάρχουν τρείς επιλογές:214 

● Αναπαραγωγή με το πάτημα - προεπιλογή (Play on tap - default)   

● Αυτόματη αναπαραγωγή (Play automatically) 

● Χωρίς αναπαραγωγή (No playback) 

 

  

 
212 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 
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214 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 
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3. PROTOTYPE 
 

3.1 Εισαγωγή στη λειτουργία Prototype 

Το prototype αποτελεί την πρώτη δοκιμή της χρηστικότητας ενός προϊόντος. Οι 

designers χρησιμοποιούν τα prototypes για να μεταδώσουν τις ιδέες τους, τον σκοπό των 

προϊόντων τους και τις εμπειρίες και αντιδράσεις των χρηστών στην υπόλοιπη ομάδα, ή 

στους πιθανούς χρήστες. Είτε πρόκειται για κάποια εφαρμογή, κάποιο website ή κάποιο 

προϊόν, το prototype ζωντανεύει και μεταδίδει ,σε μεγάλο ποσοστό, την εμπειρία του 

χρήστη. Επίσης, εφαρμόζοντας τις δοκιμές χρηστικότητας, τα prototypes βοηθούν 

σημαντικά στον εντοπισμό των πλεονεκτημάτων αλλά και των αδυναμιών ενός 

σχεδιασμού.215 

3.1. 1 Δημιουργία αλληλεπιδραστικών prototype 

Αφού ολοκληρωθεί η διαδικασία σχεδίασης και το στήσιμο των εφαρμογών, σειρά 

έχει η απεικόνιση του τρόπου με τον οποίο οι χρήστες θα βιώσουν την εκάστοτε εφαρμογή 

ή ιστοσελίδα. Η απεικόνιση αυτή, επιτυγχάνεται μέσα από τη δημιουργία ενός 

διαδραστικού prototype. Παρέχεται η δυνατότητα σύνδεσης οθονών στην επιθυμητή 

ακολουθία πλοήγησης και οργάνωσης πολλαπλών ροών, έχοντας δύο ή περισσότερους 

πίνακες γραφικών συνδεδεμένους μεταξύ τους. Αφού ορίσετε τις οθόνες, μπορείτε να 

κάνετε κοινή χρήση κάθε ροής, με τη μορφή κοινόχρηστων συνδέσεων, για αναθεώρηση 

και συγκέντρωση σχολίων, έτσι ώστε να τα δημοσιεύσετε σε διάφορες επιφάνειες 

προορισμού ταυτόχρονα. 216 

Ορισμός αρχικής οθόνης (Home screen) 

Κάνοντας preview του prototype, χωρίς να έχει επιλεχθεί κανένα άλλο στοιχείο, το 

preview ξεκινάει από την αρχική οθόνη (home screen). Αυτό είναι αποτέλεσμα 

προεπιλογής, όπου η αρχική οθόνη είναι ρυθμισμένη στο artboard το όποιο έχει οριστεί 
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σαν home screen. Για τον ορισμό ενός artboard ως Αρχική Σελίδα, ακολουθήστε τα εξής 

βήματα: 217 

1. Μεταβείτε σε λειτουργία Prototype. 

2. Επιλέξτε το artboard το οποίο θα οριστεί ως αρχική οθόνη. Με την επιλογή του, 

εμφανίζεται ένα γκρι εικονίδιο αρχικής σελίδας στην επάνω αριστερή γωνία. 

3. Κάνοντας click στο εικονίδιο «Αρχική σελίδα», μετατρέπεται σε μπλέ, 

υποδεικνύοντας ότι το artboard έχει πλέον οριστεί με επιτυχία ως Home screen. 

Ρυθμίσεις πολλών ροών στο project  

Η επιλογή «Πολλαπλές ροές», επιτρέπει τη δημιουργία και την κοινή χρήση 

πολλαπλών εκδόσεων ενός design, απο το ίδιο έγγραφο ή αρχείο, καθώς και την χρήση 

του ίδιου artboard σε πολλά πρωτότυπα ή προδιαγραφές σχεδίασης. Κάθε ροή διατηρεί το 

δικό της σύνολο συνδεδεμένων οθονών και μοιράζεται λεπτομέρειες, ώστε να υπάρχει 

δυνατότητα αλλαγών και αναδημοσίευσης, χωρίς ανάγκη αναίρεσης και επανάληψης του 

συνόλου των ρυθμίσεων, κάθε φορά. 218 

Σε περίπτωση δημιουργίας πολλαπλών εκδόσεων ενός design, αρκεί να ορίσετε ένα 

δεύτερο Home artboard και να τα συνδέσετε μεταξύ τους. Κατα αυτόν τον τρόπο, 

μοιράζεστε μοναδικές συνδέσεις για κάθε σύνολο.  Τα Home artboard λειτουργούν ως 

σημείο εκκίνησης για το σχεδιασμό, όπου μπορείτε να σύρετε τις γραμμές -που ενώνουν 

τις οθόνες- με σκοπό την σύνδεση διαφορετικών οθονών μαζί. Το ίδιο σύνολο artboards, 

μπορεί να χρησιμοποιηθεί  σε πολλά prototype, χωρίς να απαιτείται διπλάσια εργασία. 219 

Ένα παράδειγμα δημιουργίας διαφορετικών ροών είναι η περίπτωση σχεδιασμού 

website που προορίζεται για πολλαπλές πλατφόρμες όπως κινητά, επιτραπέζιους 

υπολογιστές, tablet και άλλα. Σε αυτή τη περίπτωση, μπορείτε να ορίσετε και να συντάξετε 

πολλαπλές ροές αλληλεπίδρασης, όπου σε κάθε ροή απεικονίζεται μία πλοήγηση χρήστη. 

 
217 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 
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Αργότερα, μπορείτε να μοιραστείτε κάθε μεμονωμένη ροή με τους ενδιαφερόμενους, με 

σκοπό την συγκέντρωση σχολίων. Τα βήματα είναι τα κάτωθι: 220 

1. Μεταβείτε σε λειτουργία Prototype. 

2. Ορίστε «Home artboard», ως σημείο εκκίνησης του σχεδίου. 

3. Εισάγετε ονομασία για κάθε ροή, για καλύτερη οργάνωση. 

4. Σε περίπτωση που το design αποτελείται από πολλές ροές, ορίστε τα κεντρικά 

artboards για κάθε μία από αυτές τις ροές. 

5. Κάντε click στο επόμενο αντικείμενο ή artboard που θέλετε να συνδέσετε. 

6. Αφού εμφανιστεί μία λαβή σύνδεσης με ένα βέλος από το αντικείμενο ή το 

artboard, κάντε click και σύρετε για να αποδεσμεύσετε τη λαβή στο αντικείμενο ή 

το artboard προορισμού.  

Προσθήκη αλληλεπιδράσεων για αντικείμενα και artboards  

Για να πραγματοποιηθεί αυτό, επιλέξτε το αντικείμενο και κάντε click στο + το 

οποίο βρίσκεται δίπλα του ή στο + το οποίο βρίσκεται στο εργαλείο Property Inspector. 

Ενεργοποιήστε το Triggers and Action Type. Μόλις επιλεγεί ο τύπος ενέργειας, ορίστε 
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τις συγκεκριμένες επιλογές για αυτόν τον τύπο ενέργειας, συμπεριλαμβανομένου του 

«Destination» . Για παράδειγμα, σε περίπτωση που το ζητούμενο είναι η βελτίωση της 

εμπειρίας περιήγησης για τα πρωτότυπα, μία λύση αποτελεί η προσθήκη anchor links, 

ορίζοντας την επιλογή «scroll to» ως action type:221 

 

A. Ρυθμίσειςγια Tap, Drag, Hover, Time, Keys & Gamepad, Voice ή End of playback. 

B. Ορισμός χρόνου, καθυστέρηση σε δευτερόλεπτα. 

C. Ορισμός σε μετάβαση, αυτόματη κίνηση, επικάλυψη, κύλιση σε, προηγούμενο 

artboard, αναπαραγωγή ήχου, αναπαραγωγή ομιλίας, αναπαραγωγή βίντεο 

D. Αλλαγή προορισμού των artboard σε περίπτωση που απαιτείται. 

E. Ορισμόςσε dissolve or none. 

F. Επιλογή του easing effect. 

G. Εισαγωγή της χρονικής διάρκειας σε δευτερόλεπτα. 
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Σε περίπτωση που επιλέξετε «Tap» ως έναυσμα, παρέχεται η δυνατότητα συνδυασμού 

του  transition με μια ενέργεια  non-transitional, όπως για παράδειγμα την αναπαραγωγή 

ομιλίας ή ήχου. Για την προσθήκη δεύτερης ενέργειας, πρέπει να ορίσετε το πρώτο κουμπί 

Action +, το οποίο βρίσκεται στο Property Inspector σε transition, auto-animate, overlay, 

scroll to ή previous και να ορίσετε το δεύτερο κουμπί Action + στην αναπαραγωγή ήχου ή 

speech. Σε περίπτωση που η αναπαραγωγή ήχου ή ομιλίας επιλεχθεί ως πρώτη ενέργεια, 

δεν υπάρχει δυνατότητα επιλογής δεύτερης ενέργειας Για τον συνδυασμό πολλών 

εναυσμάτων, για δημιουργία σύνθετων αλληλεπιδράσεων, χωρίς κατανομή των 

εναυσμάτων σε διαφορετικά αντικείμενα σε ένα artboard, χρησιμοποιήστε το κουμπί + 

στον καμβά. Εναλλακτικά, κάντε click στο κουμπί + στο Property Inspector, και στην 

συνέχεια επιλέξτε το Triggers, Action και Destination.222 

Tips223 

● Για επεξεργασία ή διαγραφή ενός wire, αρκεί πολύ απλά να τα επιλεξουμε. 

Μπορούμε επίσης να επιλέξουμε μια μεμονωμένη αλληλεπίδραση από το property 

inspector και να επεξεργαστούμε τις αλληλεπιδράσεις της. 

● Για προσωρινή απόκρυψη των γραμμών -που ενώνουν τις οθόνες- στη λειτουργία 

prototype, κρατάμε πατημένο το πλήκτρο Option (για MAC) ή Alt (για Windows). 

● Τοποθετούμε το δείκτη του ποντικιού πάνω στο καλώδιο για να φανεί μια 

συμβουλή εργαλείου, η οποία μας ενημερώνει για τον αριθμό των 

αλληλεπιδράσεων και τον τύπο τους. 

● Για την εφαρμογή της καθορισμένης αλληλεπίδρασης σε άλλο αντικείμενο, 

επιλέγουμε το αντικείμενο ή το artboard, στη συνέχεια επιλέγουμε αντιγραφή, 

κάνουμε click στο αντικείμενο ή το artboard προορισμού και στο contex menu, 

κάνοντας δεξί click, επιλέγουμε το paste interaction. 

  

 
222 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
223 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 



96 
 

Σύνδεση με προηγούμενο artboard 

Η σύνδεση με προηγούμενο artboard, πραγματοποιείται με τα εξής βήματα: 224 

1. Σε λειτουργία Prototype, επιλέξτε το στοιχείο ή το artboard το οποίο θέλετε να 

συνδέσετε. Όταν εμφανιστεί ένα μικρό βέλος, κάντε click και σύρετε το βέλος στο 

προηγούμενο artboard. Εναλλακτικά, επιλέξτε Action >προηγούμενο artboard.  

2. Πραγματοποιήστε προεπισκόπηση των συνδέσεων, μέσα από το παράθυρο 

preview.  

Λύσιμο των artboards  

Το λύσιμο των artboards, πραγματοποιείται με τα εξής βήματα: 225 

1. Σε λειτουργία Prototype, επιλέξτε Destination > None 

2. Πραγματοποιήστε προεπισκόπηση της σύνδεσης σε ένα πρόγραμμα περιήγησης. 

Με αυτό τον τρόπο, καταργείται οποιαδήποτε σύνδεση προορισμού έχει 

προηγηθεί. 

Αλληλεπίδραση προεπισκόπησης και εγγραφής 

Η Αλληλεπίδραση προεπισκόπησης και εγγραφής, πραγματοποιείται με τα εξής βήματα:  

1. Κάντε click στο εικονίδιο προεπισκόπησης επιφάνειας εργασίας. Εμφανίζεται το 

παράθυρο «Προεπισκόπηση» και  το artboard σε εστίαση.  

Για τον έλεγχο της πλοήγησης μεταξύ οθονών, κάντε click στα αλληλεπιδραστικά 

στοιχεία. Μπορείτε να επεξεργαστείτε τη σχεδίαση και τις αλληλεπιδράσεις στο prototype 

ενώ πραγματοποιείται προεπισκόπηση στο preview window. Οι αλλαγές που προκύπτουν 

είναι άμεσα διαθέσιμες για προεπισκόπηση.226 
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2. Για καταγραφή αλληλεπίδρασης, κάντε click στο εικονίδιο Record το οποίο 

βρίσκεται στο preview window. 

3. Για τον τερματισμό εγγραφής, επιλέξτε Esc ή κάντε ξανά click στο εικονίδιο 

Record. 

4. Καθορίστε ένα όνομα και μία θέση όπου θα αποθηκευτεί η εγγραφή. Η εγγραφή 

αποθηκεύεται ως αρχείο mp4. 

➔ Με ποιον τρόπο μπορείτε να δημιουργήσετε μικρό-αλληλεπιδράσεις, 

χρησιμοποιώντας την αυτόματη κίνηση;  

Με την αυτόματη κίνηση, μπορούμε να δημιουργήσουμε συναρπαστικές μεταβάσεις 

για να απεικονίσουμε την κίνηση του περιεχομένου σε artwork. Σε συνδυασμό με το Drag 

and Time, μας βοηθά να δημιουργήσουμε ένα ευρύ φάσμα εφέ, όπως ένα YouTube swipe 

και να σύρουμε για να έχουμε ένα καλύτερο αποτέλεσμα prototype.227 

Για την κατανόηση του τρόπου δημιουργίας ενός prototype με κίνηση, πρέπει να 

αναφερθούν ορισμένοι χρήσιμοι κανόνες: 228 

1. Aν ένα αντικείμενο δεν υπάρχει στα artboard προορισμού, εμφανίζεται σταδιακά.  

2. Αν ένα αντικείμενο δεν υπάρχει στο artboard προέλευσης, εξαφανίζεται σταδιακά. 

3. Αν ένα αντικείμενο έχει αντιστοιχία τόσο από άποψη ονόματος επιπέδου όσο και 

από άποψη ομάδας, οι ιδιότητες εισάγονται ως κινούμενες. 

4. Για τη δημιουργία prototype ενός οριζόντιου ή κατακόρυφου εφέ κύλισης, 

μπορείτε να χρησιμοποιήσετε ομάδες κύλισης. 

Για τη δημιουργία ενός prototype με κίνηση: 229 
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1. Συνδέστε τα artboards με τη λειτουργία prototype. 

2. Κάντε click στη γραμμή σύνδεσης για να προλάβετε τον πίνακα αλληλεπίδρασης 

ο οποίος εμφανίζεται στο property inspector και στη συνέχεια ορίστε τις ακόλουθες 

επιλογές:230 

Trigger: ορισμός μιας επιλογής για την ενεργοποίηση μίας αλληλεπίδρασης -Tap, Drag 

Time, Keys and Gamepad, Voice- . 

Action: επιλογή αυτόματης κίνησης. Σε αυτή τη περίπτωση, υπάρχει δυνατότητα 

αντιστοίχισης δύο ενεργειών σε ένα μόνο έναυσμα, όπως είναι το Tap.  

Πρέπει πρώτα να οριστεί το πρώτο κουμπί Action + στο property inspector σε transition, 

Auto-animate, overlay, scroll to ή previous artboard. Στην συνέχεια να οριστεί το δεύτερο 

κουμπί Action + σε μη μεταβατική ενέργεια. Για παράδειγμα, αν οριστεί η αναπαραγωγή 

ήχου ή ομιλίας ως πρώτη ενέργεια, δεν μπορούμε να προσθέσουμε δεύτερη ενέργεια. 

Destination: επιλογή του artboard προορισμού για τη μετάβαση της κίνησης. 

Easing: ορισμός μιας επιλογής για αναπαράσταση μιας χαλαρής εναλλαγής. Για 

παράδειγμα, επιλέγουμε Ease Out  σε περίπτωση που θέλουμε να απαλύνουμε τα animate 

γραφικά από το prototype. 

3. Για να οριστεί περαιτέρω αλληλεπίδραση για ένα αντικείμενο, επιλέξτε το 

αντικείμενο με μία αλληλεπίδραση που έχει ήδη οριστεί και κάντε click στο κουμπί 

+ στο artboard. Εναλλακτικά, κάντε click στο κουμπί + το οποίο βρίσκεται στο 

property inspector. 

4. Πραγματοποιήστε προεπισκόπηση (preview) του animation στα υποστηριζόμενα 

προγράμματα περιήγησης. 
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Προσθήκη αναπαραγωγικού ήχου (playback) σε prototype 

Για την προσθήκη αναπαραγωγής ήχου σε ένα αντικείμενο ή σε ένα artboard, αρκεί να 

εκτελέσουμε τα παρακάτω βήματα:231 

1. Σε λειτουργία Prototype, επιλέξτε το αντικείμενο ή το artboard. 

2. Στο Property Inspector, ορίστε τις ακόλουθες επιλογές: 

● Κάντε click στο κουμπί (+), για προσθήκη αλληλεπίδρασης.  

● Επιλέξτε Trigger για ορισμό σε tap. 

● Ορίστε το Action σε audio playback. Στη συνέχεια, πραγματοποιήστε περιήγηση 

και προσθήκη του αρχείου ήχου.  

Προσθήκη πολλών ενεργειών σε ένα Trigger 

Υπάρχει δυνατότητα προσθήκης μιας μη μεταβατικής ενέργειας, όπως μια 

αναπαραγωγή ήχου, με μία κύρια μεταβατική ενέργεια, όπως μετάβαση ή αυτόματη 

κίνηση σε ένα μόνο έναυσμα. Για παράδειγμα, όταν κάνουμε μετάβαση από ένα artboard 

σε ένα άλλο, εμφανίζεται ήχος με click του ποντικιού.  Για την προσθήκη πολλών 

ενεργειών  στο prototype, ακολουθήστε τα παρακάτω βήματα:232 

1. Σε λειτουργία Prototype, επιλέξτε το αντικείμενο ή το artboard, που επιθυμείτε 

προσθήκη ενεργειών.  

2. Στο property inspector, ορίστε τις ακόλουθες επιλογές: 

● Κάντε click στο κουμπί + για προσθήκη αλληλεπίδρασης. 

● Επιλέξτε Trigger για ορισμό σε tap. 

● Ορίστε το πρώτο κουμπί Action + (μεταβατικήενέργεια), σεTransition, Auto-

Animate, Overlay, Scroll To, Previous. 

● Ρυθμίστε το δεύτερο κουμπί Action + (μη μεταβατική ενέργεια) σε Audio 

Playback ή Speech Playback. 
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Προσθήκη αναπαραγωγής ομιλίας 

Για την προσθήκη αναπαραγωγής ομιλίας σε ένα αντικείμενο ή artboard, ακολουθήστε 

τα παρακάτω βήματα: 233 

1. Ενώστε το artboard προέλευσης στο artboard προορισμού. 

2. Στο Property Inspector, ορίστε τις ακόλουθες επιλογές:  

● Trigger: Ορισμός σε χρόνο. 

● Delay: Ορισμός της χρονικής καθυστέρησης (σε δευτερόλεπτα) για το πότε θα 

ξεκινάει η αναπαραγωγή ομιλίας. 

● Action: Ορισμός σε αναπαραγωγή ομιλίας. 

● Voice: Επιλογή μιας φωνή για την αναπαραγωγή ομιλίας. 

● Speech: Πληκτρολογήστε το κείμενο που επιθυμείτε για την αναπαραγωγή ομιλίας. 

Προσθήκη φωνητικής αφήγησης σε prototype 

Για την προσθήκη φωνητικής αφήγησης σε πρωτότυπο, ακολουθήστε τα παρακάτω 

βήματα: 234 

1. Σε λειτουργία Prototype, επιλέξτε την αρχική οθόνη στην οποία έχει οριστεί η αρχή 

της ροής και κάντε click στο κουμπί Desktop Preview. 

2. Επιλέξτε το αναπτυσσόμενο βέλος, δίπλα στο κουμπί εγγραφής. Στη συνέχεια, 

επιλέξτε Ενεργοποίηση μικροφώνου (για MAC). Ενεργοποιήστε το μικρόφωνο 

μέσω ενός ελέγχου επιπέδου λειτουργικού συστήματος στο GameCenter (για 

Windows).  

3. Τέλος, προχωρήστε σε αποθήκευση της εγγραφής ως αρχείο MP4. Με αυτόν τον 

τρόπο μπορείτε να την μοιραστείτε με τους συμμετέχοντες ή να την δημοσιεύσετε 

στα μέσα κοινωνικής δικτύωσης. 
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Κοινή χρήση και review της σύνδεσης προδιαγραφών prototype ή σχεδίασης στο Web 

Για την κοινή χρήση της σύνδεσης προδιαγραφών  prototype ή σχεδίασης στο Web, 

ακολουθήστε τα παρακάτω βήματα: 235 

1. Στο desktop app, κάντε click στο εικονίδιο Share, πάνω δεξιά. Στη συνέχεια, 

επιλέξτε Design review (για prototype) ή Development (για προδιαγραφές 

σχεδίασης). 

2. Όταν κάνουμε preview ενός prototype, υπάρχουν οι παρακάτω επιλογές:  

● Επιτραπέζιος ή φορητός υπολογιστής: Κρατήστε  πατημένο το πλήκτρο 

διαστήματος. 

● Εφαρμογή Adobe XD Mobile (iOS/Android):  Πατήστε παρατεταμένα με 

οποιοδήποτε σημείο της οθόνης. Στη συνέχεια, τοποθετήστε το δάχτυλό σας στην 

οθόνη, χωρίς να το μετακινήσετε, και χρησιμοποιήστε τη φωνητική εντολή, πριν 

σηκώσετε και πάλι το δάχτυλο σας. 

● Mobile browser: Κρατήστε πατημένο το εικονίδιο μικροφώνου στην κάτω δεξιά 

γωνία της οθόνης. Κατά την προεπισκόπηση των προδιαγραφών σχεδίασης, οι 

προγραμματιστές έχουν δυνατότητα να διαβάσουν ή να δουν τις φωνητικές εντολές 

καθώς και την αναπαραγωγή ομιλίας ως κείμενο. 

*Tip: οι προδιαγραφές σχεδίασης δεν υποστηρίζουν φωνητικές αλληλεπιδράσεις. 

3.1.2 Δημιουργία χρονικών μεταβάσεων (timed transitions)  

Δημιουργία prototype με τη χρήση time triggers για τη δημιουργία χρονικών 

μεταβάσεων 

Με την χρήση των time triggers, παρέχεται η δυνατότητα δημιουργίας μεταβάσεων 

μεταξύ των artboards, με βάση την χρονική καθυστέρηση και τη διάρκεια. Η χρήση των 

συγκεκριμένων εναυσμάτων χρόνου, μπορεί να γίνει συνδυαστικά με άλλες ενέργειες, έτσι 

ώστε να δημιουργηθεί μία σειρά από εφέ, όπως είναι οι επαναλαμβανόμενες κινούμενες 

 
235 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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εικόνες,οι γραμμές προόδου και άλλα.  Η δημιουργία μιας απλής χρονικής μετάβασης, 

πραγματοποιείται με τα παρακάτω βήματα: 236 

1. Σε λειτουργία Prototype, κάντε click στον τίτλο του artboard προέλευσης και 

μεταφέρετε τον στο artboard προορισμού. 

2. Κάντε click στη γραμμή σύνδεσης, για την προβολή του πίνακα αλληλεπίδρασης, 

ο οποίος εμφανίζεται στο Property Inspector. Στη συνέχεια ,ορίστε τις ακόλουθες 

εντολές: 

● Trigger: επιλογή ώρας. Αν δεν βλέπετε την συγκεκριμένη επιλογή, είναι πιθανό να 

μην έχετε επιλέξει ολόκληρο τον πίνακα γραφικών και μαζί και τον τίτλο του στο 

βήμα 1. 

● Delay: εισαγωγή της χρονικής καθυστέρησης, για να ακολουθήσει η έναρξη της 

μετάβασης. Το αποδεκτό εύρος κυμαίνεται από 0,2 – 5 δευτερόλεπτα. 

● Action: επιλογή μετάβασης. Μπορείτε επίσης να χρησιμοποιήσετε έναυσμα 

χρόνου με άλλες ενέργειες, όπως είναι το auto-animate, το overlay και η 

αναπαραγωγή ομιλίας για τη δημιουργία διαφορετικών εφέ.  

● Destination: εμφάνιση του artboard προορισμού, το οποίο είναι συνδεδεμένο με το 

βήμα 1, το οποίο μπορεί να τροποποιηθεί σε περίπτωση που απαιτείται. 

● Easing: επιλογή του επιθυμητού εφέ easing, για την εφαρμογή στο artboard 

προέλευσης. 

● Duration: εισαγωγή της διάρκειας του εφέ χαλάρωσης για υπόδειξη του χρονικού 

του διαστήματος. Το αποδεκτό εύρος κυμαίνεται από  0,2 – 5 δευτερόλεπτα. 

  

 
236 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
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3.1.3 Προσθήκη overlays  

Εισαγωγή overlay για προσομοίωση αλληλεπιδραστικών εφέ διαφάνειας 

Το Adobe XD επιτρέπει στον χρήστη να στοιβάξει περιεχόμενο πάνω σε ένα άλλο 

artboard, αντί της αναπαραγωγής σε πολλά artboards, με σκοπό την προσομοίωση εφέ 

όπως drop-down lists , slide-up keyboards και άλλα. Η εισαγωγή overlay για προσομοίωση 

αλληλεπιδραστικών εφέ διαφάνειας, πραγματοποιείται με τα παρακάτω βήματα: 237 

1. Σε λειτουργία Design, επιλέξτε ένα artboard προέλευσης και ένα ακόμα artboard, 

προκειμένου να πραγματοποιηθεί overlay.  Ένα overlay artboard μπορεί να 

χρησιμοποιηθεί πολλές φορές. 

2. Σε λειτουργία Prototype, κάντε χρήση του drag and drop στη γραμμή σύνδεσης 

από το artboard προέλευσης στο artboard το οποίο περιέχει το overlay. Κάντε click 

στη γραμμή σύνδεσης για προβολή του interaction panel το οποίο εμφανίζεται στο 

property inspector. Στη συνέχεια, ορίστε τις ακόλουθες επιλογές:  

● Trigger: ορισμός μιας επιλογής. 

● Action: επιλογή του overlay. Σε περίπτωση που θελήσετε να εισάγετε δύο ενέργειες 

σε ένα μόνο trigger, όπως το tap, τότε ρυθμίστε το πρώτο κουμπί action +  στο 

Property Inspector σε overlay και το δεύτερο κουμπί action +  σε μία μη μεταβατική 

ενέργεια, όπως η αναπαραγωγή ήχου ή αναπαραγωγή ομιλίας. 

● Animation: επιλογή του τύπου κίνησης. Σε περίπτωση επιλογής «ολίσθηση προς 

τα πάνω» (slide up), ή «ολίσθηση προς τα κάτω» (slide down), το XD τοποθετεί 

αυτόματα την επικάλυψη στην άκρη του artboard προέλευσης. 

● Easing: ορισμός μιας επιλογής για την αναπαράσταση του easing effect. 

● Duration: καταχώρηση της διάρκειας του χρόνου. Η μέγιστη επιτρεπτή διάρκεια 

μετάβασης μεταξύ δύο artboard είναι 5 δευτερόλεπτα. 

 
237 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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3. Για την ρύθμιση της θέσης ενός overlay στο artboard προέλευσης, κάντε click και 

στη συνέχεια προσαρμόστε την θέση, κάνοντας drag and drop το πράσινο κουμπί 

θέσης (+).  

4. Για την πραγματοποίηση προεπισκόπησης των overlays στα υποστηριζόμενα 

προγράμματα περιήγησης, κάντε click στο εικονίδιο play.  

Nested overlays (ένθετα overlays) 

Το adobe XD δεν υποστηρίζει ένθετα overlays, δηλαδή overlay πάνω σε  άλλο 

overlay. Σε τέτοιες περιπτώσεις, όταν συνδέετε το πρώτο overlay artboard σε άλλο 

artboard, το πρώτο overlay μεταβαίνει προς τα έξω πριν τη μετάβαση στο δεύτερο overlay. 

238 

Side-in-drop-down list effect (εφέ αναπτυσσόμενης λίστας) 239 

Για τη δημιουργία ενός εφέ αναπτυσσόμενης λίστας, ακολουθήστε τα παρακάτω 

βήματα:   

1. Αρχικά, επιλέξτε ένα artboard προέλευσης και ένα artboard επικάλυψης το οποίο να 

διαθέτει αναπτυσσόμενη λίστα στοιχείων. 

2. Μεταβείτε σε λειτουργία Prototype, για την σύνδεση του artboard προέλευσης με το 

artboard επικάλυψης. 

           Στη συνέχεια, ορίστε τις παρακάτω επιλογές στο Property Inspector:  

● Trigger: επιλογή του tap  

● Action: επιλογή του overlay 

● Animation: επιλογή με slide right  

● Easing: επιλογή του ease out εφέ  

 
238 Wood, B. (2020). Adobe XD Classroom in a Book (2020 release). Adobe Press. 
239 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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● Duration: εισαγωγή της τιμής 0.3s  

3. Συνδέστε όσα διαφορετικά artboards προέλευσης επιθυμείτε στο overlay artboard. 

4. Τέλος, για πραγματοποίηση προεπισκόπησης του εφέ, χρησιμοποιήστε την επιλογή 

preview της επιφάνειας εργασίας. 

3.1.4 Design Voice Prototypes 

Συγχώνευση voice prototype με το XD 

Οι δυνατότητες φωνής στο Adobe XD επιτρέπουν στους σχεδιαστές να 

ενσωματώνουν τη φωνή τους στα prototypes τους και με αυτό το τρόπο να σχεδιάζουν 

πλούσιες εμπειρίες, όπως την ενσωμάτωση της φωνητικής αναζήτησης σε μία φορητή 

εφαρμογή, την προσθήκη μιας εξόδου ομιλίας για οδηγίες βήμα προς βήμα σε ένα σύστημα 

πλοήγησης αυτοκινήτου ή την ενσωμάτωση τους σε ένα διαδραστικό περίπτερο στο χώρο 

της λιανικής.240 

Οι φωνητικές εντολές επιτρέπουν τη δημιουργία μιας αλληλεπίδρασης με την 

χρήση λεκτικής εντολής. Παρόμοια με τη χρήση ενός click ή ενός tap ως trigger, υπάρχει 

δυνατότητα προσθήκης μιας συγκεκριμένης έκφρασης ως trigger μέσα στη λειτουργία 

δημιουργίας prototype του XD. Η αναπαραγωγή ομιλίας παρέχει πρόσβαση σε μία ισχυρή 

μηχανή κειμένου σε ομιλία, μέσω της οποίας είναι εφικτή η αλληλεπίδραση με το 

prototype.241 

Πλεονεκτήματα των δυνατοτήτων φωνής σε XD.242 

● Ικανότητα σχεδιασμού prototype και ανταλλαγής εμπειριών με τη χρήση της 

φωνής. 

● Δημιουργία εμπειριών για νέες πλατφόρμες και συσκευές, όπως ενισχυτές φωνής 

και έξυπνα ηχεία. 

 
240 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
241 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
242 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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● Ευκολία χρήσης στην προσθήκη της φωνής, όπως κάθε άλλη αλληλεπίδραση 

prototype, χωρίς προηγούμενη εμπειρία στη τεχνολογία φωνής ή την 

κωδικοποίηση. 

Προϋποθέσεις χρήσης φωνής στα prototypes243 

Απαραίτητα είναι τα παρακάτω: 

● XD έκδοση 13.0 ή νεότερη για τη προσθήκη δυνατοτήτων φωνής και την 

προεπισκόπηση. 

● Αξιόπιστη σύνδεση στο διαδίκτυο για αλληλεπίδραση με χαρακτηριστικά φωνής. 

Δεν είναι εφικτή η χρήση φωνητικών εντολών με ενσωματωμένα prototype ή prototype τα 

οποία είναι εκτός σύνδεσης. 

3.1.5 Δημιουργία anchor links 244 

➔ Πως μπορώ να δημιουργήσω anchor  link για να βελτιώσω την εμπειρία 

περιήγησης του χρήστη μεταξύ των artboards? 

Το adobe XD δίνει τη δυνατότητα να δημιουργήσουμε anchor links κατά τη δημιουργία 

prototype  και μας βοηθάει να πραγματοποιήσουμε κύλιση σε συγκεκριμένες ενότητες 

ενός artboard. Η χρήση των  anchor links εξυπηρετεί τη ταχύτερη περιήγηση και 

βελτιωμένη χρηστικότητα κατά το σχεδιασμό μιας μεγάλης σελίδας ή ενός μεγάλου 

κειμένου.  Ακολουθεί μία μικρή εμπειρία κύλισης, μεταβαίνοντας γρήγορα σε 

συγκεκριμένες ενότητες σε ένα artboard. 

1. Αρχικά μεταβείτε σε λειτουργία prototype. Επιλέξτε το αντικείμενο στο 

artboard, στο οποίο θέλετε να προσθέσετε ένα anchor link. 

2. Σύρετε το prototyping wire κάτω από το artboard σας μέχρι να φτάσετε στο 

σημείο το οποίο θέλετε να συνδεθείτε. 

 
243 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
244 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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3. Κάντε click στο prototyping wire για να δείτε το interaction panel το οποίο 

εμφανίζεται στο property inspector με τις ακόλουθες επιλογές:  

● Trigger: ορισμός σε tap 

● Action: ορισμός σε scroll Το 

● Destination: επιλογή του επιπέδου προορισμού  

● Y-offset( μετατόπιση y): εισάγετε την επιθυμητή τιμή της μετατόπισης y, η 

οποία είναι σχετική με την κορυφή του wired αντικειμένου. Σύρετε τη λαβή 

μετατόπισης y στα αριστερά του artboard και παρατηρήστε ότι η τιμή 

μετατόπισης y αλλάζει. Οποιαδήποτε τιμή πάνω από το wired αντικείμενο 

είναι αρνητική μετατόπιση και κάτω είναι θετική μετατόπιση. 

● Easing: ορίστε μια επιλογή για να αναπαραστήσετε τα easing effect. Για 

παράδειγμα, επιλέξτε το “Ease-Out” για να εξομαλύνετε την κινούμενη 

εικόνα από το prototype. 

● Duration: καταχωρίστε τη διάρκεια του χρόνου. Η μέγιστη διάρκεια που 

μπορείτε να ορίσετε ανάμεσα σε δύο artboards μετάβασης είναι 5 

δευτερόλεπτα. 

4. Για να πραγματοποιήσετε προεπισκόπηση στο scrolling εφέ το οποίο βρίσκεται 

στο artboard σας, κάντε click στο κουμπί  

3.1.6 Δημιουργία hyperlinks 

Σύνδεση σε εξωτερικές σελίδες web από το prototype της adobe XD 

Σε αυτό το σημείο να αναφερθεί ότι οποιοδήποτε κείμενο, αντικείμενο ή 

component στο design  του χρήστη, μπορεί να συνδεθεί με μία εξωτερική ιστοσελίδα ή μια 

διεύθυνση e-mail. Αφού δημιουργηθεί ένα hyperlink, μπορεί να πραγματοποιηθεί 

προεπισκόπηση και κοινή χρήση των προδιαγραφών σχεδίασης με τα ενδιαφερόμενα 

μέλη.245 

 
245 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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Δημιουργία hyperlink text 

Για τη δημιουργία hyperlink text σε μία ιστοσελίδα ή σε μία διεύθυνση mail, 

ακολουθήστε τα παρακάτω βήματα: 246 

1. Σε λειτουργία design, επιλέξτε το κείμενο μέσα στο text object το οποίο θέλετε να 

μετατραπεί σε hyperlink. 

2. Στο πεδίο insert URL here, στην ενότητα text του Property Inspector,  

πραγματοποιήστε τα εξής: Για τη δημιουργία σύνδεσης προς μίας ασφαλή 

ιστοσελίδα (https), πληκτρολογήστε τη διεύθυνση URL της ιστοσελίδας. Για 

παράδειγμα: https://www.adobe.com 

 

 

 

 

 

 

Για τη δημιουργία σύνδεσης προς μία διεύθυνση ηλεκτρονικού ταχυδρομείου, 

πληκτρολογήστε mailto:. Στη συνέχεια, συμπληρώστε τη διεύθυνση ηλετρονικού 

ταχυδρομείου του παραλήπτη. Για παράδειγμα: mailto: katy@xyz.com

Αφού καθοριστεί το text hyperlink στο design mode:247 

● Πάνω στον καμβά, υπογραμμίζεται από προεπιλογή το hyperlinked text. 

● Σε περίπτωση που μόνο ένα τμήμα του κειμένου είναι hyperlink, όταν επιλέξουμε το 

αντικείμενο κειμένου θα εμφανιστεί μία παύλα (-) στο πεδίο URL here. 

 
246 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
247 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 

https://www.adobe.com/
mailto:katy@xyz.com
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● Σε λειτουργία prototype, αν έχει επιλεχθεί ένα κείμενο ως hyperlinks, τότε αυτό θα 

εμφανίζεται στο property inspector. 

● Μπορούμε να επεξεργαστούμε ένα hyperlink text όταν βρισκόμαστε σε λειτουργία 

σχεδίασης ή prototype. 

Δημιουργία object ή component hyperlink 

Για την σύνδεση ενός αντικειμένου ή ενός component με μία ιστοσελίδα ή μία διεύθυνση  e-

mail, αρκεί να εκτελέσετε τα παρακάτω βήματα:248 

1. Αρχικά πρέπει να μεταβείτε στη λειτουργία Prototype και να επιλέξετε το αντικείμενο ή 

αντίστοιχα το component το οποίο θέλετε να ορίσετε ως hyperlink. 

2. Στη συνέχεια, κάντε click στο μπλε βέλος και μετά στο αντικείμενο στο property inspector 

όπου θα ορίσετε για trigger το tap, keys & gamepad ή voice. 

3. Ορίστετο action type σε hyperlink  

4. Στο πεδίο destination, ακολουθήστε τις παρακάτω εντολές: 

● Για τη δημιουργία σύνδεσης προς μία ασφαλή ιστιοσελίδα (https), πληκτρολογήστε τη 

διεύθυνση URL της ιστιοσελίδας. Για παράδειγμα: https://www.adobe.com 

● Για τη δημιουργία σύνδεσης προς μία διεύθυνση ηλεκτρονικού ταχυδρομείου, αρκεί να 

πληκτρολογήσετε mailto: Στη συνέχεια, πληκτρολογήστε τη διεύθυνση ηλεκτρονικου 

ταχυδρομείου του παραλήπτη. Για παράδειγμα: katy@xyz.com

 
248 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 

https://www.adobe.com/
mailto:katy@xyz.com


3.1.7 Προεπισκόπηση design και prototypes 249 

➔ Πως μπορούμε να κάνουμε προεπισκόπηση prototype και να 

καταγράψουμε τις αλληλεπιδράσεις χρησιμοποιώντας το Adobe XD;  

Αφού ολοκληρωθεί η σχεδίαση των πόρων ή των prototypes, μπορούμε να κάνουμε 

προεπισκόπηση της ροής του website ή της εφαρμογής  που σχεδιάσαμε , 

συμπεριλαμβανομένων   των μεταβάσεων οθόνης. Κατά την προεπισκόπηση, μας 

δίνεται η δυνατότητα να αλλάξουμε τα design ή τα prototypes στο Adobe XD και να 

τα ελέγχουμε σε πραγματικό χρόνο. 

Η διαδικασία είναι τα εξής:  

Σε λειτουργία Design ή Prototype, κάντε click στο Desktop preview. 

Εμφανίζεται το παράθυρο προεπισκόπησης. Στο παράθυρο προεπισκόπησης, 

εμφανίζεται το artboard το οποίο περιέχει τα τρέχοντα επιλεγμένα αντικείμενα. Σε 

περίπτωση που δεν έχει επιλεγεί κάποιο αντικείμενο, τότε το preview window 

εμφανίζει πρώτα το home artboard.  

Επισημαίνεται ότι πραγματοποιώντας αλλαγές πάνω στα prototypes και γενικά 

πάνω σε design, οι αλλαγές ενημερώνονται άμεσα στο preview window. 

Για την έξοδο από το παράθυρο preview, κάντε click στο κουμπί κλεισίματος 

του παραθύρου. 

Καταγραφή αλληλεπιδράσεων σε prototypes250 

Όπως έχει ήδη αναφερθεί, η προεπισκόπηση των design και των prototypes, 

πραγματοποιείται κάνοντας click στην επιλογή Preview. Η καταγραφή 

αλληλεπιδράσεων πραγματοποιείται στο παράθυρο αυτό, κάνοντας click στο κουμπί 

Record. Σε περίπτωση που υπάρχει κάποιο αλληλεπιδραστικό Prototype, τότε όλες οι 

αλληλεπιδράσεις καταγράφονται ως αρχεία mp4. 

Για διακοπή της εγγραφής, κάντε ξανά click στην επιλογή record. Εναλλακτικά, 

πατήστε το Esc. Η εγγραφή σταματά επίσης αν βγείτε απο την εφαρμογή ή αν το 

παράθυρο προεπισκόπησης δεν είναι πια εστιασμένο. 

 
249 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
250 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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Χρησιμοποιώντας την εφαρμογή Adobe XD για κινητές συσκευές, υπάρχει 

δυνατότητα προεπισκόπησης των σχεδίων και των prototypes σε συσκευές iOS και 

Android. Πολλαπλές συσκευές μπορούν να συνδεθούν, χρησιμοποιώντας θύρες USB 

στον υπολογιστή που τρέχει XD. Κατα την υλοποίηση αλλαγών, έχετε πρόσβαση 

στην προεπισκόπηση της λειτουργίας σε πραγματικό χρόνο σε όλες τις συνδεδεμένες 

συσκευές. 

3.2 Share, export and review 

3.2.1 Κοινοποίησηεπιλεγμένων artboards 

Σε Prototype mode:251 

1. Για την σύνδεση δύο artboards, σύρουμε το μπλε βέλος από το πρώτο μέχρι το τελικό 

artboard  που είναι και ο επιθυμητός προορισμός.  

2. Για διαγραφή μιας σύνδεσης που έχουμε κάνει, την επιλέγουμε και πατάμε Delete. 

Μεταφερόμαστε στο Share mode και επιλέγουμε Create Link από το Property 

Inspector. 

3.2.2 Κοινοποίηση design και prototypes (Share design and prototypes) 252 

Αρχικά, θα γίνει μια συνοπτική αναφορά στα flows ή διαφορετικά στις ροές. 

Μπορείτε να μοιραστείτε το εκάστοτε design με πολλαπλές ροές, με διαφορετική 

έκδοση  αν αυτό εξυπηρετεί στην καλύτερη κατανόηση. Αφού λοιπόντα flows είναι 

συνδεδεμένα με το έγγραφο σχεδίασης, στην συνέχεια θα παρουσιαστεί ο τρόπος 

κοινής χρήσης των σχεδίων με έναν άλλον ενδιαφερόμενο, όπως για παράδειγμα έναν 

συνεργάτη.  

Share multiple flows 

1. Σε λειτουργία Share, παρουσιάζονται όλα τα flows που ορίζονται στο έγγραφο 

να εμφανίζονται.  

2. Επιλέξτε οποιαδήποτε από τα καθορισμένα flows και ορίστε τις απαιτούμενες 

ρυθμίσεις πρόσβασης, πριν τη δημοσίευση τους ως συνδέσμους. 

 
251 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
252 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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3. Όταν επιλέξετε ένα flow, το XD επισημαίνει αυτόματα όλα τα artboards σε 

αυτό το flow. 

4. Κάντε click στο Create a Link για τη δημιουργία ενός συνδέσμου με 

δυνατότητα κοινής χρήσης για τη ροή.  

 

3.2.3 Καθορισμόςδικαιωμάτωνπρόσβασης (Set access permissions for links) 

Στο Adobe XD, όταν πραγματοποιείται κοινή χρήση των προδιαγραφών σχεδίασης και των 

πρωτότυπων με τους ενδιαφερόμενους φορείς, χρησιμοποιούνται οι ενσωματωμένες 

προεπιλογές για τον καθορισμό των δικαιωμάτων πρόσβασης. Ο καθορισμός γίνεται 

μέσα από συνδέσμους: δημόσιους, ιδιωτικούς και κωδικού πρόσβασης.253 

● Δημόσιοι σύνδεσμοι: έχει πρόσβαση στον σύνδεσμο οποιοσδήποτε μπορεί να 

δει τις προδιαγραφές ή το πρωτότυπο κοινόχρηστης σχεδίασης. Αυτή η ρύθμιση 

πρόσβασης έχει τους λιγότερους περιορισμούς ασφαλείας, αλλά είναι χρήσιμη 

όταν μοιράζεστε τις προδιαγραφές σχεδίασης και τα πρωτότυπα σας με ένα 

ευρύ κοινό. 

● Ιδιωτικοί σύνδεσμοι: έχει μόνο το σύνολο των προσκεκλημένων συνεργατών 

πρόσβαση στην κοινόχρηστη προδιαγραφή σχεδίου ή πρωτότυπου. 

● Σύνδεσμοι κωδικού πρόσβασης: οι συνεργάτες πρέπει να εισαγάγουν τον 

κωδικό πρόσβασης, για να αποκτήσουν πρόσβαση στην κοινόχρηστη 

προδιαγραφή σχεδίου ή στο πρωτότυπο. 

 

Για τον ορισμό ενός συνδέσμου ως δημόσιο, ιδιωτικό ή προσβάσιμο με κωδικό 

πρόσβασης, από  το Property Inspector>Link Access> επιθυμητή επιλογή. 

 
253 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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Για την ενσωμάτωση του πρωτότυπου συνδέσμου σε μια ιστοσελίδα, χρησιμοποιήστε 

την επιλογή Copy Embed Code. 

 

 

3.3.4 Χρήση των prototypes 

Για την επίτευξη ενός περισσότερο ελεγχόμενου περιβάλλοντος για δοκιμές 

χρήστη σε πρωτότυπα με wire, παρέχεται η επιλογή της απόκρυψης των στοιχείων 

ελέγχου σελιδοποίησης και πλοήγησης στο πρωτότυπο web του χρήστη.254 

Εάν τα στοιχεία ελέγχου πλοήγησης είναι:255 

 
254 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
255 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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● Ενεργοποιημένα (προεπιλεγμένη ρύθμιση): η πρωτότυπη εφαρμογή web 

εμφανίζει τα κουμπιά Home, Back και Next. 

● Απενεργοποιημένα: τα πρωτότυπα στοιχεία ελέγχου πλοήγησης εφαρμογών 

ιστού και οι αριθμοί του artboard δεν είναι ορατοί. Μπορείτε να 

χρησιμοποιήσετε τα καθορισμένα hotspot για να αλληλεπιδράσετε με τα 

πρωτότυπα και να κάνετε click στο κουμπί Home page για να μεταβείτε στην 

αρχική οθόνη. Όταν ανοίγετε ένα πρωτότυπο σε ένα κινητό, μπορείτε  να 

προβάλετε την οθόνη ενσωμάτωσης, τα αριστερά/δεξιά όρια είναι κρυφά και η 

κίνηση ολίσθησης είναι απενεργοποιημένη. 

Προβολή πλέγματος (grid) 

Η προβολή πλέγματος (grid)  σε πρωτότυπα και σχεδιαστικές προδιαγραφές, 

διευκολύνει τους ενδιαφερόμενους ή τους προγραμματιστές να πλοηγηθούν γρήγορα 

στο πιο σχετικό artboard. Για εναλλαγή σε προβολή πλέγματος, κάντε click στο όνομα 

του συνδέσμου ή στο εικονίδιο πλέγματος στην πάνω δεξιά γωνία του κοινόχρηστου 

πρωτοτύπου. Στο grid view, υπάρχει δυνατότητα:256 

● προβολής της μικρογραφίας όλων των οθονών. 

● προβολής σχολίων σε ένα δεδομένο artboard. 

● αναζήτηση ενός συγκεκριμένου artboard με το όνομά του. 

● προβολή όλων των συνδεδεμένων οθονών για ένα δεδομένο artboard, κάνοντας 

click στο εικονίδιο της συνδεδεμένης οθόνης.  

3.2.5 Review prototypes 

Κατα την κοινή χρήση design, ο χρήστης αναμένει σχόλια και διορθώσεις για 

τα κοινοποιημένα design του. Τα σχόλια αυτά θα βρίσκονται καρφιτσωμένα στο design 

του. Αντίστοιχα, είναι και εκείνος σε θέση να προχωρήσει σε ανάλογο σχολιασμό, 

εφόσον του ζητηθεί. Η δυνατότητα προβολής όλων των σχολίων οθόνης στο Adobe 

XD κάνει  πολύ πιο εύκολη τη διαχείριση των σχολίων στα πρωτότυπα και τις 

προδιαγραφές σχεδίασης. Είναι εφικτή η προβολή του συνόλου των σχολίων σε λίστα. 

Είναι επίσης εφικτή, η απευθείας μεταφορά στο artboard που ανήκει ένα μεμονωμένο 

 
256 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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σχόλιο, κάνοντας click πάνω σε αυτό, προκειμένου να απαντηθεί, να επιλυθεί ή να 

διαγραφεί.   Ενεργοποιήστε το All Screen Comments στην κάτω αριστερή γωνία του 

πίνακα σχολίων, για να παραθέσετε τα σχόλια που προστέθηκαν σε πολλά artboards σε 

μία προβολή. Η εναλλαγή είναι ενεργοποιημένη από προεπιλογή σε δημοσιευμένες 

προδιαγραφές σχεδίασης ή σύνδεσμο πρωτοτύπου.257 

3.2.6 Work with design specs 

Η εργασία με design specs στο Adobe XD, συντελεί σημαντικό ρόλο στις ροές 

εργασίας σχεδιαστή και προγραμματιστή. Βοηθά στην εξοικονόμηση χρόνου και στην 

υλοποίηση αποτελεσματικότερης επικοινωνίας μεταξύ τους.258 

Design specs workflows259 

● Publish and Share: Το design specs δίνει τη δυνατότητα στους σχεδιαστές να 

μοιράζονται τις ιδιότητες σχεδίασης των αρχείων τους με τους 

προγραμματιστές. Οι σχεδιαστές μπορούν να παρέχουν στους προγραμματιστές 

βασικές πληροφορίες, όπως ύψος αντικειμένου, πλάτος, μέγεθος, στοίχιση, 

σχετική απόσταση μεταξύ δύο εικονιδίων (αντικείμενα), χρώματα, τυπογραφία, 

ιδιότητες συνδυασμού, αλληλεπιδράσεις ενεργοποίησης και αποσπάσματα 

κώδικα CSS. Ο σύνδεσμος προδιαγραφών σχεδίασης είναι εξατομικευμένος για 

προγραμματιστές. Οι σχεδιαστές δεν χρειάζεται να επισημαίνουν σε αυτόν, με 

συγκεκριμένο τρόπο, τα χαρακτηριστικά που ενδιαφέρουν τους 

προγραμματιστές. 

● Review:  Οι προγραμματιστές μπορούν να ελέγξουν το σχέδιο και να 

μοιραστούν σχόλια με τους σχεδιαστές. Ο σύνδεσμος είναι πάντα 

ενημερωμένος με τα τελευταία σχόλια. 

● Password and protect: Οι σχεδιαστές μπορούν να περιορίσουν την πρόσβαση 

στις προδιαγραφές του δημόσιου design, προσθέτοντας προστασία με κωδικό 

πρόσβασης. Μπορούν επίσης να προστατεύσουν με κωδικό πρόσβασης τις ήδη 

κοινές προδιαγραφές σχεδίασης.  

 
257 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
258 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
259 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
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● Privatelinks: Οι σχεδιαστές μπορούν να επιλέξουν να δημοσιεύσουν τις 

προδιαγραφές σχεδίασης ως ιδιωτικό σύνδεσμο και να προσκαλέσουν 

προγραμματιστές σε αυτόν, προς αποφυγή μη εξουσιοδοτημένης πρόσβασης. 

● Download assets: Οι σχεδιαστές μπορούν να επιλέξουν να συμπεριλάβουν 

στοιχεία ενώ δημοσιεύουν τις προδιαγραφές σχεδίασης και οι προγραμματιστές 

μπορούν να τα κατεβάσουν από τον κοινόχρηστο σύνδεσμο. 

3.2.7 Share design specs260 

● Κατα την κοινή χρήση design specs ως public links, χρησιμοποιήστε την 

επιλογή Copy Embed Code για την ενσωμάτωση του πρωτότυπου συνδέσμου 

σε έναν εξωτερικό ιστότοπο. 

● Κατα την κοινή χρήση design specs ως ασφαλή private links, υπάρχει 

δυνατότητα πρόσκλησης αναθεωρητών και ορισμού δικαιωμάτων, για 

περαιτέρω κοινή χρήση τους. Οι αναθεωρητές μπορούν να προσθέσουν, να 

αφαιρέσουν ή να αποδεχτούν αιτήματα από άλλο σύνολο αναθεωρητών που 

θέλουν να αποκτήσουν πρόσβαση ή να προβάλουν τον ασφαλή ιδιωτικό 

σύνδεσμο. 

● Κατα την κοινή χρήση design specs ως password links, υπάρχει δυνατότητα 

επίτευξης περιορισμένης πρόσβασης,  μέσω της προστασίας με κωδικό 

πρόσβασης. 

3.2.8 Έλεγχος (View and Inspect design specs) 

Το Design specs link ανοίγει σε Prototype mode από προεπιλογή. Για την λήψη 

πληροφοριών αναφορικά με τις ιδιότητες και τις προδιαγραφές, μεταβείτε στην 

καρτέλα προδιαγραφών σχεδίασης, κάνοντας click στο   εικονίδιο στη δεξιά ράγα. 

Για να μεταβείτε στην καρτέλα μεταβλητές, κάντε  click στο εικονίδιο {} . Αυτή η 

καρτέλα είναι διαθέσιμη όταν ο σχεδιαστής δημοσιεύει ένα design specs link για τον 

ιστό. Στη συνέχεια, αναλύεται ο τρόπος προβολής και αντιστοίχισης των 

χαρακτηριστικών σε design specs.261 

 
260 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
261 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Προβολή λεπτομερειών οθόνης 

Όταν κάνετε click έξω από ένα artboard, βρίσκεστε στην προβολή 

λεπτομερειών οθόνης. Σε αυτή την προβολή, μπορείτε να επιθεωρήσετε την οθόνη και 

διάφορες λεπτομέρειες, όπως επισημάνσεις αλληλεπίδρασης. 262 

Πατήστε και διατηρήστε πατημένο το πλήκτρο Shift, για προβολή των 

interaction highlights. Για να τα επιθεωρήσετε, πατήστε click με Shift στα interaction 

highlights. Κάντε click στα interaction highlights, για προβολή των λεπτομερειών στον 

πίνακα γραφικών, στο στυλ, στο σχέδιο και στο μέγεθος θύρας προβολής, στην θέση 

επικάλυψης (overlay position), στα χρώματα και στο στυλ χαρακτήρων. 263 

Προβολή λεπτομερειών επιπέδου 

Κατα την επιλογή ενός layer σε ένα artboard, μεταφέρεστε στην προβολή 

λεπτομερειών του layer. Στο Property Inspector, μπορείτε να προβάλετε το όνομα του 

layer και ιδιότητες όπως: ιδιότητες κειμένου (text properties), εμφάνιση (appearance), 

shapes, images, video και Lottie animations.264 

3.2.9 Πλοήγηση (Navigate design specs) 

265Για μια ολιστική άποψη της ροής του σχεδιασμού, με όλες τις πληροφορίες 

διάταξης του artboard, προτείνεται η  εναλλαγή μεταξύ των προβολών Grid και Flow.  

Η Grid view αποτελεί μια απλή μορφή πλέγματος των πληροφοριών διάταξης του 

artboard και  η Flow view διατηρεί τη διάταξη του πίνακα γραφικών και την 

αρχιτεκτονική του. Στο Grid view,  παρέχεται δυνατότητα: 

● Προβολής της μικρογραφίας όλων των οθονών, 

● Προβολής του αριθμού των σχολίων σε ένα δεδομένο artboard, 

● Αναζήτησης ενός συγκεκριμένου artboard με το όνομά του και 

● Προβολής των συνδεδεμένων οθονών για ένα δεδομένο artboard. 

 
262 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
263 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
264 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
265 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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 Στο  Flow view,  παρέχεται δυνατότητα:266 

● Επικοινωνίας με το layout και με το design και 

● προβολής των συνδεδεμένων artboards, με την τοποθέτηση του δείκτη του 

ποντικιού πάνω από ένα artboard. 

3.2.10 Export design assets 

Μπορείτε να εξάγετε στοιχεία, όπως εικόνες bitmap, εικονίδια και μοτίβα 

φόντου, κείμενο και artboards από XD σε PNG, SVG, JPG και PDF. Αυτά τα 

εξαγόμενα στοιχεία έχουν βελτιστοποιηθεί για ανάπτυξη σε iOS, Android ή εφαρμογές 

ιστού. Για την επιλογή στοιχείων ή artboards, για εξαγωγή, επιλέξτε ένα αντικείμενο ή 

ένα artboard και μεταβείτε στο File > Export. Σε Mac, μπορείτε εναλλακτικά να 

επιλέξετε τον συνδυασμό Cmd + E. 267 

Εξαγωγή ως PNG 

Επιλέξτε ένα κοινό μέγεθος εξαγωγής ή για συγκεκριμένη πλατφόρμα ή ορίστε ένα 

προσαρμοσμένο μέγεθος εξαγωγής:268 

● Προκαθορισμένο ή προσαρμοσμένο μέγεθος εξαγωγής: Επιλογή από τα 

προκαθορισμένα μεγέθη εξαγωγής: 0,5 x, 1 x, 1,5 x, 2 x, 3 x, 4x. Υπάρχει επίσης 

δυνατότητα εισαγωγής προσαρμοσμένου μεγέθους εξαγωγής, που να ξεκινάει 

από 0,5 x έως 10 x.  

● Ιστός: Τα στοιχεία εξάγονται σε αναλύσεις 1 x και 2 x. 

● iOS: Τα στοιχεία εξάγονται σε αναλύσεις 1 x, 2 x και 3 x. 

● Android: Τα στοιχεία σχεδίασης βελτιστοποιούνται και εξάγονται για τις 

ακόλουθες αναλύσεις οθόνης Android:  ldpi – Χαμηλή ανάλυση (75%) , mdpi 

– Μεσαία ανάλυση (100%), hdpi – Υψηλή ανάλυση (150%), xhdpi - 

 
266 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
267 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
268 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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Εξαιρετικά υψηλή ανάλυση (200%), xxhdpi - Εξαιρετικά εξαιρετικά υψηλή 

ανάλυση (300%), xxxhdpi - Εξαιρετικά εξαιρετικά υψηλή ανάλυση (400%) 

Εξαγωγή ως SVG 

Κατα την εξαγωγή αντικειμένων ή artboards ως SVG, μπορείτε να ορίσετε το 

οπτικό στυλ σε: Χαρακτηριστικά παρουσίασης (Presentation Attributes)  ή 

Εσωτερικό (Internal CSS) . 269 

● Χαρακτηριστικά παρουσίασης : Χρησιμοποιεί ξεχωριστά χαρακτηριστικά 

XML για κάθε μεμονωμένη ιδιότητα στυλ σε κάθε ετικέτα SVG. Αυτή η μορφή 

απαιτείται για τη χρήση στοιχείων SVG με το Android Studio. 

● Εσωτερικό CSS : Χρησιμοποιεί μια ενιαία ετικέτα στυλ με κλάσεις CSS και 

μοιράζεται τις ρυθμίσεις στυλ μεταξύ αντικειμένων με τα ίδια στυλ που 

οδηγούν σε μικρότερα μεγέθη αρχείων. 

Μπορούμε να τις αποθηκεύσουμε ως ενσωματωμένες ή συνδεδεμένες εικόνες.270 

● Ενσωμάτωση (Embed): Η εικόνα bitmap κωδικοποιείται στο αρχείο SVG. 

● Σύνδεσμος (Link): Η εικόνα bitmap  αποθηκεύεται χωριστά με αναφορά στο 

αρχείο SVG. 

Εξαγωγή ως PDF 

● Μεμονωμένο αρχείο PDF: Δυνατότητα επιλογής πολλών artboards ή 

στοιχείων και εξαγωγής ως ένα αρχείο PDF.  

● Πολλαπλά αρχεία PDF : Δυνατότητα επιλογής πολλών artboards ή στοιχείων 

και εξαγωγής ως μεμονωμένων αρχείων PDF. Δημιουργούνται ξεχωριστά 

αρχεία PDF για καθένα από τα επιλεγμένα στοιχεία ή artboard. 

Εξαγωγή ως JPG 

Κατα την εξαγωγή στοιχείου ως JPG, υπάρχει δυνατότητα καθορισμού του 

επιπέδου ποιότητας του εξαγόμενου JPG από τη λίστα Quality. Στη συνέχεια, επιλέξτε 

 
269 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
270 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
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ένα κοινό μέγεθος εξαγωγής ή για συγκεκριμένη πλατφόρμα ή ορίστε ένα 

προσαρμοσμένο μέγεθος εξαγωγής:271 

● Προκαθορισμένο ή προσαρμοσμένο μέγεθος εξαγωγής/ Preset or custom 

export size:  Τα προκαθορισμένα μεγέθη εξαγωγής: 0,5 x, 1 x, 1,5 x, 2 x, 3 x, 

4x. Δυνατότητα εισαγωγής προσαρμοσμένων μεγεθών εξαγωγής που ξεκινούν 

από 0,5 x έως 10 x. 

● Web:  Τα στοιχεία εξάγονται σε αναλύσεις 1 x και 2 x. 

3.2.11 Export and download assets from design specs  

Είναι εφικτή η λήψη του συνόλου των στοιχείων σε ενα artboard ταυτόχρονα, 

στην προβολή λεπτομερειών οθόνης. Είναι επίσης εφικτή η λήψη στοιχείων 

μεμονωμένα, στην προβολή  λεπτομερειών επιπέδου.272 

Όταν κάνετε click έξω από ένα artboard, βρίσκεστε στο Screen details. Βλέπετε 

όλα τα στοιχεία με δυνατότητα λήψης, που κατηγοριοποιούνται ως εικόνες, βίντεο, 

κινούμενα σχέδια και ήχος, στην ενότητα Assets του Property Inspector. Για την λήψη 

στοιχείων στην ενότητα Assets:273 

Κάντε click, για την επιλογή των στοιχείων που θέλετε να λάβετε μαζί. 

● Για πολλαπλή επιλογή, χρησιμοποιήστε το  Shift. 

● Για επιλογή όλων των στοιχείων μιας κατηγορίας στοιχείων, κάντε click σε ένα 

στοιχείο και πατήστε Cmd +  A (για Mac) ή  Ctrl + A (για Windows). 

Εμφανίζεται το Assets selected, που δείχνει τον αριθμό των επιλεγμένων στοιχείων. 

Τέλος, επιλέξτε το Download.  

Προβολή λεπτομερειών επιπέδου 

Όταν επιλέγετε ένα layer σε ένα artboard, μεταβαίνετε στην προβολή 

λεπτομερειών επιπέδου. Εκεί είναι εφικτή η λήψη στοιχείων μόνο για το επιλεγμένο 
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επίπεδο. Για την λήψη ενός στοιχείου στο επιλεγμένο επίπεδο, κάντε click στην 

επιλογή Download, δίπλα στο στοιχείο, στα Assets του Property Inspector.274 

Download video 

Κατα την επιλογή ενός βίντεο σε ένα artboard:275 

● Μπορείτε να κατεβάσετε το βίντεο και πρώτη εικόνα του βίντεο (thumbnail). 

● Εάν το βίντεο είναι ανεξάρτητο με την αναπαραγωγή ήχου, μπορείτε επίσης να 

κάνετε λήψη αυτού του αρχείου ήχου. 

Download Lottie 

Κατα την επιλογή ενός επιπέδου Lottie σε ένα artboard:276 

● Μπορείτε να κάνετε λήψη της κινούμενης εικόνας Lottie ως αρχείο JSON. 

● Εάν το Lottie είναι ανεξάρτητο με την αναπαραγωγή ήχου, μπορείτε επίσης να 

κάνετε λήψη αυτού του αρχείου ήχου. 
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4. DESIGN SYSTEMS 

4.1 Design Systems with Creative Cloud Libraries 

Τα συστήματα σχεδίασης με βιβλιοθήκες creative cloud, μπορεί να είναι απίστευτα 

εύχρηστα για τη διασφάλιση ότι όλα τα μέλη μιας ομάδας χρησιμοποιούν πάντα τα πιο 

πρόσφατα στοιχεία σχεδιασμού, για τη δημιουργία συνεκτικών και συνεπών εμπειριών 

στο σύνολο των έργων.  Μπορεί να γίνει χρήση των συστημάτων σχεδιασμού: 277 

● Για τη δημιουργία εγγράφων cloud που περιέχουν επαναχρησιμοποιήσιμα 

χρώματα, στυλ χαρακτήρων και στοιχεία  που καθορίζουν τα συστήματα 

σχεδιασμού. 

● Για τη δημοσίευση Creative Cloud Libraries από αυτά τα έγγραφα cloud, για 

την κοινή χρήση επαναχρησιμοποιήσιμων στοιχείων με την ομάδα, δίνοντας 

κατα αυτόν τον τρόπο στην ομάδα, την ικανότητα σχεδίασης έργων.  

● Για τη διαχείριση ενημερώσεων από ένα κεντρικό σύστημα, ώστε όλοι να 

χρησιμοποιούν τα πιο πρόσφατα στοιχεία. 

● Για την εκμετάλλευση των στοιχείων του συστήματος σχεδίασής στις ροές 

εργασιών. Από σχέδια εκτύπωσης, επωνυμίας και μάρκετινγκ έως 

παρουσιάσεις και εξασφαλίσεις, μέσω της ενοποίησης βιβλιοθηκών με τις 

δημιουργικές εφαρμογές cloud της Adobe και τις σουίτες παραγωγικότητας της 

Microsoft, όπως το Microsoft Word, το PowerPoint και επεκτάσεις τρίτων, 

όπως το πρόσθετο Visual Studio. 

4.2 Εργασία με στοιχεία εγγράφων στο Adobe XD 

Το Document Assets αποτελεί την κεντρική τοποθεσία από όπου μπορείτε να 

δημιουργήσετε, να διαχειριστείτε και να μοιραστείτε χρώματα, στυλ χαρακτήρων, 

στοιχεία και στοιχεία ήχου που χρησιμοποιούνται στα design σχεδίασης.278 
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Προσθήκη στυλ σχεδίασης 

Για την επιμέλεια των στυλ σχεδίασης και των στοιχείων, κάντε click στο 

Libraries  στη γραμμή εργαλείων. Εναλλακτικά, πατήστε Cmd + Shift + Y (για 

Mac) ή Ctrl + Shift + Y (για Windows), για άνοιγμα του πίνακα Document Assets  

.279 

Προσθήκη χρωμάτων 

Επιλέξτε ένα αντικείμενο σε καμβά και κάντε click στο εικονίδιο + δίπλα στην  

επιλογή Colors, στον πίνακα Document Assets. Το XD εξάγει τα χρώματα γεμίσματος 

και περιγράμματος που σχετίζονται με το επιλεγμένο αντικείμενο.280 

Προσθήκη στυλ χαρακτήρων 

Επιλέξτε κείμενο σε καμβά και κάντε click στο εικονίδιο + δίπλα στα 

Character Styles, στον πίνακα Document Assets. 281 

Προσθήκη στοιχείων 

Επιλέξτε ένα αντικείμενο σε καμβά και κάντε click στο εικονίδιο + δίπλα στο 

Components, στον πίνακα Document Assets, έτσι ώστε να μετατραπεί σε στοιχείο. 

Κατα τη δημιουργία ενός στοιχείου σε καμβά, το XD το προσθέτει αυτόματα στα 

Components στον πίνακα Document Assets.282 

Προσθήκη ήχου 

Τα αρχεία ήχου που προστέθηκαν σε ένα πρωτότυπο στο Property Inspector, 

στη λειτουργία Prototype, εμφανίζονται αυτόματα στα στοιχεία του εγγράφου.283 
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Προσθήκη βίντεο 

Επιλέξτε ένα βίντεο σε καμβά και κάντε click στο εικονίδιο + δίπλα στην 

επιλογή Video,  στον πίνακα Document Assets. Κατα την μετατροπή σε στοιχείο, το 

βίντεο προστίθεται και στα Components αλλά και στα video, στον πίνακα Document 

Assets.284 

Εφαρμογή και επαναχρησιμοποίηση στοιχείων ενεργητικού εγγράφου 

Αφου καταστεί εφικτή η προβολή των προστιθέμενων στοιχείων από το 

Document Assets, επιλέξτε ένα αντικείμενο ή μια ομάδα αντικειμένων στο artboard και 

κάντε click στο χρώμα ή το στυλ χαρακτήρων, για την εφαρμογή του. Για την χρήση 

ενός ή περισσότερων στοιχείων στο σχέδιο, αφού τα επιλέξετε στο πλαίσιο Document 

Assets, σύρετέ τα στον καμβά. Τα στιγμιότυπα αυτών των στοιχείων θα δημιουργηθούν 

σε καμβά.285 

Επαναχρησιμοποίηση χρώματος 

Επιλέξτε ένα αντικείμενο ή ένα layer κειμένου και κάντε click στο δείγμα 

χρωμάτων, για την εφαρμογή του ως χρώμα γεμίσματος. Κάντε δεξί click σε ένα δείγμα 

χρώματος από τα Document Assets και επιλέξτε Apply border color, για την 

εφαρμογή του ως χρώμα περιγράμματος. Αντιγράψτε την τιμή Hex, για 

επαναχρησιμοποίηση.286 

Επαναχρησιμοποίηση στυλ χαρακτήρων 

Επιλέξτε ένα layer κειμένου ή ένα μέρος του κειμένου και κάντε click στο 

character style, για την εφαρμογή του. Υπάρχει δυνατότητα πολλαπλής επιλογής 

αντικειμένων και εφαρμογής στυλ χαρακτήρων σε μια επιλογή.287 
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Επαναχρησιμοποίηση components 

Σύρετε το στοιχείο από τα Documents Assets στον καμβά. Υπάρχει δυνατότητα 

πολλαπλής επιλογής αντικειμένων και μεταφοράς πολλαπλών στοιχείων στον καμβά. 

Όταν σύρετε ένα στοιχείο, μπορείτε να τοποθετήσετε το δείκτη του ποντικιού πάνω 

από ένα άλλο στιγμιότυπο στοιχείου, για να το αλλάξετε. 288 

Επεξεργασία στοιχείων εγγράφου 

Για την επεξεργασία στοιχείων εγγράφου, προτείνεται αρχικά να βεβαιωθείτε ότι 

επεξεργάζεστε το σωστό στοιχείο. Στην συνέχεια: 289 

● Κάντε δεξί click στο στοιχείο στα Document Assets και επιλέξτε Highlight on 

Canvas για εύρεση του συνόλου των αντικειμένων που χρησιμοποιούν αυτό το 

χρώμα ή το στυλ χαρακτήρων ή για εύρεση των παρουσιών ενός στοιχείου. 

● Επιλέξτε οποιοδήποτε αντικείμενο στον καμβά, κάντε δεξί click και στην 

συνέχεια Reveal components in Assets  για να εντοπίσετε αυτό το χρώμα, το 

στυλ χαρακτήρα ή το στοιχείο. 

Επεξεργασία χρωμάτων 

Κάντε δεξί click σε ένα δείγμα χρώματος και επιλέξτε Edit, για την 

τροποποίηση της τιμής  χρώματος σε όλο το έγγραφο. Όλα τα αντικείμενα στον καμβά 

που χρησιμοποιούν αυτό το χρώμα, ενημερώνονται σε πραγματικό χρόνο. Αυτός είναι 

ένας πολύ καλός τρόπος για να πραγματοποιήσετε προεπισκόπηση μιας αλλαγής 

χρώματος σε κλίμακα και να προχωρήσετε σε αλλαγές.290 

Επεξεργασία στυλ χαρακτήρων 

Κάντε δεξί click σε ένα στυλ χαρακτήρων και επιλέξτε Edit, για την 

τροποποίηση αυτού του στυλ στο σύνολο του εγγράφου. Όλα τα επίπεδα κειμένου στον 

καμβά που χρησιμοποιούν αυτό το στυλ, ενημερώνονται σε πραγματικό χρόνο.291 
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Επεξεργασία στοιχείων 

Κάντε δεξί click στο στοιχείο σε καμβά ή στον πίνακα Document Assets. 

Επιλέξτε  Edit Main Component,  για επισήμανση του κύριου στοιχείου στον καμβά 

ή για την επαναδημιουργία του σε περίπτωση διαγραφής.Οποιεσδήποτε αλλαγές 

πραγματοποιούνται στο κύριο στοιχείο, μεταδίδονται σε άλλες παρουσίες στοιχείων.292 

4.3 Χρήση των Creative Cloud Libraries στο XD 

Δημοσίευση και κοινή χρήση συνδεδεμένων βιβλιοθηκών 

Για τη δημιουργία και τη διανομή ενός design system μέσω libraries, πρώτο 

βήμα αποτελεί η επιμέλεια των στοιχείων του συστήματος σχεδίασης (δηλαδή τα 

χρώματα, το στυλ χαρακτήρων και τα στοιχεία) στο Document Assets.293 

Μόλις οριστούν τα στοιχεία του συστήματος σχεδίασης, θα δημοσιεύσετε αυτά 

τα στοιχεία ως βιβλιοθήκη, συνδεδεμένη με το έγγραφο προέλευσης. Έτσι είστε σε 

θέση να τα μοιραστείτε με την ομάδα σας, για συνεπή επαναχρησιμοποίηση τους σε 

όλα τα έργα XD και σε άλλες εφαρμογές Creative Cloud. Για τη δημοσίευση μιας 

συνδεδεμένης βιβλιοθήκης (linked library), ακολουθήστε τα εξής βήματα:294 

1. Κάντε click στο Libraries, στη γραμμή εργαλείων και ανοίξτε το Document 

Assets. 

2. Κάντε click στο εικονίδιο του Publish, για πρόσβαση στη Διαχείριση 

βιβλιοθηκών.   

3. Στο Manage Libraries, κάντε click στηνεπιλογή Public. Εναλλακτικά, κάντε 

click στο Create new και στην επιλογή Publish linked library. 

Για τη δημοσίευση μιας βιβλιοθήκη ομάδας (a team library), ακολουθήστε τα 

παρακάτω βήματα:295 

1. Ανοίξτε το Library Manager. 

2. Επιλέξτε Create new > Create empty library ή Publish linked library. 
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3. Επιλέξτε τον χώρο της ομάδας και δημοσιεύστε τη βιβλιοθήκη της ομάδας. 

 

 

Κοινή χρήση μιας βιβλιοθήκης 

Μόλις δημοσιεύσετε τη βιβλιοθήκη, εμφανίζεται το παράθυρο του Share, το οποίο 

εξυπηρετεί στην πρόσκληση των μελών μιας ομάδας.Στη συνέχεια: 296 

● Κάντε click στο Share και προσθέστε τα μέλη της ομάδας, με τα οποία θέλετε 

να μοιραστείτε τη βιβλιοθήκη. 

● Η ρύθμιση του δικαιώματος Can edit, επιτρέπει στα μέλη της ομάδας τη 

δημοσίευση νέων ενημερώσεων στη βιβλιοθήκη. Η ρύθμιση του δικαιώματος 

Can view, επιτρέπει στα μέλη της ομάδας την χρήση του περιεχομένου της 

βιβλιοθήκης, αλλά δεν τους επιτρέπει να ενημερώσουν ή να τροποποιήσουν τη 

βιβλιοθήκη. 

➔ Τι γίνεται αν οι συνεργάτες μας δεν έχουν δικαιώματα;  

Μπορεί να υπάρχει μόνο μία συνδεδεμένη βιβλιοθήκη για ένα έγγραφο cloud. Έτσι, 

αν δεν προσκαλέσουμε έναν συνεπεξεργαστή εγγράφων στη βιβλιοθήκη μας, ο 

συνεπεξεργαστής μπορεί να δημοσιεύσει μια νέα βιβλιοθήκη από το ίδιο έγγραφο 

χωρίς να γνωρίζει ότι υπάρχει ήδη βιβλιοθήκη. Όταν ο συνεπεξεργαστής δημοσιεύει 
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μια νέα βιβλιοθήκη, αυτή συνδέεται με το έγγραφο και η αρχική βιβλιοθήκη σας 

αποσυνδέεται. 297 

Εάν προσκαλέσουμε έναν συνεπεξεργαστή στη βιβλιοθήκη με Can view , ο 

συνεπεξεργαστής δεν θα έχει επιλογή ενημέρωσης της βιβλιοθήκης.298 

➔ Πώς χρησιμοποιούμε βιβλιοθήκες αφού έχουμε αποδεχτεί την πρόσκληση 

τους; 

Τα βήματα είναι τα εξής: 299 

1. Βρίσκουμε την κοινόχρηστη βιβλιοθήκη μας. 

2. Χρησιμοποιούμε στοιχεία από την κοινόχρηστη βιβλιοθήκη. 

3. Μπορούμε να εφαρμόσουμε χρώματα ή στυλ χαρακτήρων σε αντικείμενα ή 

στοιχεία σε καμβά και να σύρουμε στοιχεία σε καμβά που γίνονται 

συνδεδεμένα στοιχεία. 

4. Πραγματοποιούμε προβολή συνδεδεμένων στοιχείων στο έγγραφό μας. 

Μεταβαίνουμε στην προβολή του πίνακα Documents Assets που εμφανίζει όλα 

τα τοπικά και συνδεδεμένα στοιχεία που χρησιμοποιούνται από μία ή πολλές 

βιβλιοθήκες. 

Προεπισκόπηση και αποδοχή ενημερώσεων βιβλιοθήκης300 

1. Πραγματοποιήστε προεπισκόπηση ενημερώσεων από το Document Assets ή 

από τον καμβά σχεδίασης. Τοποθετήστε το δείκτη του ποντικιού πάνω από το 

μπλε εικονίδιο ενημέρωσης   σε συνδεδεμένα χρώματα, στυλ χαρακτήρων 

και στοιχεία. 
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2. Ενημερώστε όλα τα συνδεδεμένα χρώματα, τα στυλ χαρακτήρων και τα 

στοιχεία του εγγράφου. Κάντε click στο μπλε εικονίδιο ενημέρωσης ή κάντε 

click στην επιλογή Update στο κάτω μέρος. 

Αναζήτηση και φιλτράρισμα στοιχείων301 

Κάτω από το Document Assets βρίσκεται  η γραμμή αναζήτησης φίλτρων. 

Το XD παρέχει τους παρακάτω τρεις μηχανισμούς φιλτραρίσματος, για περιορισμό 

των στοιχείων που θέλετε να χρησιμοποιήσετε στο έργο σας: 

● Τύπος στοιχείου (Asset type): Φιλτράρετε κατά τύπους στοιχείων (χρώματα, 

στυλ χαρακτήρων ή στοιχεία) που θέλετε να δείτε. 

● Τοπικά στοιχεία (Local assets): Εάν θέλετε να χρησιμοποιήσετε μόνο τα 

στοιχεία τοπικού εγγράφου, επιλέξτε το φίλτρο τοπικών στοιχείων. 

● Πηγή συνδεδεμένων στοιχείων (Linked assets source): Εάν έχετε συνδέσει 

στοιχεία από πολλά έγγραφα cloud ή βιβλιοθήκες και θέλετε να 

χρησιμοποιήσετε στοιχεία από μια συγκεκριμένη πηγή, επιλέξτε την επιθυμητή 

βιβλιοθήκη ή το συνδεδεμένο έγγραφο προέλευσης από το φίλτρο. 

 Χρήση στοιχείων από βιβλιοθήκες που έχουν δημιουργηθεί σε εφαρμογές Creative 

Cloud 

Το XD διευκολύνει στη χρήση στοιχείων που έχουν δημιουργηθεί σε 

διαφορετικές εφαρμογές Creative Cloud, όπως το Photoshop και το Illustrator. Είτε 

δημιουργήσετε μια εμπνευσμένη βιβλιοθήκη με μια συλλογή γραφικών, είτε με εικόνες 

Adobe Stock, είτε μια βιβλιοθήκη με μια συλλογή επαναχρησιμοποιήσιμων χρωμάτων 

και στυλ χαρακτήρων που δεν συνδέονται με ένα έγγραφο προέλευσης, μπορείτε να 

χρησιμοποιήσετε ξανά αυτά τα στοιχεία στο XD.302 

Όταν σύρετε γραφικά από βιβλιοθήκες στα design, μετατρέπονται σε 

συνδεδεμένα γραφικά που υποδεικνύονται από το σήμα. Οποιεσδήποτε τροποποιήσεις 

 
301 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World 

Journal of Research and Review (WJRR), 12(6), 41-45. 
302 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World 

Journal of Research and Review (WJRR), 12(6), 41-45. 
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πραγματοποιούνται σε αυτό το συνδεδεμένο γραφικό στο Photoshop ή το Illustrator, 

ενημερώνουν αυτόματα όλες τις συνδεδεμένες παρουσίες γραφικών στο design. Για 

την αποσύνδεση ενός συνδεδεμένου γραφικού, κάντε click στο σήμα του συνδέσμου ή 

χρησιμοποιήστε  το μενού περιβάλλοντος. 303 

4.4 Μετεγκατάσταση από linked assets σε creative cloud libraries 

Η μετεγκατάσταση των ήδη συνδεδεμένων στοιχείων, στα Creative Cloud 

Libraries, πραγματοποιείται μέσα σε μερικά μόλις βήματα.  Αρχικά, είναι σημαντικό 

να βεβαιωθείτε ότι έχετε ενημερώσει την ομάδα με την οποία εργάζεστε σχετικά, ώστε 

να μην προχωρήσει σε αλλαγές στο έγγραφο προέλευσης ή στα έγγραφα που 

χρησιμοποιούν κατά τη διάρκεια αυτής της περιόδου. Η μετεγκατάσταση του 

συστήματος σχεδίασής, θα διαρκεί μόνο μερικά λεπτά. Τα βήματα είναι τα εξής: 304 

1. Αποθήκευση του εγγράφου προέλευσης, ως έγγραφο cloud. 

2. Προετοιμασία του εγγράφου, για να δημοσιεύσετε μια βιβλιοθήκη. Πριν 

δημοσιεύσετε μια βιβλιοθήκη, προτείνεται να βεβαιωθείτε ότι το έγγραφο cloud 

δεν περιέχει αντίγραφα στοιχείων από άλλο τοπικό έγγραφο ή έγγραφο cloud. 

Εάν συμβαίνει κάτι τέτοιο, φροντίστε είτε να τα μετατρέψετεε σε local asset 

είτε να τα καταργήσετε  πριν τη δημοσίευση μιας βιβλιοθήκης. Οι ενέργειες 

αυτές, διασφαλίζουν ότι η βιβλιοθήκη που δημοσιεύεται περιέχει στοιχεία από 

ένα μόνο έγγραφο αντί να παραπέμπει σε πολλά έγγραφα. 

3. Πρόσβαση στον διαχειριστή βιβλιοθηκών (Libraries manager). Εκεί 

μπορείτε να δημοσιεύσετε το σύστημα σχεδίασής σας, καθώς και να 

προωθήσετε ενημερώσεις, κατα την πραγματοποίηση αλλαγών στο έγγραφο. 

4. Δημοσίευση της βιβλιοθήκης. 

5. Πρόσκληση άλλων, για χρήση και συνεισφορά στη βιβλιοθήκη.  
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Χρήστης με δικαιώματα επεξεργασίας 

Εάν προσκαλέσετε έναν χρήστη με δικαιώματα επεξεργασίας, μπορεί να 

χρησιμοποιήσει και να κάνει αλλαγές στη βιβλιοθήκη. Για να κάνει αλλαγές  πρέπει να 

έχει πρόσβαση επεξεργασίας στη βιβλιοθήκη και στο έγγραφο cloud. Φροντίστε να 

προσκαλέσετε τον χρήστη στο έγγραφο cloud, για επεξεργασία.305 

6. Αποδοχή της πρόσκλησης στη βιβλιοθήκη. Κατόπιν αποδοχής της 

πρόσκλησης, δίνεται δυνατότητα πρόσβασης στη βιβλιοθήκη από το XD. Είναι 

σημαντικό οποιοσδήποτε χρήστης που χρησιμοποιούσε προηγουμένως 

συνδεδεμένα στοιχεία από αυτό το έγγραφο, να αποδεχτεί την πρόσκληση στη 

βιβλιοθήκη, διαφορετικά τα στοιχεία θα εμφανίζονται με έναν κατεστραμμένο 

σύνδεσμο που αντιπροσωπεύεται με κόκκινο σήμα.  

7.  Δοκιμή του συστήματος σχεδίασης. Ένας εύκολος τρόπος για τον έλεγχο της 

μετεγκατάστασης των συνδεδεμένων στοιχείων σε μια βιβλιοθήκη, είναι να 

ανοίξετε οποιοδήποτε έγγραφο περιέχει αυτά τα συνδεδεμένα στοιχεία. Εάν ο 

χρήστης αυτού του εγγράφου έχει αποδεχτεί την πρόσκληση σε αυτήν τη 

βιβλιοθήκη, τα συνδεδεμένα στοιχεία θα πρέπει τώρα να αναφέρονται στη νέα 

βιβλιοθήκη. Εάν δεν είναι, τότε θα εμφανιστεί με ένα κόκκινο σήμα που 

υποδηλώνει ότι δεν μπορεί να ανοιχτεί ή να χρησιμοποιηθεί . Στη συνέχεια, θα 

ζητήσετε από οποιονδήποτε χρήστη με δικαιώματα επεξεργασίας στη 

βιβλιοθήκη, να κάνει μια αλλαγή και να δημοσιεύσει μια ενημέρωση στη 

βιβλιοθήκη. Εάν άλλοι χρήστες δουν μια ενημέρωση στο πλαίσιο της 

βιβλιοθήκης τους, αυτό σημαίνει ότι έχετε ρυθμίσει με επιτυχία το σύστημα 

σχεδίασής σας με τις βιβλιοθήκες. 

4.5 Χρήση των design tokens 

Μπορούμε να δημιουργήσουμε design tokens για ένα νέο artboard ή για ένα 

υπάρχον όπου έχουμε ήδη προσθέσει χρώματα και στυλ χαρακτήρων.  Σε Design 

mode θα μεταβούμε στον πίνακα Assets και θα κάνουμε click  στο +  για να δούμε τα 
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χρώματα και τα στυλ χαρακτήρων. Στη συνέχεια, θα κάνουμε διπλό click στο 

προεπιλεγμένο όνομα για το στοιχείο και θα πληκτρολογήσουμε ένα νέο όνομα. 306 

Κοινοποίηση design tokens307 

Σε  Share mode: 

1. Από το View Settings, επιλέξτε Development. Καλό θα είναι να γίνει 

έλεγχος, αν  είναι επιλεγμένο το  Export for Web, επειδή η δυνατότητα κοινής 

χρήσης συνδέσμων υποστηρίζεται μόνο σε συνδέσμους προδιαγραφών 

σχεδίασης που έχουν εξαχθεί για web. 

2. Κάντε click στο Create link και αντιγράψτε τον σύνδεσμο που δημιουργήθηκε. 

Μπορείτε  να τον μοιραστείτε με προγραμματιστές. 

Λήψη design tokens 

Για την λήψη των design tokens από έναν κοινό σύνδεσμο προδιαγραφών 

σχεδίασης, ανοίξτε τον κοινόχρηστο σύνδεσμο σε ένα πρόγραμμα περιήγησης και 

μεταβείτε στα αποσπάσματα κώδικα CSS ή επιλέξτε το εικονίδιο { }. Στη συνέχεια 

κάντε click  στην επιλογή Download CSS  για λήψη αυτών των μεταβλητών, ως 

αποσπάσματα κώδικα CSS που περιέχουν επίσης τα διακριτικά σχεδίασης. Αφού 

κάνετε λήψη των αποσπασμάτων, τα αντιγράφετε και τα επικολλάτε στον κώδικα 

υλοποίησης.308 

4.6 Χρήση πόρων από τα Creative Cloud Libraries 

Η Adobe XD διευκολύνει τους χρήστες στην χρήση στοιχείων που έχουν 

δημιουργηθεί σε διαφορετικές εφαρμογές Creative Cloud, όπως είναι το Photoshop και 

το Illustrator. Επιτρέπει εύκολα την κοινή χρήση στοιχείων μεταξύ αυτών των 

εφαρμογών και την αποθήκευση περιεχομένου όπως γραφικά, εικόνες, χρώματα και 
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στυλ κειμένου σε μια βιβλιοθήκη, η οποία συγχρονίζεται με τον λογαριασμό στο 

Creative Cloud.309 

Για την χρήση των Creative Cloud Libraries, προτείνεται να βεβαιωθείτε ότι 

έχετε συνδεθεί με το ίδιο αναγνωριστικό Adobe για όλες τις εφαρμογές CC.  Μπορείτε 

να χρησιμοποιήσετε οποιαδήποτε από τις ροές εργασίας, για να επαναχρησιμοποιήσετε 

στοιχεία μεταξύ του XD και άλλων εφαρμογών Creative Cloud: Επιλέξτε το στοιχείο 

που θέλετε να εισάγετε και σύρετε ή κάντε click στο + στον πίνακα Libraries CC, για 

την προσθήκη του στοιχείου. Στην συνέχεια, αντιγράψτε και επικολλήστε το στοιχείο 

σε XD. Κάντε  click στο Files>Open Libraries CC στο XD. Ρίχνετε και αφήνετε το 

στοιχείο του Photoshop ή του Illustrator στο έργο στο Adobe XD. Κάντε διπλό click 

στο στοιχείο, για την τροποποίηση και αποθήκευση των αλλαγών.  310 
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5. CLOUD DOCUMENTS 

5.1 Cloud documents in Adobe XD 

Τα έγγραφα cloud αποτελούν τον τύπο αρχείου εγγράφων της Adobe, στον 

οποίο η πρόσβαση μπορεί να είναι online ή και offline, απευθείας από το XD. Η 

αποθήκευση της εργασίας ως έγγραφο cloud, βοηθάει στην κοινή χρήση, τη 

συνεργασία και την πρόσβαση σε αυτή από πολλές συσκευές. 311 

Πλεονεκτήματα αποθήκευσης εγγράφων σε cloud312 

1. Προσβασιμότητα αρχείων από συσκευές. 

Αν το αρχείο αποθηκευτεί ως αρχείο cloud, τότε αυτόματα το αρχείο θα βρίσκεται σε 

κάθε κινητή συσκευή μέσω του λογαριασμού του εκάστοτε χρήστη στο cloud.                        

2. Συνεργασία και κοινή χρήση  αρχείων. 

Δυνατότητα επεξεργασίας και κοινής χρήσης των αρχείων, κάνοντας share, με σκοπό 

την αμεσότερη αλληλεπίδραση με κάποιον άλλο χρήστη.  

3. Απλή και αποδοτική αξιοποίηση πόρων. 

Χρησιμοποιώντας τους linked assets, παρέχεται η δυνατότητα κοινής χρήσης και 

επαναχρησιμοποίησης στοιχείων σχεδίασης, σε συστήματα σχεδίασης καθώς και η 

διασφάλιση συνέπειας του brand στα σχέδια μας.  

4. Εντοπισμός προηγούμενων εκδόσεων.  

Δυνατότητα διαχείρισης των αναθεωρήσεων στη σχεδίαση ή ακόμα προβολή 

οποιασδήποτε έκδοσης του εγγράφου, στο cloud. Η αυτόματη αποθήκευση διατηρεί 

έτοιμες τις προηγούμενες εκδόσεις. 

5. Εργασία χωρίς σύνδεση. 

Δυνατότητα εργασίας χωρίς σύνδεση, στα έγγραφα cloud. 

 

311 Figliolia, A. C., Sandnes, F. E., & Medola, F. O. (2020, November). Experiences using three app prototyping tools 
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Τα έγγραφα τα οποία βρίσκονται στην αρχική οθόνη XD και είναι διαθέσιμα για 

εργασία χωρίς σύνδεση, εμφανίζουν ένα πράσινο σημάδι. Η έκδοση χωρίς σύνδεση, 

συγχρονίζεται αυτόματα όταν γίνεται και η επανασύνδεση.  

6. Διατήρηση των τρεχόντων αρχείων. 

Δυνατότητα διατήρησης της εργασίας με τις τελευταίες ενημερώσεις, μέσα από τη 

λειτουργία αυτόματης αποθήκευσης και συνέχειας από το τελευταίο σημείο, σε 

οποιαδήποτε συσκευή.  

Πρόσβαση και οργάνωση εγγράφου στο cloud 

Τα έγγραφα cloud διασφαλίζουν, όπως ήδη αναφέρθηκε, ότι η εργασία 

ενημερώνεται πάντα, σε όλες τις συσκευές, με πλήρη πιστότητα. Μετά την 

αποθήκευση του αρχείου, ως έγγραφο cloud, μπορείτε να αποκτήσετε πρόσβαση στο 

αρχείο αυτό, μέσα από την καρτέλα «τα αρχεία σας» (Your Files), στην αρχική οθόνη 

XD ή στην ιστοσελίδα του Creative cloud.  313 
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Μπορείτε επίσης:314 

● ενεργοποιώντας το πλαίσιο ελέγχου δίπλα σε κάθε έγγραφο cloud, να επιλέξετε 

παραπάνω από ένα έγγραφο ταυτόχρονα. 

● κάνοντας click στα εικονίδια προβολής λίστας και προβολής grid, να επέμβετε 

στον τρόπο με τον οποίο προβάλλονται τα έγγραφα. 

● να ανοίξετε, να μετονομάσετε, να διαγράψετε, ακόμη και να μετακινήσετε τα 

έγγραφα clouds μέσα σε φακέλους. 

Διαφορά μεταξύ εγγράφων cloud και άλλων αρχείων creative cloud 

Το creative cloud πλάνο, περιλαμβάνει διαφορετικούς τύπους χώρου 

αποθήκευσης στο cloud, όπως έγγραφα cloud, βιβλιοθήκες (libraries) και αρχεία 

creative cloud (συγχρονισμένα αρχεία). Αυτά έχουν διαφορετικές χρήσεις και οφέλη.  

Cloud document 

Με τα έγγραφα cloud, η εργασία ενημερώνεται πάντα, όπου και αν βρίσκεστε 

και αποθηκεύεται αυτόματα. Η κοινόχρηστη μορφή για το Photoshop, το Photoshop 

στο iPad και το adobe Fresco, επιτρέπει την ομαλή μετακίνηση μεταξύ τους, ενώ τα 

έγγραφα XD cloud επιτρέπουν τη συνεργασία σε πραγματικό χρόνο. Η διαχείριση των 

εγγράφων cloud είναι εφικτή και απο την αρχική οθόνη της εφαρμογής μας ή στην 

ιστοσελίδα του Creative Cloud. 

Libraries   

Οι βιβλιοθήκες επιτρέπουν την συλλογή και την κοινή χρήση στοιχείων 

σχεδίασης (γραφικά, εικόνες, character style, πινέλα και παλέτες χρωμάτων). Η 

πρόσβαση σε αυτούς τους πόρους είναι εφικτή και από οποιαδήποτε εφαρμογή του 

Creative Cloud επιθυμείτε. Οι βιβλιοθήκες βοηθούν να διασφαλίσετε οτιδήποτε 

χρησιμοποιείτε εμείς και η ομάδα σας, σε έγγραφα και έργα. 
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Creative cloud files 

Τα αρχεία Creative cloud αποθηκεύονται στο cloud και είναι προσβάσιμα από 

οποιαδήποτε συνδεδεμένη συσκευή. Οι αλλαγές που γίνονται, συγχρονίζονται 

αυτόματα. Επισημαίνεται ότι τα αρχεία Adobe Fresco και Adobe Aero δεν 

υποστηρίζουν αρχεία creative cloud.315 

➔ Πως μπορούμε να επεξεργαστούμε τα σχέδια μας σε συνεργασία και να 

διαχειριστούμε τις αναθεωρήσεις της σχεδίασης;  

Το Adobe XD ενισχύει την ολοκληρωμένη συνεργασία σε κάθε βήμα της 

διαδικασίας σχεδιασμού, από την επεξεργασία σε πραγματικό χρόνο με άλλους 

σχεδιαστές μέχρι την εργασία με προγραμματιστές και σχεδιαστές για τη συλλογή 

σχολίων.  316 

Μπορούμε να κωδικοποιήσουμε σχέδια με συναδέλφους σχεδιαστές και 

ανάλογα με το ιστορικό του εγγράφου, να επιλύσουμε τυχόν διενέξεις που αφορούν 

την κωδικοποίηση. Επίσης, σε περίπτωση που βρισκόμαστε εκτός σύνδεσης, 

διακόπτεται προσωρινά η διαδικασία πραγματοποίησης αλλαγών στο κοινόχρηστο 

έγγραφο μας, για να αποφύγουμε τυχόν διενέξεις όταν συνδεθούμε αργότερα. 317 

Πρόσκληση για συνεργασία 

Η συνεργασία με συναδέλφους σχεδιαστές δεν ήταν ποτέ ευκολότερη. 

Μπορείτε να προσκαλέσετε τους συναδέλφους και συνεργάτες, για να έχουν 

ταυτόχρονη πρόσβαση και επεξεργασία του εγγράφου XD. Αποθηκεύοντας το σχέδιο, 

ως έγγραφο cloud, κάντε click στο invite document εικονίδιο. Στην συνέχεια, εισάγετε 

διευθύνσεις e-mail που σχετίζονται με τον λογαριασμό Adobe των συναδέλφων και 

 
315 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 
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κάντε click στην επιλογή Invite. Οι συνεργάτες ειδοποιούνται μέσω ηλεκτρονικού 

ταχυδρομείου ή creative cloud εφαρμογή του υπολογιστή.318 

Colored avatar 

Πρόκειται για ένα avatar των συναδέλφων σχεδιαστών, οι οποίοι 

επιδιορθώνουν το design σας. Αν η εικόνα προφίλ δεν έχει οριστεί από έναν σχεδιαστή, 

τότε το πρώτο γράμμα του πρώτου ονόματος, εμφανίζεται ως χρωματικό avatar. Σε 

περίπτωση που δεν έχει οριστεί όνομα προφίλ, εμφανίζεται μια κενή εικόνα προφίλ.319 

Bounding box 

Πρόκειται για το bounding box ή αλλιώς, το πλαίσιο οριοθέτησης, που ταιριάζει 

με το χρώμα του avatar το οποίο εμφανίζεται στο σχέδιο σας. Τοποθετήστε το δείκτη 

του ποντικιού πάνω από το πλαίσιο οριοθέτησης, για να δείτε τα ονόματα των 

προγραμμάτων επεξεργασίας που χρησιμοποιείτε. 320 

Real-time edits 

Πρόκειται για ταυτόχρονες αλλαγές, σε πραγματικό χρόνο, καθώς οι συντάκτες 

σας περιηγούνται και τροποποιούν τη σχεδίαση σας. 321 

Παρακολούθηση της θέσης των συνεργατών με ζωντανούς δρομείς 

Μπορείτε να παρακολουθήσετε τις ζωντανές αλλαγές των συναδέλφων σας σε 

κοινόχρηστα έγγραφα, με τη βοήθεια έγχρωμων avatars, τα οποία εμφανίζονται ως 

απομακρυσμένοι live cursor.  Επιλέξτε view > show / hide live cursor για την 

ενεργοποίηση ή την απενεργοποίηση αντίστοιχα της επιλογής Live Cursor. Από 

προεπιλογή, η επιλογή show live cursor είναι ενεργοποιημένη. Τοποθετώντας το 

δείκτη του ποντικιού πάνω από το live, προβάλλονται οι λεπτομέρειες του σχεδιαστή 

συναδέλφου. Οποιαδήποτε στιγμή, μπορείτε να ενημερωθείτε αν το πρόγραμμα 

επεξεργασίας κειμένου που χρησιμοποιείτε λειτουργεί στην ίδια θέση ενός 

κοινόχρηστου εγγράφου. Κάντε click στο avatar του προγράμματος επεξεργασίας, στη 
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γραμμή παρουσίας. Ο live cursor μεταπηδά στην τρέχουσα θέση του coeditor, στο 

κοινόχρηστο έγγραφο. Το remote live cursor αποτελείται από έναν ζωντανό δείκτη, ο 

οποίος αντιστοιχεί στη ζωντανή θέση του σχεδιαστή μας καθώς και ένα χρωματικό 

avatar, το οποίο είναι συγχρονισμένο με το προφίλ του σχεδιαστή που εμφανίζεται στη 

γραμμή παρουσίας.322 

Διαχείριση εκδόσεων εγγράφων 

Η διαχείριση των εκδόσεων του εγγράφου, πραγματοποιείται εύκολα μέσα από 

την προσθήκη ονομασίας, περιγραφής και κάνοντας χρήση της αναζήτησης και του 

φίλτρου:323 

● Για εκδόσεις εγγράφων της access: επιλέξτε δίπλα στο όνομα του εγγράφου, 

για την προβολή της λίστας  των προηγούμενων εκδόσεων. 

● Για την αποθήκευση εκδόσεων, την προσθήκη ονόματος και περιγραφής 

έκδοσης: από προεπιλογή, οι εκδόσεις ονομάζονται με βάση τις χρονικές 

σημάνσεις και αποθηκεύονται αυτόματα σε τακτά χρονικά διαστήματα. Οι 

αυτόματα αποθηκευμένες εκδόσεις, έχουν τη τάση να διαγράφονται από το 

cloud μετά από 60 ημέρες. Για την μετονομασία της έκδοσης εγγράφου και την 

προσθήκη μιας περιγραφής, πρέπει να επιλέξετε τις τρεις (3) κουκίδες δίπλα 

στη χρονική σήμανση και στην συνέχεια να επιλέξετε την επεξεργασία 

πληροφοριών έκδοσης. Όταν προσθέτετε όνομα και περιγραφή σε μία έκδοση, 

αν το αποθηκεύσετε μόνιμα, τότε θα διαπιστώσετε ότι με αυτό τον τρόπο, 

βελτιώνεται η δυνατότητα αναζήτησης του. 

● Εκδόσεις αναζήτησης και φιλτραρίσματος: για την αναζήτηση μιας έκδοσης 

εγγράφου, πληκτρολογήστε το όνομα της ή μία λέξη από την περιγραφή της. 

Εναλλακτικά, μπορείτε να κάνετε αναζήτηση, χρησιμοποιώντας τις εκδόσεις με 

σήμανση ή οποιαδήποτε από τις δεδομένες χρονικές σημάνσεις ως φίλτρο. 

● Προβολή έκδοσης: για την προβολή μιας έκδοσης, αρκεί να επιλέξετε τις τρεις 

(3) κουκίδες και στη συνέχεια να επιλέξετε το «άνοιγμα σε νέο παράθυρο». 
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Επισημαίνεται ότι η επαναφορά σε άλλη έκδοση, δεν είναι δυνατή. Ωστόσο, 

υπάρχει δυνατότητα αντιγραφής και επικόλλησης του περιεχομένου στη τρέχουσα 

έκδοση.324 

Αποθήκευση αντιγράφου για εργασία χωρίς σύνδεση 

Υπάρχει δυνατότητα να συνεχίσετε να εργάζεστε πάνω σε έγγραφα και εκτός 

σύνδεσης, με την προϋπόθεση ότι δεν πραγματοποιείται κοινή χρήση τους με άλλους. 

Οι αλλαγές που πραγματοποιούνται, συγχρονίζονται με την ηλεκτρονική έκδοση κάθε 

φορά που γίνεται η επανασύνδεση. Δεν μπορείτε ωστόσο να εργαστείτε χωρίς σύνδεση 

σε κοινόχρηστα έγγραφα, προς αποτροπή διενέξεων κατα την σύνδεση. Μπορείτε να 

αποθηκεύσετε ένα αντίγραφο και να εργαστείτε σε αυτό, αντιγράφοντας με μη 

αυτόματο τρόπο τις αλλαγές, τις φορές όπου υπάρχει πρόσβαση στο ηλεκτρονικό 

έγγραφο.325 

Ανάκληση πρόσβασης 

Η ανάκληση πρόσβασης γίνεται, καταργώντας το όνομα του προγράμματος 

επεξεργασίας από το αναδυόμενο παράθυρο «πρόσκληση σε έγγραφο».326 

Αποτροπή αντικατάστασης 

Αποφύγετε την επεξεργασία του ίδιου αντικειμένου με κάποιον άλλον 

σχεδιαστή, προς αποφυγή της ανάγκης αντικατάστασης. Το XD διατηρεί τις ενέργειες 

επεξεργασίας που φτάνουν πρώτα στον διακομιστή και απορρίπτονται άλλες 

αλλαγές.327 
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Συνεργασία σε κοινόχρηστα έγγραφα 

Σε κοινή χρήση με εσάς είναι τα έγγραφα XD, στα οποία έχετε προσκληθεί. 

Όταν ένας συνεργάτης, σας στέλνει μια πρόσκληση, λαμβάνετε ένα mail και μια 

ειδοποίηση στην εφαρμογή creative cloud για υπολογιστή. Για να αρχίσετε να 

εργάζεστε με αυτά τα σχέδια, ανοίξτε το έγγραφο σε μορφή XD.328 

Οποιοσδήποτε μπορεί να σας στείλει ένα έγγραφο. Αν είστε σε πρόγραμμα επί 

πληρωμή, έχετε απεριόριστη επιμέλεια σε αυτά τα έγγραφα.  Αν χρησιμοποιείτε το 

πρόγραμμα εκκίνησης, έχετε τα ακόλουθα όρια χρήσης για κοινόχρηστα έγγραφα:329 

● Έγγραφα που ανήκουν σε έναν ελεύθερο χρήστη: μπορείτε να κάνετε 

απεριόριστη επεξεργασία σε ένα έγγραφο. 

● Έγγραφα που ανήκουν σε έναν χρήστη επί πληρωμή: μπορείτε να 

κωδικοποιήσετε οποιοδήποτε αριθμό εγγράφων για τριάντα (30) ημέρες. Στη 

συνέχεια, θα έχετε πρόσβαση μόνο για προβολή σε αυτά τα έγγραφα.  

Αντιγραφή και επικόλληση SVG από το Photoshop 

Για αντιγραφή και επικόλληση ενός SVG από το Photoshop, κάντε δεξί click 

στο σχήμα ή στο διανυσματικό επίπεδο στο Photoshop. Στην συνέχεια, κάντε click 

στην επιλογή αντιγραφή SVG και επικόλληση στο XD.330 

Μεταφορά πόρων από το illustrator 

Μπορείτε επίσης να αντιγράψετε διανυσματικές εικόνες και εικόνες bitmap από 

το adobe illustrator και να τις επικολλήσετε σε XD, διατηρώντας την ίδια πιστότητα 

και δυνατότητα επεξεργασίας, κατα το άνοιγμα ή την εισαγωγή αρχείων του illustrator. 

Τα αρχεία του illustrator τοποθετούνται μέσα στο ανοιχτό έγγραφο αντί να ανοίγουν 

ως ξεχωριστό έγγραφο. Τα smart object εισάγονται ως ανεπτυγμένα επίπεδα αντί για 

bitmap και τα επίπεδα ρύθμισης διατηρούνται. Ωστόσο, δεν μπορείτε να αντιγράψετε 

και να επικολλήσετε ένα artboard του illustrator σε XD.331 
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Μπορείτε επίσης να αντιγράψετε ένα διανυσματικό αρχείο στο πρόχειρο του 

OS και να χρησιμοποιήσετε την επιλογή paste appearance για να επικολλήσετε την 

εικόνα απευθείας ως γέμισμα εικόνας. Τέλος, μπορείτε να εισάγετε πόρους του adobe 

illustrator που είναι αποθηκευμένοι σε creative cloud libraries μέσα στο XD, σύροντας 

τους από τον πίνακα libraries στο  XD canvas.332 

Άνοιγμα illustrator αρχείων στο XD 

Μπορείτε να ανοίξετε απευθείας αρχεία illustrator (.ai) και να τα μετατρέψετε σε 

αρχεία XD. Αφού ανοίξετε τα αρχεία, μπορείτε να τα επεξεργαστείτε σε μορφή XD, 

να δείτε αλληλεπιδράσεις μεταξύ ενώσεων (cables) και να τα μοιραστείτε ως prototype 

ή design specs.333 

Για άνοιγμα ενός αρχείου illustrator σε μορφή XD, αρκεί να κάνετε τα εξής:334 

● Στο XD επιλέξτε file > open. Στη συνέχεια, μεταβείτε στον απαιτούμενο 

φάκελο, επιλέξτε ένα αρχείο .ai και ανοίξτε το σε XD. Μπορείτε επίσης να 

χρησιμοποιήσετε τις συντομεύσεις πληκτρολογίου Cmd + O (για Mac)  ή Ctrl 

+ O (για Windows).  

● Κάντε δεξί click στο αρχείο του illustrator και επιλέξτε άνοιγμα με > XD από 

το υπομενού. 

● Για άνοιγμα του αρχείου σε XD, σύρετε το αρχείο ai πάνω από το εικονίδιο 

XD. Η δυνατότητα αυτή παρέχεται μόνο για Mac.  

Σημείωση: Κατά το άνοιγμα ενός αρχείου illustrator σε μορφή XD, δεν υποστηρίζονται 

όλα τα στοιχεία με πλήρη πιστότητα. 

Μεταφορά πόρων από το sketch 

Για την μεταφορά πόρων από το sketch, υπάρχουν οι κάτωθι επιλογές: 335 
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● Μπορείτε να ανοίξετε ένα αρχείο .sketch απευθείας στο XD. Στη συνέχεια, 

μπορείτε να επεξεργαστείτε το αρχείο σε μορφή XD, όπως οποιοδήποτε άλλο 

αρχείο XD, να κάνετε αλληλεπιδράσεις μεταξύ των ενώσεων (cables)  και να 

το μοιραστείτε ως prototype ή προδιαγραφές σχεδίασης. 

● Μπορείτε να αντιγράψετε πόρους από το Sketch και να το επικολλήσετε σε XD.  

● Μπορείτε να αντιγράψετε και να επικολλήσετε απευθείας από το Sketch σε XD, 

διατηρώντας την δυνατότητα επεξεργασίας του σε XD. 

● Μπορείτε να αντιγράψετε ένα αρχείο Sketch στο πρόχειρο του OS και να 

χρησιμοποιήσετε την επιλογή Paste Appearance την επικόλληση της εικόνας 

απευθείας, ως γέμισμα εικόνας. 

● Μπορείτε να μετατρέψετε το περιεχόμενο Sketch, σε XD συστήματα 

σχεδιασμού  

Άνοιγμα αρχείων sketch σε XD 

Για άνοιγμα ενός αρχείου σχεδίου σε XD, αρκεί να κάνετε τα παρακάτω:336 

● Κάντε click στο Αρχείο > Άνοιγμα. Στη συνέχεια, μεταβείτε στον απαιτούμενο 

φάκελο, επιλέξτε ένα αρχείο .sketch και ανοίξτε το σε XD. 

● Κάντε δεξί click στο αρχείο Sketch και επιλέξτε Open with > XD από το μενού 

περιβάλλοντος. 

● Κάντε χρήση των συντομεύσεων πληκτρολογίου Cmd + O (για MAC) ή Ctrl 

+ O (για Windows). 

● Σύρετε το  sketch αρχείο πάνω από το εικονίδιο XD,για να ανοίξετε το αρχείο 

σε XD. Η επιλογή αυτή διατίθεται μόνο σε Mac. 
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Μεταφορά επιλεγμένων πόρων από το design337 

● Στην εφαρμογή sketch, επιλέξτε ένα ή περισσότερα layers ή groups, και στη 

συνέχεια κάντε click στο Make Exportable. 

● Επιλέξτε «SVG» ως μορφή και στη συνέχεια σύρετε το layer από την εφαρμογή 

του sketch στο XD. Το περιεχόμενο εισάγεται ως επεξεργάσιμο vector 

περιεχόμενο σε XD. 

Μετατροπή sketch libraries στο XD design systems 

Υπάρχει δυνατότητα μετακίνησης του περιεχομένου του sketch στο XD και 

συνέχεια της εργασίας με τα συστήματα σχεδίασης. Τα σύμβολα και τα στοιχεία του 

sketch, δεν μετατρέπονται μόνο σε στοιχεία XD, αλλά μπορούν επίσης να 

χρησιμοποιηθούν ως συνδεδεμένοι πόροι. Πιο συγκεκριμένα: 338 

1. Ανοίξτε το σύστημα σχεδίασης σε XD. 

2. Από τον πίνακα assets, κάντε click στην επιλογή link assets. Σε περίπτωση που 

υπάρχουν ήδη πόροι στον πίνακα assets, τότε κάντε click στο εικονίδιο συν (+). 

3. Στο παράθυρο link assets, επιλέξτε την εντολή convert sketch library και στην 

συνέχεια, επιλέξτε ένα αρχείο sketch από το file picker. Η μορφή XD 

μετατρέπει το έγγραφο sketch και στη συνέχεια το αποθηκεύει αυτόματα ως 

έγγραφο cloud, συνδέοντας το χρώμα, το character style και το component του 

εγγράφου XD. 

4. Σε περίπτωση που υπάρχουν πολλά sketch libraries με τα οποία πρέπει να 

εργαστείτε, κάντε click στο εικονίδιο (+) στον πίνακα assets και στη συνέχεια 

εισάγετε ξανά ένα άλλο sketch library. 

Εξαγωγή στα after effects 

Αρχικά, επισημαίνεται ότι η εξαγωγή στο after effects,  υποστηρίζεται μόνο με τις 

εκδόσεις after effects 2018 και 2019. Αν έχετε εγκατεστημένη μια παλαιότερη έκδοση, 

η επιλογή «export to after effects», είναι απενεργοποιημένη στο XD. Για την 
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ενεργοποίηση της, συνδεθείτε στην εφαρμογή creative cloud και ενημερώστε το after 

effects στην πιο πρόσφατη έκδοση. Σε περίπτωση χρήσης της λειτουργίας after effects 

για τη μετατροπή των σχεδίων XD σε προσαρμοσμένες κινούμενες εικόνες ή μικρο – 

αλληλεπιδράσεις, ακολουθήστε τα παρακάτω βήματα:339 

1. Επιλέξτε το layer ή το artboard που θέλετε να προσδώσετε κίνηση μέσα από 

την λειτουργία after effect. 

2. Επιλέξτε file > export > after effects. Σε περίπτωση που το after effects δεν 

έχει εγκατασταθεί στον υπολογιστή σας, τότε αυτή η επιλογή είναι 

απενεργοποιημένη.  

3. Τα επιλεγμένα layers ή artboards μεταφέρονται ως native shapes, δηλαδή texts 

που περιλαμβάνουν παραγράφους, assets, εσωτερικά και εξωτερικά strokes και 

nested compositions στο έργο σας στο after effects. Μπορείτε να 

πραγματοποιήσετε πολλές μεταφορές πόρων στο ίδιο έργο του after effects και 

να δημιουργήσετε κινούμενες εικόνες σε στάδια ή εικόνες προερχόμενες από 

πολλά αρχεία XD. 

Σημείωση: κατά την εξαγωγή περιεχομένου XD στο after effects, δεν υποστηρίζονται 

όλα τα στοιχεία με πλήρη πιστότητα.  

Εισαγωγή άλλων αρχείων  

Για εισαγωγή αρχείων, όπως PNG, JPG, TIFF, GIF, SVG υποστηριζόμενα βίντεο 

ή αρχεία Lottie, αρκεί να εκτελέσετε μία από τις ακόλουθες ενέργειες: 340 

1. Κάντε click στο file > import και κατόπιν πραγματοποιήστε αναζήτηση του 

αρχείου για να το επιλέξετε (για MAC). Κάντε click στο μενού hamburger και 

επιλέξτε import (για Windows). 
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2. Κάντε μεταφορά και απόθεση του αρχείου σε XD, από το Finder ή από την 

εξερεύνηση αρχείων των windows. Μπορείτε επίσης να αντιγράψετε και να 

επικολλήσετε ένα αρχείο εικόνας. 

Το Adobe XD παρέχει τη δυνατότητα συγχώνευσης των σχεδίων και των artboards 

του Photoshop, έτσι ώστε να μπορούν να μετατραπούν σε αλληλεπιδραστικές 

εφαρμογές ή prototypes. Είτε προσπαθείτε να απελευθερώσετε τις δυνατότητες των 

αρχείων .psd είτε κάνετε μια απλή αντιγραφή – επικόλληση, η συμπληρωματική 

ενοποίηση μεταξύ XD και Photoshop  σας βοηθά να το πετύχετε χωρίς κόπο.341 

Σημείωση: Παρόλο που και το Photoshop και το XD, έχουν συμπληρωματικά 

χαρακτηριστικά, υπάρχουν ακόμα ορισμένα χαρακτηριστικά, τα οποία δεν έχουν 

αντιστοίχιση στο Photoshop και το XD. Συγκεκριμένα: 342 

● Δεν είναι δυνατή η επιλογή ορισμένων στοιχείων του Photoshop και η 

μεταφορά τους στη σχεδίαση XD.  

● Δεν είναι δυνατή η εξαγωγή αρχείων ως αρχεία .psd στο Photoshop. Ωστόσο, 

μπορείτε να χρησιμοποιήσετε την εντολή file > open in XD, για το άνοιγμα 

εικόνων Photoshop που αποτελούν μέρος της σχεδίασης XD, χρησιμοποιώντας 

τις δυνατότητες επεξεργασίας εμπλουτισμένων φωτογραφιών του Photoshop.  

● Σε περίπτωση που έχετε ανοίξει ένα αρχείο .psd σε XD, δεν είναι εφικτό να 

αποθηκευτεί ξανά ως αρχείο .psd.  

Share και collaborate with XD 

Ένα από τα σημαντικότερα πλεονεκτήματα της χρήσης του adobe XD για το 

σχεδιασμό και τη δημιουργία διαδραστικών prototypes, είναι η δυνατότητα κοινής 

χρήσης των σχεδίων και των prototype μας και η λήψη σχολίων από τα ενδιαφερόμενα 

μέρη. Τα shared design, βελτιστοποιούνται χωρίς απώλεια πιστότητας, ενώ τα σχόλια 

από τους συμμετέχοντες διατίθενται σε πραγματικό χρόνο και οι προγραμματιστές 
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μπορούν να κάνουν λήψη των κοινόχρηστων πόρων και των προδιαγραφών σχεδίασης 

για κωδικοποίηση. 343 

Με τη λειτουργία κοινής χρήσης σε XD, υπάρχει δυνατότητα κοινής χρήσης 

design και αλληλεπιδραστικών prototypes με άλλους ενδιαφερόμενους και 

συνεργασίας με άλλους σχεδιαστές. Οι εκδόσεις του κάθε  εγγράφου, αποθηκεύονται 

αυτόματα σε τακτά χρονικά διαστήματα, επιτρέποντας την επαναφορά αλλαγών από 

προηγούμενη έκδοση. 344 

Work with illustrator assets in adobe XD 

To Adobe XD συνεργάζεται με το illustrator για να φέρει διανυσματικά 

γραφικά υψηλής πιστότητας, όπως λογότυπα, εικονίδια ή οποιαδήποτε άλλα στοιχεία 

τα οποία προσφέρονται προς χρήση στα σχέδια του χρήστη στο XD. Το εισαγόμενο 

γραφικό παραμένει επεξεργάσιμο σε μορφή XD, επιτρέποντας την εξοικονόμηση του 

απαιτούμενου χρόνου, για τη δημιουργία prototype.345 

Αντιγραφή των vectors από το illustrator στο XD 

Για την αντιγραφή και επικόλληση διανυσματικών αντικειμένων ή SVG, από 

το illustrator στο adobe XD, αρχικά να αναφερθεί ότι δεν υπάρχει πάντα λόγος 

μεταφοράς του συνόλου του εγγράφου από το illustrator. Μερικές φορές, το μόνο που 

χρειάζεται είναι η αντιγραφή των αντικειμένων εντός των layers.346 

Ο πιο γρήγορος τρόπος για την μεταφορά αντικειμένων από το illustrator στο 

XD, είναι με αντιγραφή (copy) SVG ή διανυσματικών αντικειμένων από το illustrator 

και με επικόλληση (paste) στο XD. Καθώς το XD είναι ένα εργαλείο σχεδίασης με 

βάση το διάνυσμα, μπορείτε να συνεχίσετε να επεξεργάζεστε τις διαδρομές του 

αντικειμένου.347 
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6: INTEGRATIONS & PLUG-INS 

To Adobe XD διαθέτει προσθήκες και ενσωματώσεις εφαρμογών από την 

Adobe και τρίτους προγραμματιστές, που βελτιώνουν τη ροή εργασιών σχεδίασης, 

αυτοματοποιώντας σύνθετες και επαναλαμβανόμενες εργασίες και επιτρέποντας 

βαθιές ενοποιήσεις με εξωτερικά εργαλεία και υπηρεσίες.  Για παράδειγμα, σε 

περίπτωση που θελήσετε να χρησιμοποιήσετε τους χάρτες Google, μπορείτε να κάνετε 

εγκατάσταση, χρησιμοποιώντας μια προσθήκη τρίτου μέρους για την μεταφορά της 

εφαρμογής στον χώρο εργασίας XD. 348 

Επισημαίνεται ότι το XD υποστηρίζει επίσης εξωτερικές ενσωματώσεις, όπως 

Jira και επεκτάσεις εντός εφαρμογής, με σκοπό την παροχή μιας ολοκληρωμένης λύσης 

για σχεδιαστές και ενδιαφερόμενους.349 

6.1 Προβολή και εγκατάσταση plugins 

Χρησιμοποιώντας οποιαδήποτε από τις ακόλουθες επιλογές, για την προβολή και 

την εγκατάσταση των plug-ins: 350 

● Στην αρχική οθόνη, επιλέξτε Add-on > plugins για να λειτουργήσει ο πίνακας 

Plugin. 

● Κάνοντας click στο εικονίδιο Plugins, στη γραμμή εργαλείων. Επιλέξτε 

Discover Plugins ή κάντε click στο εικονίδιο + για να ξεκινήσει το plugin 

panel. 

Discover στο Adobe XD 

Μπορείτε να αναζητήσετε, να εγκαταστήσετε και να απεγκαταστήσετε 

προσθήκες και ενσωματώσεις εφαρμογών από την Adobe και τρίτους 

προγραμματιστές, για να βελτιωθούν οι ροές εργασιών σχεδίασης αυτοματοποιώντας 

εργασίες και επιτρέποντας τη βαθιά ενοποίηση με εξωτερικά εργαλεία και υπηρεσίες. 

Για παράδειγμα, χρησιμοποιώντας τη προσθήκη Adobe Asset Link μπορείτε να 
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περιηγηθείτε, να αναζητήσετε και να κατεβάσετε πόρους στο Adobe Experience 

Manager μέσα από το XD.351 

Browser  

Μπορείτε να περιηγηθείτε και να φιλτράρετε plugins ανά κατηγορία, πιο 

πρόσφατα, κορυφαία βαθμολογία και πιο δημοφιλή. Η αξιολόγηση ενός plugin μπορεί 

να πραγματοποιηθεί μόνο όταν πραγματοποιηθεί η εγκατάσταση της.352 

Manage  

Μπορείτε να δείτε τη λίστα όλων των plugins που είναι εγκατεστημένα στο 

σύστημα. Τα plugins  ταξινομούνται με βάση το όνομα τους ή την τελευταία 

ενημέρωση τους. Κάνοντας click στα αποσιωπητικά (…) στα plugins, μπορείτε να τα 

ενεργοποιήσετε ή να τα απενεργοποιήσετε.353 

Επαλήθευση για το αν τα ζητήματα αντιμετώπισης προβλημάτων σχετίζονται 

αποκλειστικά με τα plugins:354 

● Χρησιμοποιήστε την επιλογή disable που βρίσκεται στο plugin panel, για να 

απενεργοποιήσετε χειροκίνητα κάθε εγκατεστημένο plugin. 

● Εναλλακτικά, κρατήστε πατημένο το πλήκτρο Shift κατά την εκκίνηση του 

XD, για να απενεργοποιήσετε προσωρινά όλα τα plugins. 

6.2 Ενεργοποίηση της ενσωμάτωσης Jira για το XD 

H Adobe XD και η Atlassian Jira, συνδυάζουν τη δημιουργική εργασία και την 

ομαδική εργασία. Με την εφαρμογή Adobe XD για Jira, οι σχεδιαστές μπορούν εύκολα 
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να μοιράζονται τα πιο πρόσφατα prototype και τις προδιαγραφές σχεδιασμού τους με 

άλλα ενδιαφερόμενα μέρη στην Jira.355 

Εγκατάσταση και διαμόρφωση της εφαρμογής Adobe XD για Jira Cloud 

1. Αρχικά, πρέπει να συνδεθείτε στο Jira ως διαχειριστής. 

2. Στην πλαϊνή γραμμή, κάντε click στην επιλογή Jira Settings και στη συνέχεια 

επιλέξτε App > Find new apps. Εμφανίζεται η σελίδα Atlassian Marketplace 

for Jira. 

3. Κάντε αναζήτηση για Adobe XD. Από τα αποτελέσματα αναζήτησης, κάντε 

click στο Install για το Adobe XD. 

4. Στο πλαίσιο διαλόγου, κάντε click στο Accept & install. Εκεί εμφανίζεται ένα 

μήνυμα επιβεβαίωσης, όταν η εφαρμογή εγκατασταθεί με επιτυχία.  

5. Από προεπιλογή, όλα τα έργα μέσα στο workspace έχουν τη δυνατότητα να 

εμφανίζουν την εφαρμογή μέσα σε ένα Jira issue. Παρόλα αυτά, σαν 

διαχειριστές, μπορείτε να επιλέξετε την ενεργοποίηση add-on μόνο για 

συγκεκριμένα projects. 

Για την αλλαγή της προεπιλογής,  αρκεί να κάνετε τα παρακάτω:356 

● Μεταβείτε στο manage add-ons, στην πλαϊνή γραμμή. 

● Στην ενότητα user-installed add-ons, επιλέξτε Adobe XD for Jira και στη 

συνέχεια κάντε click στο Configure. Η σελίδα Configure Adobe XD for Jira 

παραθέτει ενεργοποιημένα έργα στο αριστερό τμήμα του παραθύρου και 

απενεργοποιημένα έργα στο δεξί τμήμα του παραθύρου. 

● Για την απενεργοποίηση του add-on σε ένα ή περισσότερα έργα, αρκεί να 

επιλέξετε το project  το οποίο βρίσκεται στο αριστερό τμήμα και να το 

μεταφέρετε στο δεξί τμήμα. 
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● Κάντε click στο Αποθήκευση. Στο πλαίσιο διαλόγου επιβεβαίωσης, κάντε 

click στην επιλογή Disable Projects. Μπορείτε να δείτε το add-on, αν είστε 

μέρος ενός ενεργοποιημένου έργου ή έχετε πρόσβαση σε κάποιο ζήτημα Jira 

στο project. 

Επισύναψη πρωτοτύπου ή προδιαγραφών σχεδίασης σε ένα issue της Jira 

Μπορουν να επισυναφθούν οι ακόλουθοι τύποι συνδέσεων Adobe XD σε ένα 

ζήτημα Jira:357 

● Prototypes  

● Design specs 

● Password protected prototypes or design specs  

● Private prototype or design spec 

Τα βήματα είναι τα εξής: 358 

1. Ανοίξτε το Jira issue. 

2. Μεταβείτε στην ενότητα Adobe XD, κάτω από την περιγραφή της έκδοσης. 

Σε περίπτωση που δεν φαίνεται η ενότητα Adobe XD, κάντε click στο μενού επιλογών 

(…) κάτω από τη σύνοψη έκδοσης και επιλέξτε Adobe XD. 

3. Πραγματοποιήστε επικόλληση της σύνδεσης προς το prototype ή τις 

προδιαγραφές σχεδίασης στο πεδίο εισαγωγής XD και κάντε click στο Attach. 

Για την επισύναψη περισσότερων prototypes ή προδιαγραφών σχεδίασης, 

ακολουθείται η ίδια διαδικασία.  

Εμφανίζεται μια προεπισκόπηση του αντίστοιχου πόρου ως κάρτα. Μπορείτε 

να προσθέσετε μια σύντομη περιγραφή των assets.  

Για ένα asset, το οποίο είτε είναι private είτε προστατεύεται με κωδικό 

πρόσβασης, η προεπισκόπηση δεν εμφανίζεται στη κάρτα. Για την προβολή του asset, 
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αρκεί να κάνετε click στην επιλογή view prototype ή view design specs στην κάρτα. 

Εισάγετε τον κωδικό πρόσβασης στη σελίδα προβολής assets XD και στη συνέχεια 

επιλέξτε view.359 

Εγκατάσταση και διαμόρφωση του adobe XD για τον διακομιστή Jira και στην 

εφαρμογή Jira κέντρου δεδομένων 

Από προεπιλογή, όλα τα έργα εντός του χώρου εργασίας έχουν τη δυνατότητα να 

εμφανίζουν  την εφαρμογή εντός του ζητήματος Jira. Ωστόσο, ως διαχειριστές, έχετε 

δυνατότητα επιλογής της ενεργοποίησης της εφαρμογής, μόνο για συγκεκριμένα έργα 

και συγκεκριμένους τύπους θεμάτων. Για την αλλαγή της προεπιλογής, αρκεί να κάνετε 

τα εξής: 360 

1. Κάντε click στην επιλογή Διαχείριση σελίδας προσθέτων, από την πλαϊνή 

γραμμή. 

2. Στην ενότητα under user-installed add-ons, κάντε click στο Adobe XD για 

Jira και  

επιλέξτε Configure. Η σελίδα  Adobe XD για Jira, παραθέτει τα έργα Jira που έχετε 

στο αριστερό τμήμα του παραθύρου και τους τύπους προβλημάτων που έχετε στο δεξιό 

τμήμα του παραθύρου.  

3. Από προεπιλογή, η εφαρμογή είναι ενεργοποιημένη στο σύνολο των έργων. Για 

την απενεργοποίηση της εφαρμογής σε ένα ή περισσότερα έργα, επιλέξτε τα 

επιθυμητά έργα και ορίστε τις προτιμήσεις σας.  

4. Κάντε click στο Save. 

Μπορείτε να προβάλλετε την εφαρμογή μόνο αν είστε μέρος ενός ενεργοποιημένου 

έργου και τύπου θέματος. Μπορείτε επίσης να προβάλλετε την εφαρμογή, αν έχετε 

πρόσβαση σε έναν τύπο προβλήματος Jira στο project. 361 
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Λεπτομέρειες για τα πρωτότυπα Adobe XD και τις προδιαγραφές σχεδίασης στο 

Jira 

Ωστόσο, όταν κάνετε share του συνδέσμου Home artboard ενός prototype ή μιας 

προδιαγραφής σχεδίασης, εμφανίζεται ο συνολικός αριθμός σχολίων που προστίθενται 

στο prototype ή στην προδιαγραφή.362 

● Artboards: Ο αριθμός των artboards που υπάρχουν στην προδιαγραφή του 

prototype ή της σχεδίασης, που χρησιμοποιούνται από κοινού με την εφαρμογή 

XD για Jira. 

● Views: Το Adobe XD για την εφαρμογή Jira, εμφανίζει τα ονόματα και τα 

εικονίδια προφίλ όλων των ατόμων τα οποία έχουν δεί το prototype μέσω της 

εφαρμογής XD για Jira. Μπορείτε εύκολα να διαπιστώσετε αν οι 

ενδιαφερόμενοι φορείς, έχουν ανοίξει τα prototypes XD και τις προδιαγραφές 

σχεδιασμού. 

● Date και time: Μπορείτε να δείτε την ημερομηνία και την ώρα κατά την οποία 

το prototype ή μια προδιαγραφή σχεδιασμού, κοινοποιήθηκε σε ένα issue της 

Jira. 

● Rich in context preview: Κάνοντας click στο εικονίδιο ανάπτυξης, μπορείτε να 

προβάλλεται όλα τα artboards σε ένα prototype, σε πλήρη οθόνη στη Jira. 

Μπορείτε να αποφύγετε τη μετάβαση σε xd.adobe.com, διευκολύνοντας τον 

εντοπισμό των αρχείων XD που θέλετε να ανοίξετε, χωρίς τον τερματισμό της 

Jira. 

● Update Label: Όταν ένα prototype ή μια προδιαγραφή σχεδιασμού, που 

μοιράζεται μέσω της εφαρμογής XD για Jira, ενημερώνεται χρησιμοποιώντας 

την εφαρμογή XD, εμφανίζεται ένα μικρό tag πάνω από τη μικρογραφία στη 

Jira. Αυτό το tag, δηλώνει ότι το prototype ή η προδιαγραφή σχεδίασης Jira, 

έχει ενημερωθεί. Υπάρχει δυνατότητα προβολής της ετικέτας, αν είστε ή έχετε 

ακολουθήσει το θέμα Jira πριν απο την XD σύνδεση.  
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6.3 Slack plug-in 

Εργασία με το πρόσθετο αδράνειας σε XD 

Το slack στο Adobe XD, επιτρέπει την κοινή χρήση artoboards, εικόνων, 

prototype links και ομαλής σχεδίασης των slack channels και τις επαφές αδράνειας.363 

Με το slack plugin, μπορείτε να προσθέσετε πολλά workspaces, να 

δημιουργήσετε δημόσια ή ιδιωτικά slack channels ή να παρέχετε πρόσβαση σε ιδιωτικά 

links εντός XD.364 

Σύνδεση στο slack και προσθήκη ενός χώρου workplace 

1. Στο home screen, κάντε click στο εικονίδιο των plugins 

2. Στο plugins panel, κάντε click στο κουμπί + και εγκαταστήστε το Slack. 

3. Μετά την εγκατάσταση, ζητήστε άδεια για πρόσβαση στην κατάσταση Slack 

στο XD: 

● Κάντε click στην επιλογή Sign in 

● Στην ιστοσελίδα Slack, εισάγετε τη διεύθυνση URL του workspace σας. 

● Επιλέξτε το workspace από την αναπτυσσόμενη λίστα στην επάνω δεξιά 

γωνία και κάντε click στο κουμπί Submit. 

● Αφού εγκριθεί το αίτημα, θα λάβετε μια ειδοποίηση από την Slack. 

4. Για να προσθέσετε ένα workspace  σε XD: 

● Ανοίξτε ξανά το Adobe XD και κάντε click ξανά στο κουμπί sign in. 

● Επιλέξτε το workspace από την αναπτυσσόμενη λίστα στην επάνω δεξιά 

γωνία και  

     κάντε click στο Allow. 

5. Για να αποσυνδεθείτε από τον λογαριασμό σας Slack, κάντε click στο κουμπί 

Sign-out. 
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Προσθήκη πολλών workspace 

Έχετε τη δυνατότητα προσθήκης πολλών Slack Workspace στο XD, καθώς και 

της εναλλαγής μεταξύ τους. Μεταβείτε στα settings, κάντε click στο κουμπί add 

workspace και επιλέξτε το workspace που θέλετε να ενεργοποιηθεί.365 

Δημιουργία καναλιού αδράνειας εντός του XD366 

1. Στο  Slack plugin,κάντε click Share with drop-down και select Add new 

channel. 

2. Στο  Create new Slack channel window, εισάγετετιςλεπτομέρειες. 

3. Στο create a public channel, κάντε click στο Create and OK. 

4. Στο create a private channel, επιλέξτε το Make private check box, και κάντε 

click Create and OK. 

Κοινή χρήση δημοσίων συνδέσμων και προδιαγραφών σχεδιασμού στο Slack367 

1. Για την κοινή χρήση prototypes ή design-specs, πρέπει να δημιουργηθούν 

public link. 

2. Κάντε click στο XD Link και επιλέξτε το Link από το drop-down menu. 

3. Για την κοινοποίηση του link μέσα στο workspace, πληκτρολογήστε ένα 

μήνυμα και στη συνέχεια κάντε click Post and Done. 

Παροχή πρόσβασης σε ιδιωτικούς συνδέσμους XD368 

1. Για την κοινή χρήση ιδιωτικών συνδέσεων prototype ή προδιαγραφών 

σχεδίασης, δημιουργήστε μια ιδιωτική σύνδεση. 

 
365 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system 

for soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune 
Section International Conference (PuneCon) (pp. 1-5). IEEE. 
366 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system 

for soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune 
Section International Conference (PuneCon) (pp. 1-5). IEEE. 
367 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system 

for soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune 
Section International Conference (PuneCon) (pp. 1-5). IEEE. 
368 Low, N. E. (2022). Barber App UI/UX Design. 
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2. Κάντε click στο XD Link και επιλέξτε τη σύνδεση από την αναπτυσσόμενη 

λίστα. 

3. Πληκτρολογήστε το όνομα της επαφής, της ομάδας ή του καναλιού στο πεδίο 

Share with και κάντε click στην επιλογή Post. 

4. Εμφανίζεται ένα παράθυρο που σας ζητά να επιτρέψετε την πρόσβαση στην 

ιδιωτική  σύνδεση με τους παραλήπτες. Για να επιτρέψετε την πρόσβαση, 

επιλέξτε «Yes,invite everyone in this channel to this link» και κάντε click στην 

επιλογή Share. 

 

6.4 Δημοσίευση design από το XD σε Behance 

Μοιραστείτε εύκολα το prototype απο την Adobe XD, για την προβολή του στην 

παγκόσμια δημιουργική κοινότητα.369 

➔ Σκέφτεστε πώς το σχέδιό σας μπορεί να φτάσει σε ένα ευρύτερο κοινό;  

Η Behance είναι η πλατφόρμα της Adobe στην οποία μπορείτε να προβάλλετε το 

design σας σε ένα παγκόσμιο κοινό και να ανακαλύψετε δημιουργικό έργο άλλων 

χρηστών.370 

Μοιραστείτε το prototype σας απευθείας από την XD, για να ανοίξετε ένα νέο έργο 

Behance. Με τον prototype σύνδεσμο ενσωματωμένο αυτόματα στο έργο σας, μπορείτε 

εύκολα να το δημοσιεύσετε. Αφού δημοσιευτεί, ελέγξτε τυχόν σχόλια σχετικά με το 

σχέδιό σας. 371 

Κοινή χρήση πρωτότυπου απευθείας σε ένα νέο έργο Behance 

Για κοινή χρήση ενός prototype, απευθείας σε ένα νέο έργο Behance, κάντε τα 

εξής:372 

 
369 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
370 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
371 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 

372 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World 

Journal of Research and Review (WJRR), 12(6), 41-45. 
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1. Μεταβείτε σε λειτουργία share mode. 

2. Στην ενότητα Link Settings του εργαλείου επιθεώρησης ιδιοτήτων, επιλέξτε τη 

ρύθμιση προβολής που προτιμάτε. Στην αναπτυσσόμενη λίστα «Πρόσβαση 

σύνδεσης», επιλέξτε anyone with the link για να δημιουργήσετε μια δημόσια 

σύνδεση. 

3. Κάντε click στο create link. 

4. Κάντε click στο Behance εικονίδιο, δίπλαστο published link. 

Edit και publish Behance project 

Μπορείτε να επιλέξετε να προσθέσετε περιεχόμενο ή να επεξεργαστείτε το νέο έργο 

Behance που έχετε ανοίξει, πριν το δημοσιεύσετε. Για να μάθετε πώς μπορείτε να 

προσθέσετε περιεχόμενο στο έργο σας ή να το επεξεργαστείτεδείτε, δείτε την ενότητα 

Δημιουργία έργου. Για να δημοσιεύσετε το έργο σας, κάντε τα εξής:373 

1. Για να επισυνάψετε το αρχείο προέλευσης XD (προαιρετικό) στο έργο, κάντε 

click στην επιλογή «Επισύναψη αρχείων» και καθορίστε τη διαδρομή του 

αρχείου XD. Κάντε click στο Συνέχεια. 

2. Κάντε click στο κουμπί «Αποστολή εικόνας», για να προσθέσετε μια εικόνα 

εξωφύλλου για το έργο σας. 

3. Στην ενότητα «Πώς θα κατηγοριοποιήσετε αυτό το έργο;», ελέγξτε τη Σχεδίαση 

αλληλεπίδρασης. Ορίστε την επιλογή «Ορατότητα παρουσίας» σε όλους, για 

πρόσβαση στο έργο σας από άλλους χρήστες. 

4. Κάντε click στο κουμπί Δημοσίευση. Το έργο σας είναι τώρα σε ζωντανή 

λειτουργία. 

 

373 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system 

for soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune 
Section International Conference (PuneCon) (pp. 1-5). IEEE. 

 



158 
 

Για τον έλεγχο των αλληλεπιδράσεων του πρωτοτύπου στο έργο, με το κουμπί 

«click», ξεκινάτε ένα αλληλεπιδραστικό πρωτότυπο. Χρησιμοποιώντας την εφαρμογή 

Adobe XD για κινητές συσκευές, μπορείτε να κάνετε τα εξής:374 

● Σύνδεση της κινητής συσκευής σας μέσω USB στον υπολογιστή σας που 

εκτελεί XD, επεξεργασία των σχεδίων και των πρωτοτύπων στην επιφάνεια 

εργασίας, προεπισκόπηση σε πραγματικό χρόνο σε συνδεδεμένες κινητές 

συσκευές. Για περισσότερες πληροφορίες, ανατρέξτε στο θέμα 

Προεπισκόπηση πρωτοτύπων σε πραγματικό χρόνο σε κινητές 

συσκευές. 

● Πρόσκληση ατόμων για έλεγχο των πρωτοτύπων σας, με χρήση ιδιωτικού 

συνδέσμου με δυνατότητα κοινής χρήσης.  

 

 

 

 

 

 

 

 

 

 

 

  

 
374 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. 

In 10th International Symposium on Graphic Engineering and Design (pp. 537-541). 
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7. XD ΓΙΑ IOS ΚΑΙ ANDROID 

Κάντε προεπισκόπηση των σχεδίων σας για κινητά σε πραγματικό χρόνο ή 

ανοίξτε τα αποθηκευμένα αρχεία XD από το Creative Cloud, χρησιμοποιώντας την 

εφαρμογή XD σε μια κινητή συσκευή. Επίσης, κάντε προεπισκόπηση τυχόν 

δημοσιευμένων πρωτοτύπων σε ένα πρόγραμμα περιήγησης για κινητά.376 

Χρησιμοποιώντας την εφαρμογή Adobe XD για κινητές συσκευές, έχετε 

δυνατότητα:375 

● Να συνδέσετε τη φορητή σας συσκευή, χρησιμοποιώντας USB στον 

υπολογιστή και εκτελώντας XD.  

● Να επεξεργαστείτε τα σχέδια και τα πρωτότυπα στην επιφάνεια εργασίας. 

● Να κάνετε προεπισκόπηση σε πραγματικό χρόνο, σε συνδεδεμένες φορητές 

συσκεύες. 

● Να προσκαλέστε άτομα, για αναθεώρηση των πρωτοτύπων σας, μέσα απο 

ιδιωτική σύνδεση με δυνατότητα κοινής χρήσης.  

● Να προβάλλετε και να σχολιάσετε τη σχεδίαση ή τα πρωτότυπα, που είναι 

αποθηκευμένα  στην κινητή συσκευή σας, στο οικοσύστημα Cloud σε μορφή 

XD. 

● Να μοιραστείτε πρωτότυπα και design με άλλους.  

7.1 Προεπισκόπηση σε κινητές συσκευές 

Πραγματοποιήστε προεπισκόπηση των design σας σε πραγματικό χρόνο, σε μια 

κινητή συσκευή που είναι συνδεδεμένη στον υπολογιστή σας, χρησιμοποιώντας ένα 

καλώδιο USB.  Συγκεκριμένα: 376 

1. Συνδέστε τη φορητή σας συσκευή στη θύρα USB του υπολογιστή, στον οποίο 

εκτελείται το Adobe XD στην επιφάνεια εργασίας. Βεβαιωθείτε ότι είναι 

εγκατεστημένη η πιο πρόσφατη έκδοση του XD στον υπολογιστή σας, η οποία 

είναι διαθέσιμη στο Creative Cloud.  

 
375 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
376 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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2. Ανοίξτε το Adobe XD στη συσκευή. 

3. Ο πίνακας γραφικών που είναι επιλεγμένος  στο Adobe XD στην επιφάνεια 

εργασίας εμφανίζεται στη συσκευή σας. Όλες οι αλλαγές που κάνετε στα σχέδια 

σας αντικατοπτρίζονται σε πραγματικό χρόνο στην κινητή συσκευή σας. 

Αν προσθέσετε καλώδια που δημιουργούν αλληλεπιδράσεις στη λειτουργία 

prototype, μπορείτε να δείτε τις αλληλεπιδράσεις να λειτουργούν, όπως ακριβώς στο 

preview window στην επιφάνεια εργασίας.377 

Χρησιμοποιήστε την κίνηση triple tap στην οθόνη εφαρμογής για κινητές 

συσκευές, για περισσότερες επιλογές:378 

● Browse artboards: Κύλιση σε όλα τα artboards στο σχέδιό σας. 

● Share this screen as image: Κοινή χρήση ενός συγκεκριμένου πίνακα γραφικών, 

ως αρχείου PNG μέσω ηλεκτρονικού ταχυδρομείου, αδράνειας ή άλλων 

καναλιών. 

● Hotspot hints: Ενεργοποίηση συμβουλών ενεργού σημείου, κατα την προβολή 

του prototype. 

● Swipe navigation: Για να μην είναι δυνατή η σάρωση κατά την αλληλεπίδραση 

με ένα prototype. 

● View options: Για προβολή του design σε διαφορετικά μεγέθη. 

Προεπισκόπηση εγγράφων XD που έχουν αποθηκευτεί ως έγγραφα cloud 

Υπάρχει δυνατότητα προεπισκόπησης εγγράφων XD, με την αποθήκευση τους ως 

έγγραφα cloud στην επιφάνεια εργασίας. Αναλυτικότερα: 379 

1. Βεβαιωθείτε ότι το έγγραφο XD έχει αποθηκευτεί ως έγγραφο cloud στην 

επιφάνεια  εργασίας σας. 

2. Ανοίξτε το Adobe XD στην κινητή συσκευή σας. 

 
377 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. 

In 10th International Symposium on Graphic Engineering and Design (pp. 537-541). 
378 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. 

In 10th International Symposium on Graphic Engineering and Design (pp. 537-541). 
379 Low, N. E. (2022). Barber App UI/UX Design. 
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3. Στα έγγραφα XD, υπάρχουν διαθέσιμα προς προβολή, όλα τα έγγραφα XD και 

συγκεκριμένα στον φάκελο εγγράφων Cloud. Μπορείτε να αναζητήσετε 

αρχεία, με βάση το όνομα αρχείου. Στη συνέχεια, μπορείτε να τα ταξινομήσετε 

με αύξουσα ή φθίνουσα σειρά, με αλφαβητική σειρά ή με βάση την τελευταία 

τροποποίηση. Αφού βρείτε το επιθυμητό αρχείο, πατήστε πάνω για προβολή. 

4. Κατά την προεπισκόπηση, χρησιμοποιήστε την κίνηση τριπλού πατήματος για 

να  αποκτήσετε πρόσβαση στις επιλογές του prototype: 

● Browse artboards: αναζήτηση και μετάβαση σε artboards που θέλετε στο design 

σας. 

● Share this screen as image: Κοινή χρήση ενός συγκεκριμένου artboard, ως 

αρχείου PNG μέσω ηλεκτρονικού ταχυδρομείου, κοινωνικών μέσων ή 

οποιασδήποτε άλλης επιλογής κοινής χρήσης που παρέχεται από τη συσκευή 

σας. 

● Hotspot hints: Ενεργοποίηση συμβουλών ενεργού σημείου, κατα την προβολή 

του prototype. 

● Swipe navigation:Για να μην είναι δυνατή η σάρωση κατά την αλληλεπίδραση 

με ένα prototype. 

● View options: Για προβολή του design σε διαφορετικά μεγέθη. 

5. Αφού ελέγξετε τη σχεδίαση στην εφαρμογή για κινητές συσκευές, μπορείτε να 

μοιραστείτε τα πρωτότυπα με τους reviewers. 

6. Πριν προχωρήσετε σε κοινή χρήση του prototype, βεβαιωθείτε ότι έχετε 

ενεργοποιήσει τις συμβουλές ενεργού σημείου. Πατήστε τρεις φορές την οθόνη 

του κινητού και ενεργοποιήστε τις υποδείξεις Hotspot Hints. 

7. Μοιραστείτε τα prototype link με άλλους μέσω ηλεκτρονικού ταχυδρομείου, 

μέσων κοινωνικής δικτύωσης ή οποιασδήποτε άλλης επιλογής κοινής χρήσης 

που παρέχεται από τη συσκευή σας. Πατήστε τρεις φορές την οθόνη του 

κινητού και πατήστε το πλήκτρο Share for Review. 
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7.2 ADOBE XD IN MOBILE - FAQ 

Γραμματοσειρές σε κινητές συσκευές 

Ακολουθούν ορισμένοι τρόποι διαχείρισης γραμματοσειρών στο κινητό σας:380 

● Όταν είναι δυνατόν, οι γραμματοσειρές αποστέλλονται στη συσκευή σας όταν 

κάνετε προεπισκόπηση σε κινητό. Ωστόσο, ορισμένοι προμηθευτές 

γραμματοσειρών δεν επιτρέπουν τη μεταφορά, την εμφάνιση και τη διανομή 

των γραμματοσειρών τους. Είστε υπεύθυνοι για την εξασφάλιση ότι θα 

σεβαστείτε την άδεια χρήσης γραμματοσειρών μεταξύ εσάς και του 

προμηθευτή γραμματοσειρών. 

● Κατά την προβολή ενός prototype στο κινητό, αν η απαιτούμενη 

γραμματοσειρά δεν υπάρχει στη συσκευή σας, θα λάβετε ένα μήνυμα 

προειδοποίησης. Οι γραμματοσειρές που λείπουν αντικαθίστανται με 

διαθέσιμες γραμματοσειρές. 

● Adobe Fonts. Το Adobe Fonts θα ενεργοποιείται αυτόματα και θα εμφανίζεται 

σωστά κατά την προεπισκόπηση ενός εγγράφου cloud XD στις εφαρμογές XD 

για κινητές συσκευές iOS ή Android. 

● Non-Adobe fonts. Το iOS 13.0 υποστηρίζει την εγκατάσταση προσαρμοσμένων 

γραμματοσειρών. Οι χρήστες μπορούν να εγκαταστήσουν προσαρμοσμένες 

γραμματοσειρές μέσω εφαρμογών τρίτων κατασκευαστών χρησιμοποιώντας 

μεθόδους που παρέχει η Apple ή χρησιμοποιώντας την εφαρμογή Creative 

Cloud iOS για κινητές συσκευές (iOS 13.1 και νεότερη έκδοση). 

Διαγραφή ληφθέντων αρχείων XD από τη συσκευή σας 

Για να ελέγξετε τον χώρο αποθήκευσης στην κινητή συσκευή σας, μπορείτε να 

διαγράψετε τα ληφθέντα αρχεία πατώντας Settings > Preferences.381 

 
380 Schwarz, D. (2017). Jump Start Adobe XD. SitePoint Pty Ltd. 
381 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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Εδώ, μπορείτε να δείτε το μέγεθος του τοπικού χώρου που χρησιμοποιείται και 

στη συνέχεια, πατώντας Remove Offline Documents, να διαγράψετε έγγραφα XD, που 

έχουν ληφθεί στη συσκευή. 382 

Προεπισκόπηση δημοσιευμένων πρωτοτύπων σε προγράμματα περιήγησης για 

κινητές συσκευές 

Κατα το άνοιγμα μιας κοινόχρηστης σύνδεσης σε ένα πρόγραμμα περιήγησης 

για κινητές συσκευές, υπάρχει δυνατότητα προβολής του πρωτοτύπου με ένα zoomed-

in artboard. Αν τα artboards του πρωτοτύπου δεν είναι συνδεδεμένα, σαρώστε προς 

τα αριστερά ή τα δεξιά, για την μετακίνηση από το ένα artboard στο άλλο.383 

Όταν ανοίξετε το prototype για πρώτη φορά, το παράθυρο του προγράμματος 

περιήγησης μπορεί  να μείνει αδρανές για τρία δευτερόλεπτα και στη συνέχεια 

εμφανίζεται ένα pinch icon. Αυτό το pinch icon δεν επανεμφανίζεται στο ίδιο 

πρόγραμμα περιήγησης, ακόμα και αν  ανοίξετε άλλο δημοσιευμένο prototype. 

Χρησιμοποιήστε τo pinch gesture για να κάνετε click  στο artboard για την προβολή 

της μετατόπισης. Χρησιμοποιήστε τις ακόλουθες επιλογές στην προβολή 

μετατόπισης:384 

● εικονίδιο για πλοήγηση στο αρχικό artboard. 

● βέλη για περιήγηση στα artboards. 

● εικονίδιο για σχολιασμό των σχεδίων και των prototypes. 

 

Προεπισκόπηση design σε διαφορετικές αναλύσεις 

Scale to Fit 

Με την επιλογή κλιμάκωσης προς τα πάνω ή προς τα κάτω, η σχεδίαση 

προσαρμόζεται στο πλάτος ή το ύψος της κινητής συσκευής. Συγκεκριμένα, στην 

 
382 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
383 Low, N. E. (2022). Barber App UI/UX Design. 
384 Sharma, V., & Tiwari, A. K. (2021). A study on user interface and user experience designs and its tools. World 

Journal of Research and Review (WJRR), 12(6), 41-45. 
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επιλογή που δεν θα αποκόψει το design. Τα artboards κλιμακώνονται μόνο έως το 

διπλάσιο της σχεδιασμένης ανάλυσης τους.385 

View στο 100% 

Η σχεδίαση προβάλλεται με την ανάλυση στην οποία δημιουργήθηκε, χωρίς 

καμία κλιμάκωση. Αν το σχέδιο ξεπερνάει τα περιθώρια της οθόνης, χρησιμοποιήστε 

δύο δάχτυλα για πανοραμκή λήψη. 386 

Freeform 

Κάντε ζουμ και μετατόπιση στα artboards, πιέζοντας για ζουμ με δύο δάχτυλα 

και μετακινώντας με δύο δάχτυλα. Τα artboards κλιμακώνονται μόνο έως το διπλάσιο 

της σχεδιασμένης  ανάλυσης τους. Οι αλληλεπιδράσεις θα συνεχίσουν να λειτουργούν 

με αυτήν την φιλοσοφία.387 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 
385 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. 

In 10th International Symposium on Graphic Engineering and Design (pp. 537-541). 
386 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. 

In 10th International Symposium on Graphic Engineering and Design (pp. 537-541). 
387 Đurđević, S., Novaković, D., & Zeljković, Ž. (2020). Development of products state identification application. 

In 10th International Symposium on Graphic Engineering and Design (pp. 537-541). 
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8. TIPS AND TRICKS 

Γενικές συμβουλές και κόλπα388 

● Αντί να αντιγράψετε και να επικολλήσετε ομάδες στοιχείων στο σχέδιό σας, 

εξετάστε το ενδεχόμενο να χρησιμοποιήσετε το εργαλείο Repeat Grid. 

● Μπορείτε να αντιγράψετε ένα σχήμα επιλέγοντάς το, κρατώντας πατημένο το 

πλήκτρο Opt (για Mac) ή το πλήκτρο Alt (για Windows) και σύροντας ένα νέο 

αντίγραφό του. 

● Τα στοιχεία μπορούν να κλειδωθούν με Object>Lock ή Cmd + L σε Mac. 

Αυτό στην πραγματικότητα αλλάζει το κλείδωμα, επομένως χρησιμοποιήστε 

την ίδια εντολή για να ξεκλειδώσετε τα στοιχεία. Στα Windows, κάντε δεξί click 

σε ένα αντικείμενο και επιλέξτε Lock από το μενού περιβάλλοντος. 

● Γρήγορη κάλυψη ρίχνοντας μια εικόνα σε ένα σχήμα: το γέμισμα του σχήματος 

γίνεται εικόνα. 

● Δημιουργήστε μια επεξεργάσιμη μάσκα εισάγοντας μια εικόνα και, στη 

συνέχεια, σχεδιάστε ένα σχήμα πάνω της. Επιλέξτε και τα δύο και, στη 

συνέχεια, επιλέξτε Object >Mask with Shape (για Mac) ή κάντε δεξί click στα 

αντικείμενα και επιλέξτε Mask with Shape από το μενού περιβάλλοντος. 

Design και κείμενο389 

● Κάντε διπλό click σε οποιοδήποτε σημείο αγκύρωσης για εναλλαγή μεταξύ 

μιας καμπύλης και μιας γωνίας. 

● Πατήστε Opt (για MAC) ή Alt (για Windows) ενώ σύρετε μια λαβή καμπύλης, 

για να κάνετε τη λαβή καμπύλης ανεξάρτητη. (Για αναίρεση, κάντε διπλό click 

ώστε να επιστρέψετε σε γωνία και μετά κάντε διπλό click ξανά). 

● Μπορείτε να επιλέξετε σημεία αγκύρωσης όταν σχεδιάζετε, χρησιμοποιώντας 

το pen tool. 

 
388 Huddleston, R., & Huddleston, R. (2017). Introduction to Adobe Experience Design. Beginning Adobe Experience 

Design: Quickly Design and Prototype Websites and Mobile Apps, 7-21. 
389 Swaroop, S. (2023). Usability Evaluation Technical Report: A Usability Evaluation of the Communication Tool 

Prototype Prepared in Adobe XD for High Density Vertiplex (HDV) Team. 
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● Κάντε διπλό click για να εισαγάγετε το περιβάλλον επεξεργασίας μιας ομάδας 

(μπορείτε να προσθέσετε στοιχεία σε αυτό το πλαίσιο), ή απλώς κάντε click και 

Cmd (για MAC) ή Ctrl (για Windows) σε ένα αντικείμενο μέσα σε μια ομάδα 

για να το επιλέξετε. 

● Επιλέξτε ένα στοιχείο κειμένου και, στη συνέχεια, δημιουργήστε ένα νέο για 

να εφαρμόσετε όλα τα στυλ από το πρώτο στοιχείο στο δεύτερο. 

Artboards390 

● Για να επιλέξετε ένα artboard, κάντε click στον τίτλο του , Cmd / Ctrl + Κάντε 

click στο φόντο του ή κάντε διπλό click στο φόντο του. 

● Για να αντιγράψετε ένα artboard (και τα περιεχόμενά του), επιλέξτε το artboard 

και πατήστε Cmd (σε Mac) ή Alt (στα Windows) ενώ σύρετε για να 

δημιουργήσετε ένα αντίγραφο. 

● Για να μετονομάσετε ένα artboard, κάντε διπλό click στον τίτλο του. 

Prototyping and Preview391 

● Επιλέξτε οποιοδήποτε αντικείμενο σε ένα artboard (ή ολόκληρο το artboard) 

και ενώστε τα  για να ενεργοποιήσετε μια αλληλεπίδραση μεταξύ των artboard. 

● Σύρετε μία ένωση από έναν προορισμό για να καταργήσετε την ένωση μιας 

αλληλεπίδρασης που έχετε ορίσει. 

● Χρησιμοποιήστε τη μετάβαση Dissolve όταν σχεδιάζετε για web. 

● Μπορείτε να δείτε όλες τις συνδέσεις μεταξύ των γραφικών σας (εκτός από 

αυτές που ενεργοποιούνται απευθείας από τους πίνακες γραφικών) πατώντας 

Cmd + A (σε Mac) ή Ctrl + A (Windows) σε Prototype Mode. 

● Το παράθυρο Preview εμφανίζει το artboard που έχει την τρέχουσα επιλογή. 

Εάν δεν υπάρχει επιλογή, ανοίγει το παράθυρο προεπισκόπησης με πρώτο το 

αρχικό artboard. 

 
390 Low, N. E. (2022). Barber App UI/UX Design. 
391 Bharti, N. K., Dongargaonkar, M. D., Kudkar, I. B., Das, S., & Kenia, M. (2019, December). Hydroponics system 

for soilless farming integrated with android application by internet of things and MQTT broker. In 2019 IEEE Pune 
Section International Conference (PuneCon) (pp. 1-5). IEEE. 
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● Μπορείτε να εγγράψετε ένα βίντεο από το παράθυρο προεπισκόπησης του 

διαδραστικού πρωτοτύπου σας. Κάντε click στο εικονίδιο εγγραφής στη 

γραμμή τίτλου για να ξεκινήσετε ένα βίντεο. 

● Κάνοντας ξανά click στο κουμπί εγγραφής Ή πατήστε ESC για να σταματήσετε 

μια εγγραφή βίντεο. 
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ΣΥΜΠΕΡΑΣΜΑΤΑ 

Όσο "ελαφρύ και βασικό" και αν φαίνεται, το περιβάλλον εργασίας του Adobe 

XD χειρίζεται πολύπλοκα συστήματα σχεδιασμού και βιβλιοθήκες συμβόλων, 

επιτρέποντας στους σχεδιαστές να δημιουργούν και να ενημερώνουν περίπλοκα σχέδια 

με ευκολία. Εξίσου σημαντικά για τη διαδικασία σχεδιασμού και δοκιμής από τους 

χρήστες είναι τα εξελιγμένα εργαλεία πρωτοτύπων και κινούμενων σχεδίων του XD. 

Όταν ένας σχεδιαστής είναι έτοιμος να λάβει ανατροφοδότηση για τα design, τα 

πρόσθετα των UserTesting και Userlytics του επιτρέπουν να το κάνει αυτό χωρίς να 

βγει από το πρόγραμμα. 

Η δημιουργία του απόλυτου εργαλείου σχεδιασμού UX που θα έχει όλα τα 

σωστά χαρακτηριστικά είναι αυτό που επιδιώκουν εταιρείες όπως η InVision, η Adobe 

και άλλες. Το έργο είναι τεράστιο και περίπλοκο, οπότε ένας από τους τρόπους για την 

επίτευξη αυτού του στόχου είναι οι πλατφόρμες να αναπτύξουν plugins (και να 

ενθαρρύνουν τους άλλους να κάνουν το ίδιο). 

Η πρόσφατη ανακοίνωση της Adobe για την ίδρυση ενός Design Fund ύψους 

10 εκατομμυρίων δολαρίων για αυτόν ακριβώς τον σκοπό αποδεικνύει τη σημασία της 

υποστήριξης των plugins και της παροχής κινήτρων στους προγραμματιστές για τη 

δημιουργία τους. Κατά τη διάρκεια του πρόσφατου συνεδρίου Adobe MAX, υπήρξαν 

αρκετές σημαντικές ανακοινώσεις γύρω από τα plugins, τα UI kits και τις 

ενσωματώσεις εφαρμογών για την επέκταση της χρησιμότητας του Adobe XD. 

Ενώ το Sketch είναι ένα εξαιρετικό εργαλείο σχεδίασης, αυτό που το κάνει 

πραγματικά σπουδαίο είναι η διαθεσιμότητα plugins τρίτων κατασκευαστών όπως το 

Runner, το Color Accessibility Check, το Magic Mirror, το Auto Animate κ.λπ. Το 

Adobe XD ενισχύει το παιχνίδι του με plugins όπως τα RenameIt, Pixel Perfect, Data 

Generator κ.λπ. και ενσωματώσεις με Trello, Dribbble, Google Sheets κ.λπ. 

Επενδύοντας στη φιλοξενία και υποστήριξη αναδυόμενων ταλέντων στο Adobe 

Creative Residency η Adobe διατηρεί το σημαντικό πλεονέκτημα του οικοσυστήματός 

της. Ένα άλλο βασικό στοιχείο της μελλοντικής επιτυχίας είναι κάτι άλλο που η ομάδα 

του Adobe XD κάνει καλά - ακούει τους τελικούς χρήστες και τους εμπλέκει στη 

διαδικασία ανάπτυξης, καλώντας τους να προτείνουν και να δώσουν upvote για τα 

επόμενα χαρακτηριστικά που θα αναπτυχθούν. 
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Από την αρχή, το Adobe XD τοποθετήθηκε ως ένα "προϊόν από σχεδιαστές για 

σχεδιαστές" και παραμένει πιστά σε αυτή την πορεία. Κάθε μήνα, νέα σύνολα 

χαρακτηριστικών αναπτύσσονται. Για παράδειγμα, μόλις τους τελευταίους μήνες, η 

Adobe εισήγαγε νέα χαρακτηριστικά του Adobe XD, όπως Responsive Resize, Timed 

Transitions, Spell Check, ενσωμάτωση Jira και πολλά άλλα. 

Αν λάβουμε υπόψη μας όλα τα παραπάνω, συμπεραίνουμε πως το Adobe XD 

ήρθε για να μείνει έχοντας σαν στόχο του να κατακτήσει τη θέση του απόλυτου 

εργαλείου σχεδιασμού UX, αποσκοπώντας να γίνεται όλο και πιο λειτουργικό και 

φιλικό για τους χρήστες που το επιλέγουν. 
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ΠΑΡΑΡΤΗΜΑΤΑ 

ΣΥΝΤΟΜΕΥΣΕΙΣ ΠΛΗΚΤΡΟΛΟΓΙΟΥ (KEYBOARD SHORTCUTS) 

ΓΕΝΙΚΕΣ ΣΥΝΤΟΜΕΥΣΕΙΣ 

 MAC Windows 

Quit Cmd + Q Alt + F4 

 

ΠΛΗΚΤΡΑ ΓΙΑ ΤΟ ΜΕΝΟΥ ΕΠΕΞΕΡΓΑΣΙΑΣ 

Μενού MAC Windows 

Undo Cmd + Z Ctrl + Z 

Redo ⇧ + Cmd + Z Ctrl + Shift + Z 

Cut Cmd + X Ctrl + X 

Copy Cmd + C Ctrl + C 

Paste Cmd + V Ctrl + V 

Paste Appearance (in Design mode), and 

Paste Interaction (in Prototype mode) 
Cmd + Opt + V Ctrl + Alt + V 

Duplicate Cmd + D Ctrl + D 

Delete ⌫ Delete 

Select all Cmd + A Ctrl + A 
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Deselect all ⇧+ Cmd + A Ctrl + Shift + A 

 

ΠΛΗΚΤΡΑ ΓΙΑ ΤΟ ΜΕΝΟΥ ΑΡΧΕΙΟ 

Μενού MAC Windows 

New Cmd + N Ctrl + N 

Open 
Cmd + 

Shift + O 

Ctrl + Shift + 

O 

Close Cmd + W Alt + F4 

Save Cmd + S Ctrl + S 

Save As 
⇧+ Cmd + 

S 

Ctrl + Shift + 

S 

Save As Local Document 

Opt + 

Shift + 

Cmd + S 

    Shift + Ctrl 

+ Alt + S 

Export Batch  
Shift + 

Cmd + E 

Ctrl + Shift + 

E 

Export Selected Cmd + E Ctrl + E 

Export σε μια ενσωματωμένη εφαρμογή τρίτου 

κατασκευαστή (εάν στον υπολογιστή σας είναι 

εγκατεστημένη μια εφαρμογή ενσωματωμένη με XD) 

Opt + 

Cmd + E 

Μη 

διαθέσιμος 



174 
 

Import  
Shift + 

Cmd + I 
Ctrl + Shift + I 

 

KEYS FOR PATH/PEN 

Menu MAC  Windows 

Switch to Pen tool P P 

Convert Point/Μετατροπή σημείου Double click Double click 

Asymmetric Control Point/Ασύμμετρο Σημείο 

Ελέγχου 
Opt Alt 

Snap Control Point Angle/ΓωνίαΣημείουΕλέγχου 

Snap 
Shift Shift 

Snap Anchor Point Angle/Γωνία Σημείου Αγκύρωσης Shift Shift 

Add 
Opt + Cmd + 

U 

Ctrl + Alt + 

U 

Subtract/Αφαιρώ Opt + Cmd + S Ctrl + Alt + S 

Intersect/Διατέμνω Opt + Cmd + I Ctrl + Alt + I 

Exclude Overlap 
Opt + Cmd + 

X 

Ctrl + Alt + 

X 

Convert to Path Cmd + 8 Ctrl + 8 
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KEYS FOR LAYERS (OBJECTS), GROUPS, SCROLL GROUPS, AND 

ARTBOARDS 

Μενού MAC Windows 

Group Layers Cmd + G Ctrl + G 

Ungroup Layers Shift + Cmd + G Ctrl + Shift + G 

Make Component Cmd + K Ctrl + K 

Edit Main Component Shift + Cmd + K Shift + Ctrl + K 

Back to Previous Instance Shift + Opt + K Shift + Alt + K 

Lock/Unlock Layer Cmd + L Ctrl + L 

Hide/Show Layer Cmd + , Ctrl + , 

Mask with Shape Shift + Cmd + M Ctrl + Shift + M 

Make repeat grid Cmd + R Ctrl + R 

Directly select a layer in a 

group/component 

Cmd + Κάντε click στο 

επίπεδο στον καμβά 

Ctrl + στρώμα click στον 

καμβά 

Change layer opaciy 1 έως 9 (0 για 100%) 1 έως 9 (ή 0 για 100%) 

Select artboard 
Cmd + Κάντε click στο 

κενό μέρος του artboard 

Ctrl + click στο κενό 

μέρος του artboard 

Draw shape from center Επιλογή + Σύρετε Alt + Σύρετε 
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Draw shape with 1:1 aspect ratio 

(perfects square/circle) 
Shift + Σύρετε Shift + Σύρετε 

Σχεδιάστε ισόπλευρο τρίγωνο Shift + Σύρετε Shift + Σύρετε 

Εμφάνιση/Απόκρυψη guides 

artboards 
Cmd + ; Ctrl + ; 

Κλειδώστε τους guides του 

artboard 
Shift + Cmd + ; Shift + Ctrl + ; 

Move element by 10px  Shift + Arrows Shift + Arrows 

Resize element by 1px increment Cmd + Arrows Alt + Arrows 

Resize element by 10px 

increment 
Cmd + Shift + Arrows Alt + Shift + Arrows 

Select through overlapping 

layers 
Cmd + click Ctrl + click 

Edit padding 

Τοποθετήστε το δείκτη 

του ποντικιού και σύρετε 

σε καμβά + S 

Τοποθετήστε το δείκτη 

του ποντικιού και σύρετε 

σε καμβά + S 

Mirror padding on opposite sides Opt + S Alt + S 

Edit all sides Shift + S Shift + S 

Horizontal scroll Shift + Cmd + H Shift + Alt + H 

Vertical scroll Shift + Cmd + V Shift + Alt + V 

Horizontal and Vertical scroll Shift + Cmd + D Shift + Alt +D 
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Add color to Assets Shift + Cmd + C Shift + Ctrl + C 

Rename Layers (δεν ισχύει για 

το πλαίσιο Document Assets ή 

Plugins) 

Cmd + Opt + R Ctrl + Alt + R 

 

ΠΛΗΚΤΡΑ ΓΙΑ ΕΥΘΥΓΡΑΜΜΙΣΗ/KEYS FOR ALIGN 

Μενού MAC Windows 

Left Ctrl + Cmd + ← Ctrl + Shift + ← 

Center (horizontally) Ctrl + Cmd + C Shift + C 

Right Ctrl + Cmd + → Ctrl + Shift + → 

Top Ctrl + Cmd + ↑ Ctrl +Shift + ↑ 

Middle (vertically) Ctrl + Cmd + M Shift + M 

Bottom Ctrl + Cmd + ↓ Ctrl + Shift + ↓ 

 

ΚΛΕΙΔΙΑ ΓΙΑ ΤΑΚΤΟΠΟΙΗΣΗ/KEYS FOR ARRANGE 

Μενού MAC Windows 
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Bring to front Shift + Cmd +] Shift + Ctrl + ] 

Bring Forward Cmd + ] Ctrl + ] 

Send Backward Cmd + [ Ctrl + [ 

Send to Back Shift + Cmd + [ Shift + Ctrl + [ 

 

ΚΛΕΙΔΙΑ ΓΙΑ ΔΙΑΝΟΜΗ/KEYS FOR DISTRIBUTE 

Μενού MAC Windows 

Horizontal Ctrl + Cmd + H Ctrl + Shift + H 

Vertical Ctrl + Cmd + V Ctrl + Shift + V 

 

ΠΛΗΚΤΡΑ ΓΙΑ ΚΕΙΜΕΝΟ/KEYS FOR TEXT 

Μενού MAC Windows 

Bold/Έντονη γραφή Cmd + B Ctrl + B 

Italic/Πλάγια γραφή Cmd + I Ctrl + I 
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Υπογράμιση/Underline Cmd + U Ctrl + U 

Αυξήστε το μέγεθος της γραμματοσειράς/Increase 

font size 

Shift + Cmd 

+ > 

Ctrl + Shift 

+ > 

Μειώστε το μέγεθος της γραμματοσειράς/Decrease 

font size 

Shift + Cmd 

+ < 

Ctrl + Shift 

+ < 

 

ΠΛΗΚΤΡΑ ΓΙΑ ΜΕΝΟΥ ΛΕΙΤΟΥΡΓΙΩΝ 

Μενού MAC Windows 

Από το Κέντρο/From center Opt Alt 

Copy paste Object Opt+ Drag Alt + Drag 

Περιορίζω/Constrain Shift Shift 

Επεξεργασία κειμένου/Edit Text Enter Enter 

Περιστροφή περιορισμού/Constrain Rotate Shift (15°) Shift (15°) 

Περιστροφήγραμμής/Line Constrain Rotate Μετατόπιση 

(45°) 

Μετατόπιση 

(45°) 
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Περιορισμός από το κέντρο/Constrain from 

center 

Shift + Opt Shift + Alt 

Άμεση επιλογή/Direct Select Cmd Ctrl 

Switch between Design and Prototype mode Ctrl + Tab Ctrl + Tab 

 

KEYS FOR TOOLS MENU 

Μενού MAC Windows 

Select V V 

Rectangle R R 

Ellipse  E E 

Polygon Υ Υ 

Line L L 

Pen P P 

Text Τ Τ 

Artboard A A 

Zoom Enter zoom mode: Z Enter zoom mode: Z 

Eyedropper  I I 
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ΠΛΗΚΤΡΑ ΓΙΑ ΤΗ ΔΙΕΠΑΦΗ ΚΑΙ ΤΙΣ ΕΠΙΛΟΓΕΣ ΠΡΟΒΟΛΗΣ/KEYS FOR 

INTERFACE AND VIEWING OPTIONS 

 

Μενού MAC Windows 

Switch to Design Mode Opt + 1 Alt + 1 

Switch to Prototype Mode  Opt + 2 Alt + 2 

Switch to Share mode Opt + 3 Alt + 3 

Zoom In 

● Cmd + ,  

● Opt – Scroll Wheel,  

● Opt - swipe (Magic 

Mouse) 

● Pinch out (trackpad) 

● Ctrl + + 

● Ctrl – Scroll Wheel 

● Pinch out (trackpad) 

Zoom Out 

● Cmd + -  

● Opt – Scroll Wheel 

● Option-swipe 

(Magic Mouse) 

● Pinch in (trackpad) 

● Ctrl + - 

● Ctrl-Scroll Wheel 

● Pinch in (trackpad) 

Zoom to Selection Cmd + 3 Ctrl + 3 

Zoom to Fit Cmd + 0 Ctrl + 0 

100% Cmd + 1 Ctrl + 1 

200% Cmd + 2 Ctrl + 2 
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Pan Spacebar Spacebar 

Assets Shift + Cmd + Y Ctrl + Shift + Y 

Layers Cmd + Y Ctrl + Y 

Show Layout Grid Shift + Cmd + ' Shift + Ctrl + ' 

Show Square Grid Cmd + ' Ctrl + ' 

Full Screen Mode Ctrl + Cmd + F  Μη διαθέσιμος 

Εναλλαγή μεταξύ 

σχεδίασης και λειτουργίας 

πρωτοτύπου 

Ctrl + Tab Ctrl + Tab 

Switch between windows 

(files) 

Cmd + Tilde (~) 
Μη διαθέσιμος 

Αυξήστε ή μειώστε μια 

τιμή σε ένα πεδίο κατά 1 
↑ ή ↓ ↑ ή ↓ 

Αυξήστε ή μειώστε μια 

τιμή σε ένα πεδίο κατά 10 

Κρατήστε πατημένο το 

Shift + πατήστε ↑ ή ↓ 

Κρατήστε πατημένο το 

Shift + πατήστε ↑ ή ↓ 

 

ΠΛΗΚΤΡΑ ΓΙΑ ΤΟ ΜΕΝΟΥ ΤΟΥ ΠΑΡΑΘΥΡΟΥ 

Μενού MAC Windows 

MAXIMIZE   WIN ↑ 
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MINIMIZE Cmd + M WIN↓ 

PREVIEW Cmd + ⏎ Ctrl + Enter 

 

KEYS FOR OPERATION MODIFIERS  

Μενού MAC Windows 

Horizontal pan Shift + Scroll Wheel Shift + Scroll Wheel 

Vertical pan Scroll Wheel Scroll Wheel 

 

ΠΛΗΚΤΡΑ ΕΠΙΛΟΓΗΣ ΚΑΙ ΜΕΤΡΗΣΗΣ ΑΠΟΣΤΑΣΕΩΝ ΜΕΤΑΞΥ 

ΣΤΟΙΧΕΙΩΝ 

Μενού MAC Windows 

Ενεργοποίηση 

μετρήσεων 

Opt (με επιλεγμένο 

αντικείμενο) 

Alt (με επιλεγμένο 

αντικείμενο) 

Απόσταση από το 

selected layer 

Κρατήστε πατημένο το Opt 

και τοποθετήστε το δείκτη 

του ποντικιού πάνω από 

object/group/artboard 

Κρατήστε το Alt και 

τοποθετήστε το δείκτη του 

ποντικιού πάνω από 

object/group/artboard 
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Απόσταση σε σχέση με 

το selected group 

Κρατήστε πατημένο το Opt 

+ Cmd και τοποθετήστε το 

δείκτη του ποντικιού πάνω 

από ένα αντικείμενο στην 

ομάδα 

Κρατήστε πατημένο το Ctrl 

+ Alt και τοποθετήστε το 

δείκτη του ποντικιού πάνω 

από ένα αντικείμενο στην 

ομάδα 

 

ΚΛΕΙΔΙΑ ΓΙΑ DESIGN SPECS 

Μενού MAC Windows 

Zoom Cmd + , Cmd -  Ctrl +, Ctrl - 

Reset zoom Cmd + 0 Ctrl + 0 

Pan ↑, ↓, →, ← 

Spacebar + click and 

Drag 

↑, ↓, →, ← 

Spacebar + click and 

Drag 

Faster pan Shift + ↑, ↓, →, ← Shift + ↑, ↓, →, ← 

Αφαιρέστε focus απότο artboard in 

Spec view  

Esc Esc 

Navigate across linked artboards  Shift + click Shift + click 
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KEYS FOR VECTOR EDITING 

Μενού MAC Windows 

Ξεκινήστε την 

επεξεργασία του 

επιλεγμένου vector object 

Enter  Enter 

Διακοπή επεξεργασίας 

επιλεγμένου vector object 

Esc  Esc 

Εναλλαγή μεταξύ 

ευθύγραμμων και 

κατοπτρικών σημείων 

ελέγχου 

Double click  Double click 

Αποσυνδέστε τη λαβή του 

σημείου ελέγχου 

Opt + Drag Alt + Drag 

 

KEYS FOR PROTOTYPING 

Μενού MAC Windows 

Δείτε όλες τις συνδέσεις σε 

λειτουργία πρωτότυπου 

Cmd + A Ctrl + A 

Hide all wires  Opt Alt 
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Προεπισκόπηση Cmd + Enter Ctrl + Enter 

Έναρξη ή διακοπή 

εγγραφής της 

προεπισκόπησης 

Cmd + Ctrl + R Μη διαθέσιμος 

Διακοπή εγγραφής Esc Μη διαθέσιμος 

Πλοηγηθείτε στα artboards 

σε προεπισκόπηση ή 

κοινόχρηστο πρωτότυπο 

Δεξί ή Αριστερό βέλος  → ή ← 

Δημιουργήστε μια νέα 

γραμμή στο πλαίσιο 

σχολίων του κοινόχρηστου 

συνδέσμου πρωτοτύπου  

Enter ή Shift + Enter Enter ή Shift + Enter 

Υποβολή σχολίου που έχει 

εισαχθεί στο πλαίσιο 

σχολίων του συνδέσμου 

κοινόχρηστου πρωτοτύπου 

Cmd + Enter  Ctrl + Enter  
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